Focused Build for SAP Solution Manager 7.2
ST-OST 200 SPS 8
## Typographic Conventions

<table>
<thead>
<tr>
<th>Type Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example</strong></td>
<td>Words or characters quoted from the screen. These include field names, screen titles, pushbuttons labels, menu names, menu paths, and menu options. Textual cross-references to other documents.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Emphasized words or expressions.</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Technical names of system objects. These include report names, program names, transaction codes, table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Output on the screen. This includes file and directory names and their paths, messages, names of variables and parameters, source text, and names of installation, upgrade and database tools.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.</td>
</tr>
<tr>
<td><strong>&lt;Example&gt;</strong></td>
<td>Variable user entry. Angle brackets indicate that you replace these words and characters with appropriate entries to make entries in the system.</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Keys on the keyboard, for example, <code>F2</code> or <code>ENTER</code>.</td>
</tr>
</tbody>
</table>
## Document History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.9</td>
<td>2021-07-28</td>
<td>Chapter 9.16.5 created</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 11.17.2 new</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 11.17.7 deleted</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 11.17.8 deleted</td>
</tr>
<tr>
<td>7.8</td>
<td>2021-07-15</td>
<td>Chapter 7.2.9 created</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 10.6.3 enhanced</td>
</tr>
<tr>
<td>7.7</td>
<td>2021-07-09</td>
<td>Chapter 9.4.2 created</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 11.7 created</td>
</tr>
<tr>
<td>7.6</td>
<td>2021-07-05</td>
<td>Chapter 7.2.1 enhanced</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 11.5.2 adjusted</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 11.5.4 adjusted</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 11.5.5 adjusted</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 11.13. adjusted entirely</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 13.8 adjusted</td>
</tr>
<tr>
<td>7.5</td>
<td>2021-05-19</td>
<td>Chapter 12.4.2 Adjusted</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 10.6.3 inclusive language capture adjusted</td>
</tr>
<tr>
<td>7.4</td>
<td>2021-05-06</td>
<td>Chapter 9.5.2 adjusted title</td>
</tr>
<tr>
<td>7.3</td>
<td>2021-04-28</td>
<td>Chapter 10.5.2 corrected</td>
</tr>
<tr>
<td>7.2</td>
<td>2021-03-31</td>
<td>ICC configuration removed (chapter 11.2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 8.3.3 adjusted</td>
</tr>
<tr>
<td>7.15</td>
<td>2021-03-19</td>
<td>Chapter 10.16.6 corrected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 10.16.9.1 corrected</td>
</tr>
<tr>
<td>7.1</td>
<td>2021-03-03</td>
<td>Chapter 6.2.1 corrected</td>
</tr>
<tr>
<td>7.0</td>
<td>2021-01-15</td>
<td>Support Package 7.0</td>
</tr>
</tbody>
</table>
Table of Contents

1 Introduction ........................................................................................................................................... 13
  1.1 Target Audience ................................................................................................................................. 13
  1.2 Purpose and Scope of Information ........................................................................................................ 13
  1.3 How to Use This Guide ......................................................................................................................... 13
  1.4 Overview of Focused Build .................................................................................................................. 14
      1.4.1 Installation of Focused Build ........................................................................................................ 14
  1.5 Additional Online Resources for Focused Build .................................................................................. 14

2 Setup: SAP Solution Manager .............................................................................................................. 16
  2.1 Getting Started .................................................................................................................................. 16
  2.2 Implementation of Mandatory SAP Notes .............................................................................................. 16
  2.3 Changes to Number Ranges in Change Request Management ............................................................... 16
  2.4 Assignment of Roles ............................................................................................................................. 16

3 Setup: Focused Build – Upgrade SPS 2/3 to SPS 4 ................................................................................. 17
  3.1 Getting Started .................................................................................................................................. 17
  3.2 Activating the Piece List(s) .................................................................................................................. 17
  3.3 Implementation of SAP Notes .............................................................................................................. 17
  3.4 Activating SALM_FB Service .............................................................................................................. 18
  3.5 Setting System Aliases for OData Services ........................................................................................... 18
  3.6 Changes to AGS_WORK_CUSTOM Table Entries ............................................................................... 19
  3.7 Implementation of report /SALM/WP_WI_CHAN_CLASSI ..................................................................... 19
  3.8 Setting Default Values for Effort, Value and Story Points .................................................................... 19
  3.9 Activating BC-Sets ............................................................................................................................... 20
  3.10 (Optional) Enabling and Displaying Rich Text ................................................................................... 20
  3.11 UI2 Cache Maintenance ....................................................................................................................... 23
  3.12 Changes to User Roles ......................................................................................................................... 23

4 Setup: Focused Build – Upgrade SPS 4 to SPS 5 ................................................................................... 24
  4.1 Getting Started .................................................................................................................................. 24
  4.2 Activating the Piece List ....................................................................................................................... 24
  4.3 Implementation of SAP Notes .............................................................................................................. 24
  4.4 Activating SALM_FB Service .............................................................................................................. 25
  4.5 Activating BC-Sets ............................................................................................................................... 25
  4.6 (Optional) Enabling and Displaying Rich Text ................................................................................... 26
  4.7 UI2 Cache Maintenance ......................................................................................................................... 29
  4.8 Changes to User Roles ......................................................................................................................... 29

5 Setup: Focused Build – Upgrade SPS 5 to SPS 6 ................................................................................... 30
  5.1 Getting Started .................................................................................................................................. 30
  5.2 Activating the Piece List ....................................................................................................................... 30
  5.3 Changes to AGS_WORK_CUSTOM Table Entries ............................................................................... 30
  5.4 Implementation of SAP Notes .............................................................................................................. 30
  5.5 Activating SALM_FB Service .............................................................................................................. 31
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.1.1</td>
<td>Import Variants Delivered via the Piece List</td>
<td>59</td>
</tr>
<tr>
<td>9.1.2</td>
<td>(Optional) Setting Batch Import Variants</td>
<td>59</td>
</tr>
<tr>
<td>9.1.3</td>
<td>Changes to System Roles in Import Configuration</td>
<td>60</td>
</tr>
<tr>
<td>9.1.4</td>
<td>(Optional) Setting Import Sequence of Systems</td>
<td>60</td>
</tr>
<tr>
<td>9.1.5</td>
<td>Setting Up System Landscape in Maintain Landscape Data</td>
<td>61</td>
</tr>
<tr>
<td>9.1.6</td>
<td>Starting Imports Based on Variant</td>
<td>62</td>
</tr>
<tr>
<td>9.2</td>
<td>Configuring Active Import Feedback</td>
<td>63</td>
</tr>
<tr>
<td>9.2.1</td>
<td>(Optional) Setting Up Batch Import Housekeeping</td>
<td>64</td>
</tr>
<tr>
<td>9.3</td>
<td>Solution Readiness Dashboard: Data Extraction</td>
<td>65</td>
</tr>
<tr>
<td>9.4</td>
<td>Configuration for Conversion Project Support</td>
<td>66</td>
</tr>
<tr>
<td>9.4.1</td>
<td>Schedule background job for Progress Dashboard</td>
<td>66</td>
</tr>
<tr>
<td>9.4.2</td>
<td>Maintain selection of Transaction Types and Project for Follow-Up Documents</td>
<td>67</td>
</tr>
<tr>
<td>9.5</td>
<td>Activating Virus Scan Profiles</td>
<td>68</td>
</tr>
<tr>
<td>9.6</td>
<td>Configuring Multilevel Categorization</td>
<td>69</td>
</tr>
<tr>
<td>9.7</td>
<td>Changes to AGS_WORK_CUSTOM Table Entries</td>
<td>72</td>
</tr>
<tr>
<td>9.8</td>
<td>Requirements Management: Customization Options</td>
<td>72</td>
</tr>
<tr>
<td>9.8.1</td>
<td>Setting Default Values for Effort, Value, and Story Points</td>
<td>73</td>
</tr>
<tr>
<td>9.8.2</td>
<td>(Optional) Make Requirement Description obligatory</td>
<td>74</td>
</tr>
<tr>
<td>9.9</td>
<td>(Optional) Set Up of E-Mail Notification for Work Packages and Work Items</td>
<td>74</td>
</tr>
<tr>
<td>9.10</td>
<td>(Optional) Enabling and Displaying Rich Text</td>
<td>74</td>
</tr>
<tr>
<td>9.11</td>
<td>Activating Required BadIs</td>
<td>77</td>
</tr>
<tr>
<td>9.12</td>
<td>Release Management: Activation of Features</td>
<td>78</td>
</tr>
<tr>
<td>9.12.1</td>
<td>Activating Enhanced Release Management Functionalities</td>
<td>78</td>
</tr>
<tr>
<td>9.12.2</td>
<td>Checking Release Management Profiles</td>
<td>78</td>
</tr>
<tr>
<td>9.12.3</td>
<td>Activating Cross-System Lock for Development Clients</td>
<td>79</td>
</tr>
<tr>
<td>9.13</td>
<td>Defining System Aliases for OData Services</td>
<td>80</td>
</tr>
<tr>
<td>9.14</td>
<td>(Optional) Replacing Dynamic My Documents Tile with Static Version</td>
<td>80</td>
</tr>
<tr>
<td>9.15</td>
<td>Configuring Exceptions for Naming of Automatically-Created KPI Documents</td>
<td>80</td>
</tr>
<tr>
<td>9.16</td>
<td>Test Suite: Configuration Activities</td>
<td>82</td>
</tr>
<tr>
<td>9.16.1</td>
<td>Configuring Test Suite Extensions</td>
<td>82</td>
</tr>
<tr>
<td>9.16.2</td>
<td>Checking Test Suite Configurations</td>
<td>82</td>
</tr>
<tr>
<td>9.16.3</td>
<td>Mapping Defect Status Aggregations</td>
<td>83</td>
</tr>
<tr>
<td>9.16.4</td>
<td>Setting Work Package Status Values for Test Preparation Tiles</td>
<td>83</td>
</tr>
<tr>
<td>9.16.5</td>
<td>(Optional) Enable application state for My Test Executions</td>
<td>84</td>
</tr>
<tr>
<td>9.16.6</td>
<td>Configuring Test Steps</td>
<td>84</td>
</tr>
<tr>
<td>9.17</td>
<td>Project Management: Configuration of Project Templates</td>
<td>85</td>
</tr>
<tr>
<td>9.17.1</td>
<td>Creating Project Templates</td>
<td>85</td>
</tr>
<tr>
<td>10</td>
<td>Configuration: Focused Build-Based Implementation Project</td>
<td>87</td>
</tr>
<tr>
<td>10.1</td>
<td>Target Group</td>
<td>87</td>
</tr>
<tr>
<td>10.2</td>
<td>Prerequisites for Project Preparation</td>
<td>87</td>
</tr>
<tr>
<td>10.2.1</td>
<td>Technical Prerequisites</td>
<td>87</td>
</tr>
<tr>
<td>10.2.2</td>
<td>Content-Related Prerequisites</td>
<td>87</td>
</tr>
<tr>
<td>10.3</td>
<td>A Solution with Branches, System Landscape, and Document-Type Assignment</td>
<td>89</td>
</tr>
<tr>
<td>10.3.1</td>
<td>Definition of Solution</td>
<td>89</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>10.3.2</td>
<td>Definition of a Branch ............................................. 90</td>
<td></td>
</tr>
<tr>
<td>10.3.3</td>
<td>Definitions Regarding System Landscape .............................. 93</td>
<td></td>
</tr>
<tr>
<td>10.3.4</td>
<td>Assigning a Sandbox System ........................................... 94</td>
<td></td>
</tr>
<tr>
<td>10.3.5</td>
<td>Considerations If Process Management Is Already in Use ............ 96</td>
<td></td>
</tr>
<tr>
<td>10.3.6</td>
<td>Creating and Assigning Document Types to a Solution ................ 97</td>
<td></td>
</tr>
<tr>
<td>10.3.7</td>
<td>Configuring Document KPI Framework .................................... 101</td>
<td></td>
</tr>
<tr>
<td>10.3.8</td>
<td>Configuring E-Mail Notifications on Document Status Change ........ 103</td>
<td></td>
</tr>
<tr>
<td>10.3.9</td>
<td>Importing Best Practice Content into the Import Branch ............ 105</td>
<td></td>
</tr>
<tr>
<td>10.3.10</td>
<td>Creating Change Control Landscape ..................................... 109</td>
<td></td>
</tr>
<tr>
<td>10.3.11</td>
<td>Configuring Branch Mapping ............................................... 110</td>
<td></td>
</tr>
<tr>
<td>10.3.12</td>
<td>Alignment of Default Values ............................................. 111</td>
<td></td>
</tr>
<tr>
<td>10.3.13</td>
<td>Allowlist Object Maintenance ............................................. 111</td>
<td></td>
</tr>
<tr>
<td>10.4</td>
<td>Release Management: Configuration ....................................... 112</td>
<td></td>
</tr>
<tr>
<td>10.4.1</td>
<td>Configuring Release Planning ............................................ 112</td>
<td></td>
</tr>
<tr>
<td>10.4.2</td>
<td>Preparing Release Component for Batch Import ........................ 117</td>
<td></td>
</tr>
<tr>
<td>10.4.3</td>
<td>Adjusting Release Profile Mapping ....................................... 117</td>
<td></td>
</tr>
<tr>
<td>10.5</td>
<td>Setting Up Projects ......................................................... 118</td>
<td></td>
</tr>
<tr>
<td>10.5.1</td>
<td>Creating Projects ............................................................. 118</td>
<td></td>
</tr>
<tr>
<td>10.5.2</td>
<td>Assigning Actual Release to Projects ..................................... 122</td>
<td></td>
</tr>
<tr>
<td>10.5.3</td>
<td>[optional, if Easy Project Setup utilized] Assigning Sub-Projects to Main Project ............. 124</td>
<td></td>
</tr>
<tr>
<td>10.5.4</td>
<td>(Optional) Adding Waves for Template Build Projects ................ 125</td>
<td></td>
</tr>
<tr>
<td>10.5.5</td>
<td>Adjusting Wave Relationships between Main and Build Projects .......... 126</td>
<td></td>
</tr>
<tr>
<td>10.5.6</td>
<td>Project Milestones Maintenance ........................................... 129</td>
<td></td>
</tr>
<tr>
<td>10.5.7</td>
<td>Release of Q-Gates ................................................................ 130</td>
<td></td>
</tr>
<tr>
<td>10.5.8</td>
<td>(Optional) Assigning Dedicated Release Numbers to Waves ............ 131</td>
<td></td>
</tr>
<tr>
<td>10.5.9</td>
<td>Releasing Wave or Sprint .................................................... 133</td>
<td></td>
</tr>
<tr>
<td>10.5.10</td>
<td>Release of Project Header .................................................... 133</td>
<td></td>
</tr>
<tr>
<td>10.6</td>
<td>Configuration of Fix Pace ................................................... 134</td>
<td></td>
</tr>
<tr>
<td>10.6.1</td>
<td>Activation of Enhanced Approval Procedure ............................ 134</td>
<td></td>
</tr>
<tr>
<td>10.6.2</td>
<td>Configuring Change Document visibility in Attribute Pane ............... 134</td>
<td></td>
</tr>
<tr>
<td>10.6.3</td>
<td>Configuring Standard Change – Allowlist .................................. 135</td>
<td></td>
</tr>
<tr>
<td>10.6.4</td>
<td>Integration of an Electronic Signature ...................................... 137</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Configuration: Standalone Extensions .................................... 138</td>
<td></td>
</tr>
<tr>
<td>11.1</td>
<td>Activating the Piece List .................................................... 138</td>
<td></td>
</tr>
<tr>
<td>11.2</td>
<td>Test System Refresh: Configuration Overview ............................ 138</td>
<td></td>
</tr>
<tr>
<td>11.2.1</td>
<td>Simulation Landscape ......................................................... 139</td>
<td></td>
</tr>
<tr>
<td>11.2.2</td>
<td>Prerequisites ................................................................. 139</td>
<td></td>
</tr>
<tr>
<td>11.2.3</td>
<td>Changes to the Task List ..................................................... 139</td>
<td></td>
</tr>
<tr>
<td>11.2.4</td>
<td>Executing the Refresh Test System Scenario ............................. 149</td>
<td></td>
</tr>
<tr>
<td>11.2.5</td>
<td>Available BADI Definition: /SALM/RTS_FILTER_DELTA_BAdI .............. 152</td>
<td></td>
</tr>
<tr>
<td>11.3</td>
<td>Retrofit Automation: Configuration Activities ............................ 152</td>
<td></td>
</tr>
<tr>
<td>11.3.1</td>
<td>Basic Configuration for SAP Solution Manager and Configuration for Change Request Management ............................................. 152</td>
<td></td>
</tr>
<tr>
<td>11.3.2</td>
<td>Activation of the Piece List ............................................... 155</td>
<td></td>
</tr>
<tr>
<td>11.3.3</td>
<td>Implementation of Mandatory SAP Notes .................................... 155</td>
<td></td>
</tr>
<tr>
<td>11.3.4</td>
<td>Checking for Correct Retrofit Setup ...................................... 156</td>
<td></td>
</tr>
<tr>
<td>11.3.5</td>
<td>Activating Retrofit Automation Scenario for Target Transport Creation ........ 157</td>
<td></td>
</tr>
<tr>
<td>11.3.6</td>
<td>Activating Retrofit Automation Scenario Full Scope ....................... 165</td>
<td></td>
</tr>
<tr>
<td>11.3.7</td>
<td>Activating Retrofit Automation Scenario Stop at Failed Retrofit ........... 167</td>
<td></td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td>------</td>
</tr>
<tr>
<td>11.8.8</td>
<td>Overview of Digital Signature</td>
<td>218</td>
</tr>
<tr>
<td>11.9</td>
<td>Multi-Tenancy Enhancement: Configuration</td>
<td>225</td>
</tr>
<tr>
<td>11.9.1</td>
<td>Use Case</td>
<td>225</td>
</tr>
<tr>
<td>11.9.2</td>
<td>Roles and Authorizations</td>
<td>225</td>
</tr>
<tr>
<td>11.9.3</td>
<td>Status Check for Transaction Types</td>
<td>226</td>
</tr>
<tr>
<td>11.9.4</td>
<td>Business Partner-Dependent Checks</td>
<td>228</td>
</tr>
<tr>
<td>11.9.5</td>
<td>Configuration of Item-Dependent Checks</td>
<td>239</td>
</tr>
<tr>
<td>11.9.6</td>
<td>Restriction of Access to Solutions and Documentation</td>
<td>241</td>
</tr>
<tr>
<td>11.9.7</td>
<td>Activation of Checks</td>
<td>244</td>
</tr>
<tr>
<td>11.10</td>
<td>Status-Dependent Check Framework: Configuration</td>
<td>248</td>
</tr>
<tr>
<td>11.10.1</td>
<td>Use Cases</td>
<td>248</td>
</tr>
<tr>
<td>11.10.2</td>
<td>Roles and Authorization</td>
<td>249</td>
</tr>
<tr>
<td>11.10.3</td>
<td>Consistency Checks for Change Transaction Types</td>
<td>249</td>
</tr>
<tr>
<td>11.10.4</td>
<td>Adding Field Checks</td>
<td>251</td>
</tr>
<tr>
<td>11.10.5</td>
<td>Checking Business Partner Function</td>
<td>253</td>
</tr>
<tr>
<td>11.10.6</td>
<td>Checking Text Fields</td>
<td>256</td>
</tr>
<tr>
<td>11.11</td>
<td>Change Request Management Scorecard: Configuration</td>
<td>258</td>
</tr>
<tr>
<td>11.11.1</td>
<td>Use Case</td>
<td>258</td>
</tr>
<tr>
<td>11.11.2</td>
<td>Roles and Authorization</td>
<td>259</td>
</tr>
<tr>
<td>11.11.3</td>
<td>Scorecard Customization</td>
<td>259</td>
</tr>
<tr>
<td>11.11.4</td>
<td>Generating Scorecard data</td>
<td>264</td>
</tr>
<tr>
<td>11.12</td>
<td>Release Batch Import: Configuration</td>
<td>264</td>
</tr>
<tr>
<td>11.12.1</td>
<td>Required Activities</td>
<td>264</td>
</tr>
<tr>
<td>11.12.2</td>
<td>Basic Configuration for SAP Solution Manager</td>
<td>264</td>
</tr>
<tr>
<td>11.12.3</td>
<td>Piece List Activation</td>
<td>266</td>
</tr>
<tr>
<td>11.12.4</td>
<td>Prerequisites</td>
<td>266</td>
</tr>
<tr>
<td>11.12.5</td>
<td>Implementation of Required SAP Notes</td>
<td>266</td>
</tr>
<tr>
<td>11.12.6</td>
<td>Configuring Status-Dependent Imports</td>
<td>267</td>
</tr>
<tr>
<td>11.12.7</td>
<td>Starting Import Based on Import Variant</td>
<td>287</td>
</tr>
<tr>
<td>11.12.8</td>
<td>Transport Checks</td>
<td>291</td>
</tr>
<tr>
<td>11.12.9</td>
<td>BAdI Implementations</td>
<td>292</td>
</tr>
<tr>
<td>11.13</td>
<td>Template Protection: Configuration</td>
<td>292</td>
</tr>
<tr>
<td>11.13.1</td>
<td>Basic Configuration for SAP Solution Manager</td>
<td>292</td>
</tr>
<tr>
<td>11.13.2</td>
<td>Prerequisite for Template Protection</td>
<td>293</td>
</tr>
<tr>
<td>11.13.3</td>
<td>Activating Template Protection Check</td>
<td>294</td>
</tr>
<tr>
<td>11.13.4</td>
<td>Activating Check at Save of Objects</td>
<td>295</td>
</tr>
<tr>
<td>11.13.5</td>
<td>Activating Check at Release of Transport Requests</td>
<td>296</td>
</tr>
<tr>
<td>11.13.6</td>
<td>Configuration Parameters for Template Protection</td>
<td>297</td>
</tr>
<tr>
<td>11.13.7</td>
<td>Add Fiori Tiles to Personalization</td>
<td>298</td>
</tr>
<tr>
<td>11.14</td>
<td>Cross-landscape Distribution: Configuration</td>
<td>298</td>
</tr>
<tr>
<td>11.14.1</td>
<td>Overview</td>
<td>298</td>
</tr>
<tr>
<td>11.14.2</td>
<td>Roles and Authorizations</td>
<td>301</td>
</tr>
<tr>
<td>11.14.3</td>
<td>Prerequisites</td>
<td>301</td>
</tr>
<tr>
<td>11.14.4</td>
<td>General Customizing Settings</td>
<td>303</td>
</tr>
<tr>
<td>11.14.5</td>
<td>Configure Filter and Distribution Groups</td>
<td>306</td>
</tr>
<tr>
<td>11.14.6</td>
<td>Activate Preparation BAdI</td>
<td>314</td>
</tr>
<tr>
<td>11.14.7</td>
<td>Activate Post-Distribution BAdI</td>
<td>316</td>
</tr>
<tr>
<td>11.14.8</td>
<td>Activate Target Change Lock BAdI</td>
<td>317</td>
</tr>
<tr>
<td>11.14.9</td>
<td>Additional configurations for transaction types</td>
<td>317</td>
</tr>
<tr>
<td>11.15</td>
<td>Cutover Checks and Post Cutover Activities: Configuration</td>
<td>325</td>
</tr>
</tbody>
</table>
11.16 Electronic Signature for Change Request Management: Configuration .................................................. 337
11.16.1 Overview ........................................................................................................................................ 337
11.16.2 Roles and Authorizations ............................................................................................................... 338
11.16.3 Creating and Validating the Signature Object .................................................................................. 338
11.16.4 Activating Electronic Signature for the Approval Assignment Block .............................................. 339
11.16.5 Activating Electronic Signature for an Action from the Action Profile ............................................ 340
11.16.6 Check sign status for documents ..................................................................................................... 341
11.17 Test Steps: Configuration .................................................................................................................. 342
11.17.1 Overview - Test Steps .................................................................................................................... 342
11.17.2 Overview - Test Steps Parameters .................................................................................................. 343
11.17.3 Prerequisites .................................................................................................................................. 344
11.17.4 Implementation of Key SAP Notes ................................................................................................ 345
11.17.5 Activating SALM_FB Service ........................................................................................................ 345
11.17.6 Defining System Aliases for OData Services ................................................................................... 346
11.17.7 Customization Options .................................................................................................................. 346
11.17.8 Enabling Machine Translation API ............................................................................................... 352
11.17.9 Users and Authorization Roles ....................................................................................................... 353
12 Additional Configuration Activities ........................................................................................................ 355
12.1 Configuration of Email-Notification for Work Packages Work Items and RFC .................................... 355
12.1.1 Getting Started ............................................................................................................................... 355
12.1.2 Configuration HTML Mail Forms ................................................................................................ 355
12.2 Configuration of Test Classification for Test Suite .............................................................................. 357
12.3 Activating BAdI for Related Transaction in Solution Documentation Attributes Panel ................................ 357
12.4 Deletion of Obsolete Projects ........................................................................................................... 359
12.5 Changing Project Reasons .................................................................................................................. 359
12.6 Creating Business Partners ................................................................................................................. 360
12.7 Defining Transport Risks ..................................................................................................................... 361
12.8 Adjusting Category Schema ................................................................................................................ 362
12.9 (Optional) Creating an Organizational Model .................................................................................... 363
12.10 Overview of Multi-Tenancy Enhancement Report .............................................................................. 367
13 Appendix ............................................................................................................................................ 370
13.1 Key SAP Notes .................................................................................................................................... 370
13.2 Other Useful SAP Notes ..................................................................................................................... 370
13.3 Important Links .................................................................................................................................... 372
13.4 Uncritical Configuration or Customizing Changes for Focused Build .................................................. 373
13.5 Transaction Types ............................................................................................................................... 373
13.6 System Roles ....................................................................................................................................... 374
13.7 Uncritical Focused Build configuration or customizing changes ......................................................... 374
13.8 Authorization Roles and Users in SAP Solution Manager System ............................................................. 375
13.9 Authorization Roles and Users in Systems Belonging to the Project.......................................................... 377
13.10 Language Settings.................................................................................................................................. 378
13.11 Package and Namespace Selection in bc-Set Activation .............................................................................. 378
13.12 Troubleshooting .................................................................................................................................... 378
  13.12.1 Context Menu for Test Steps Missing in Solution Documentation .................................................. 378
   13.12.2 Error Message When Starting My Test Executions............................................................... 379
   13.12.3 Upload of Attachments to Steps or Test Cases does not work................................................ 380
13.13 Hints and Pitfalls Regarding Virus Scan Profiles....................................................................................... 380
13.14 Clickjacking Protection Framework in SAP NetWeaver AS ABAP an AS JAVA ................................................. 380
1 Introduction

1.1 Target Audience

This guide is intended for a target group that includes technical consultants, application consultants, support consultants, and others who plan to perform configuration activities.

1.2 Purpose and Scope of Information

This guide primarily contains step-by-step instructions to configure the Requirements-to-Deploy scenario with Focused Build for SAP Solution Manager (short form: Focused Build), using SAP Solution Manager 7.2 SPS 13 (or higher) and standalone extensions. It includes an appendix for repeat reference.

Keep in mind that while this guide contains some general Focused Build information, our other resources contain detailed information of topics other than configuration. Navigate to the Additional Online Resources for Focused Build section to find links for Focused Build capabilities, the application help for Focused Build, the security guide for Focused Build, initial installation instructions, and other topics.

Notable topics not covered by this guide include: SAP Solution Manager Rapid Deployment Solution for Change Control Management, SAP Solution Manager Rapid Deployment Solution for Solution Documentation, dashboarding service, dashboard factory.

1.3 How to Use This Guide

Start with understanding the table of contents. For this guide, browse through the table of contents. As a result, you get a sense of the overall organization:

- Setup chapters – to be able to start Focused Build configuration
- Configuration chapters – for Focused Build, implementation projects, standalone extensions, additional activities
- Appendix – of general reference information

Use the table of contents to focus your approach. The first few chapters concern pre-configuration (in this guide: setup) activities for Focused Build. You can read these setup chapters to make sure you have satisfied the prerequisites to start to configure Focused Build.

Once you have satisfied the prerequisites, consider a focused approach to this guide by using the table of contents to find configuration chapters and sub-chapters that concern your specific scenario or use case. Only particular sub-sections within the Configuration of Standalone Extensions chapter, for example, may be applicable to your landscape.
When referencing a sub-chapter that describes a configuration activity, look for that topic’s prerequisites in the first sub-chapters. The first sub-chapter has an XY.1 number format. For example, if you wanted to perform configuration activities from a sub-chapter numbered 19.5, then you can find the prerequisites sub-chapter in 19.1 or 19.2. Not all chapters have topic-specific prerequisites.

Check the appendix as needed. It serves as a repeat reference for useful SAP Notes, transaction types, and other general use topics.

1.4 Overview of Focused Build

Focused Build 2.0 SPS 8 is an add-on to SAP Solution Manager 7.2 SPS 13. Its official name is Focused Build for SAP Solution Manager. The specific component to download is ST-OST 200.

Focused Build enhances standard SAP Solution Manager features and processes by adding specific functions. Innovating business processes with minimal risk to live operations is a challenge for companies seeking to maintain and increase their competitive edge. The Focused Build approach supports customers in identifying and selecting the right building blocks from an SAP platform, and in deploying them in an optimal way.

Focused Build starts with the creation of requirements in process management (Solution Documentation). For these requirements, you create work packages. Work packages are then broken down to work items. Work items are subsequently implemented/deployed. The Requirements-to-Deploy process can involve individual changes, groups of changes, or planned releases that are aligned with a release plan and controlled by release phases.

For more information, see the Focused Build landing page, SAP Support Portal.

1.4.1 Installation of Focused Build

A prerequisite for initial installation of Focused Build is SAP Solution Manager 7.2 SPS 13. Be sure to install component ST-OST 200 according to Focused Build installation instructions on SAP Support Portal. After installation, configuration instructions can be found in the subsequent chapters of this guide.

1.5 Additional Online Resources for Focused Build

For additional Focused Build and related information, see the following resources:

  - SAP Support Portal's license update
  - Focused Build installation instructions on SAP Support Portal
• SAP Help Portal: Navigate to the Focused Build landing page, SAP Help Portal (https://help.sap.com/viewer/product/Focused_Build_Focused_Insights) for primarily technical information regarding the installation and operation of Focused Build, including the latest installation guides, SAP Notes, security guides, application help online, and additional related information. There is an overlap of some information, such as installation instructions, on both portals. This helps you to easily find what you’re looking for. Be sure to use the tabs at the top of the landing page to navigate to all available resources.
  o Application Help for Focused Build
2 Setup: SAP Solution Manager

2.1 Getting Started

Installation and setup of SAP Solution Manager 7.2 are prerequisites for the configuration of Focused Build. As a starting point for SAP Solution Manager 7.2, navigate to SAP Solution Manager landing page, SAP Help Portal and the Getting Started Guide. Content includes a master guide to help you understand SAP Solution Manager processes and to help you plan an SAP Solution Manager installation for your system landscape. See the following sub-chapters for setup activities.

2.2 Implementation of Mandatory SAP Notes

Ensure that the following SAP Notes are implemented for SAP Solution Manager or the managed system.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
<th>SAP Solution Manager</th>
<th>Managed System</th>
</tr>
</thead>
<tbody>
<tr>
<td>1818804</td>
<td>Change Request Management: Enable client restriction for import subsets</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>1731806</td>
<td>Change Request Management: Support of multi-client import</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2468171</td>
<td>ChaRM: Dump DBIF_RSQL_TABLE_UNKNOWN for table /SDF/TMW_ADM on shadow systems</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2335056</td>
<td>ChaRM: runtime error PERFORM_PARAMETER_MISSING during creation of ToCs</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

2.3 Changes to Number Ranges in Change Request Management

To adjust the number ranges, check that the Adapt Number Ranges activity is executed successfully. Check via SAP Solution Manager configuration (transaction: solman_setup) ‡ Change Request Management scenario ‡ Check Prerequisites step (2.1).

2.4 Assignment of Roles

It is important to assign roles in SAP Solution Manager to proceed with the configuration of Focused Build. For detailed instructions about assigning roles, visit SAP Solution Manager landing page, SAP Help Portal and scroll down to the links for SAP Solution Manager security guides. The landing page is regularly updated with links to the latest security guides.
3 Setup: Focused Build – Upgrade SPS 2/3 to SPS 4

3.1 Getting Started

If a support package stack (SPS) upgrade of Focused Build does not apply to you, please skip ahead to the applicable setup of Focused Build chapter.

As of SPS 4, the following /SALM/DATA_EXTRACTION_PPMITSM report variants are delivered with multi-process-mode switched on by default:

- FOCUSED_BUILD1
- FOCUSED_BUILD2
- FOCUSED_BUILD3

3.2 Activating the Piece List(s)

To activate the piece list, follow these steps:

1. Start transaction SCC1 in your working client.
2. In the Transport Request field, enter /SALM/FB_CUST.
3. (optional) For a first test without database update, you can set the flag for Test Run.
4. Select an option to start the import:
   - Immediately
   - As a background job
5. (optional) Verify activation in transaction SCC3.

As a result, your system loads the predefined customizing options.

3.3 Implementation of SAP Notes

Read the following central note before proceeding with the primary Focused Build configuration. Manual activities and bc-sets of this note must be implemented after activating the piece list.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2791634</td>
<td>Focused Build: Central Note for Focused Build 2.0 SP04 for SAP Solution Manager 7.2 SP09</td>
</tr>
</tbody>
</table>
If the target support package is not ST-OST SP04 do not try to implement SAP note 2791634. Instead implement the corresponding central SAP note to the target ST-OST support package.

In addition, consider reading and implementing these recommended SAP Notes.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2541761</td>
<td>Focused Build: Release Planning</td>
</tr>
<tr>
<td>2787227</td>
<td>Solution Manager 7.2 FP Stack 09: recommended corrections</td>
</tr>
</tbody>
</table>

### 3.4 Activating SALM_FB Service

To activate the SALM_FB service for IT Service Management, Change Request Management, and Product and Portfolio Management, follow these steps:

1. Start transaction SICF_INST.
2. Activate the following service:
   - SALM_FB

If the service is activated successfully, a green traffic light icon appears.

### 3.5 Setting System Aliases for OData Services

To configure OData Services for the UI5 applications of Focused Build, follow these steps:

1. Start transaction /n/IWFND/MAINT_SERVICE.
2. Search for services beginning with /SALM/* and select one after the other as is appropriate for your use case. Select one System Alias per service.
3. In the ICF Nodes service sub-screen, mark the OData entry.

<table>
<thead>
<tr>
<th>Technical Service Name</th>
<th>Use Case</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>/SALM/CRM_SERVICE_SRV</td>
<td>General CRM services like business partner search/value help</td>
<td>SP04</td>
</tr>
<tr>
<td>/SALM/IT_PPM_UI5_APP_SERVICE_SRV</td>
<td>Project Management</td>
<td>SP04</td>
</tr>
<tr>
<td>/SALM/MY_DOCS_SRV</td>
<td>My Documents</td>
<td>SP03</td>
</tr>
<tr>
<td>/SALM/SOLDOC_NODE_SELECTION_SRV</td>
<td>Node Selection Popup</td>
<td>SP04</td>
</tr>
<tr>
<td>/SALM/TEST_SUITE_DASHBOARD_SRV</td>
<td>Test Management Dashboard</td>
<td>SP03</td>
</tr>
</tbody>
</table>

5. Choose New Entries. Use the input help to search for and insert the services:
   - /SALM/TEST_SUITE_DASHBOARD_SRV_0001
6. Use the input help to search for and insert a local connection.

   Note
   The Default System flag should not be set unless you have several system aliases.

7. Save your selection.
As a result, the system alias appears on the overview screen.

3.6 Changes to AGS_WORK_CUSTOM Table Entries

Start transaction SM30 and ensure the following entries match those in the AGS_WORK_CUSTOM table:

<table>
<thead>
<tr>
<th>Parameter Key</th>
<th>Parameter Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>UIC_PROC_TYPE_SPECIFIC_08</td>
<td>/SALM/CMCD_H/CMCDDETAILS_S1HF</td>
</tr>
<tr>
<td>UIC_PROC_TYPE_SPECIFIC_09</td>
<td>/SALM/CMCD_H/CMCDDETAILS_S1SG</td>
</tr>
</tbody>
</table>

3.7 Implementation of report /SALM/WP_WI_CHAN_CLASSI

Run report /SALM/WP_WI_CHAN_CLASSI to implement it. As a result, non-classified work packages or work items are classified as GAPs because this is the most generic classification.

As of Focused Build SPS 4, the WRICEF classification has become mandatory. Before SPS 4, this was an optional field. Nonetheless, it may be the case that work items or work packages exist, but without a classification, making it necessary to implement the report.

3.8 Setting Default Values for Effort, Value and Story Points

To set default values, follow these steps:

1. In the customizing of SAP Solution Manager, choose SAP Solution Manager ➔ Focused Build ➔ Work Package Configuration ➔ Define Default Values for Effort, Value and Story Points.

2. Set default values for transaction types of the dropdown of the fields Value Points, Effort Points, and Story Points.
This ensures a standardization for the rating of requirements, work packages, and work items.

Within the second view of customizing node Default Values for Ranges, set default ranges for the search fields in Requirements Management and Mass Change Operations application. This allows a search for requirements, work packages, and work items.
in the standardized way. A range selection is meaningful when it covers all values that are maintained in the view Default Values for Transaction Types.

Initially, the customizing/view cluster above is empty. This allows the setting of all values in Value Points, Effort Points, and Story Points fields of your requirements, work packages, and work items. As a starting point, you can activate the bc-set /SALM/VALEFFSTORYPT_CUST in transaction SCPR20 for default customizing.

3.9 Activating BC-Sets

2. Activate the following bc-sets:
   - /SALM/72SP04/KPI_FRAMEWORK

3.10 (Optional) Enabling and Displaying Rich Text

To enable rich text editing, follow these steps:

1. Maintain the relevant business type of the transaction type in view CRMV_ITSM_SWITCH. (Content of this view is transportable within a custom request.)
   - For WP/BR/WR/RISK, entry: CRM_ITSM_COM = BUS2000116
   - For incidents/defect, entry: CRM_ITSM_COM = BUS2000223

2. Maintain individual text types in transaction CRMC_TEXT.
   - In the table shown below, add the fields for which you want to activate rich text.

   ![Rich text component in CRM](image)

   To display the rich text component in CRM and enable rich text editing, follow these steps:
   1. Choose the configure page icon.
2. Choose the edit icon (highlighted below) to enter edit mode.

3. Search for Available Assignment Blocks.
4. Select **GSTEXT**.

[Image: View Configuration - Google Chrome]

**Displayed Assignment Blocks**

- **Title 1 - Status Overview**
  - Component: GTEXT
  - View Name: MainWindow
  - Title: Test

- **Title 2 - Details**
  - Component: CIGGTestMain
  - View Name: MainWindow
  - Title: Text

5. Add it to the **Details** tile.

[Image: Title 2 - Details]

6. Create a request.

[Image: Select Request - Google Chrome]

7. Check that you can see a new **Text** tab as shown below.
3.11 UI2 Cache Maintenance

Please refer to [2319491 - How to clean up the cache after applying changes that affect SAP Fiori apps](#).

3.12 Changes to User Roles

Consider changes to user roles delivered by SAP.

- Respective role copies in the customer namespace must be adapted accordingly.

Changes of Focused Build-specific roles are documented in the Focused Build-specific security guides and in the roles' descriptions in the system.
4 Setup: Focused Build – Upgrade SPS 4 to SPS 5

4.1 Getting Started

If a support package stack (SPS) upgrade of Focused Build does not apply to you, please skip ahead to chapter Setup: Focused Build SPS 07.

4.2 Activating the Piece List

To activate the piece list, follow these steps:

1. Start the SAP Solution Manager Launchpad in your browser.
2. In the Launchpad group Focused Build - Tool Lead click on tile Configuration Focused Build.
3. Goto step 1.2 Setup Steps
4. Execute Automatic Activities Activate Piece List

As a result, your system loads the predefined customizing options.

4.3 Implementation of SAP Notes

Read the following central note before proceeding with the primary Focused Build configuration. Manual activities and bc-sets of this note must be implemented after activating the piece list.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2955721</td>
<td>Focused Build: Central Note for Focused Build 2.0 SP05 for SAP Solution Manager 7.2 SP10</td>
</tr>
</tbody>
</table>

Note

If the target support package is not ST-OST SP05 do not try to implement SAP note 2955721. Instead implement the corresponding central SAP note to the target ST-OST support package.

In addition, consider reading and implementing these recommended SAP Notes.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2541761</td>
<td>Focused Build: Release Planning</td>
</tr>
</tbody>
</table>
4.4 Activating SALM_FB Service

To activate the SALM_FB service for IT Service Management, Change Request Management, and Product and Portfolio Management, follow these steps:

1. Start transaction SICF_INST.
2. Activate the following service:
   - SALM_FB

If the service is activated successfully, a green traffic light icon appears.

4.5 Activating BC-Set

To activate relevant bc-sets, follow these steps:

2. Activate the following bc-set:
   - /SALM/7ZSP04/KPI_FRAMEWORK
     - Caution
     If you have already configured and adjusted the KPI framework with predecessor SP of Focused Build, you should not activate the above bc-set /SALM/7ZSP04/KPI_FRAMEWORK.
   - /SALM/TESTSUITE
   - /SALM/TEST_STEPS
     - Caution
     If you have adjusted the Test Steps settings already with Focused Build SPS 4, you should not activate the above bc-set /SALM/TEST_STEPS.

3. To avoid overwriting existing customizing adjustments, perform a comparison before activating the following bc-set.
   - Start customizing comparison by choosing the icon highlighted in the screenshot below.
   - Confirm no customizing will be overwritten and activate the following bc-set:
     - /SALM/FIXSPACE_APPROVALPROCEDURE
4.6 (Optional) Enabling and Displaying Rich Text

To enable rich text editing, follow these steps:

1. Maintain the relevant business type of the transaction type in view CRMV_ITSM_SWITCH. (Content of this view is transportable within a custom request.)
   - For WP/BR/WI/RISK, entry: CRM_ITSM_COM = BUS2000116
   - For incidents/defect, entry: CRM_ITSM_COM = BUS2000223

2. Maintain individual text types in transaction CRMC_TEXT.
   - In the table shown below, add the fields for which you want to activate rich text.

   ![Table](image)

To display the rich text component in CRM and enable rich text editing, continue with these steps:

3. Choose the configure page icon.
4. Choose the edit icon (highlighted below) to enter edit mode.

5. Search for Available Assignment Blocks.

6. Select GSTEXT.
7. Add it to the Details tile.

8. Create a request.

9. Check that you can see a new Text tab as shown below.
4.7 UI2 Cache Maintenance

Perform maintenance on certain caches, as instructed below:

- Clear the server HTTP cache
  - Start transaction SMICM.
  - Follow the path: Goto ⇒ HTTP plugin ⇒ Server cache ⇒ Invalidate Locally and Globally

- Clear metadata cache
  - Start transaction /IWFND/CACHE_CLEANUP on gateway (OData cache clearing)
  - Start transaction /IWBEP/CACHE_CLEANUP on backend and gateway (OData cache clearing)

- Synchronize chip cache
  - Run the report /UI2/CHIP_SYNCHRONIZE_CACHE
  - Make sure there is no error in the table /UI2/CHIP_CHDR

- Run report /UI2/DELETE_CACHE_AFTER_IMP.
- Run report /UI5/APP_INDEX_CALCULATE

- Clear local browser cache
  - Reason: To avoid views and resources being displayed from local browser cache

- Run report /UI2/INVALIDATE_GLOBAL_CACHES
  - Reason: This cache clearing is mandatory to verify the translations integrated for ex-tiles, groups, catalogs in launchpad admin

4.8 Changes to User Roles

Consider changes to user roles delivered by SAP.
  - Respective role copies in the customer namespace must be adapted accordingly.

Changes of Focused Build-specific roles are documented in the Focused Build-specific security guides and in the roles' descriptions in the system.
5 Setup: Focused Build – Upgrade SPS 5 to SPS 6

5.1 Getting Started

If a support package stack (SPS) upgrade of Focused Build does not apply to you, please skip ahead to chapter Setup: Focused Build SPS 07.

5.2 Activating the Piece List

To activate the piece list, follow these steps:
1. Start the SAP Solution Manager Launchpad in your browser.
2. In the Launchpad group Focused Build - Tool Lead click on tile Configuration Focused Build.
3. Goto step 1.2 Setup Steps
4. Execute Automatic Activities Activate Piece List and Activate Piece List 2
   As a result, your system loads the predefined customizing options.

5.3 Changes to AGS_WORK_CUSTOM Table Entries

In SOLMAN_SETUP step 1.2 Setup Steps execute activity Maintain AGS_WORK_CUSTOM automatically.
In SP06 the new parameter /SALM/IMPORT_PREPROD_CHECK is introduced. This parameter triggers in release phase 'Test' the consistency check 'IMPORT INTO X_OK', if the transport request, which is assigned to a Defect Correction, has been successfully imported to the Pre-production System, when the Defect is set to 'Confirmed'.

5.4 Implementation of SAP Notes

Read the following central note before proceeding with the primary Focused Build configuration. Manual activities and bc-sets of this note must be implemented after activating the piece list.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2910105</td>
<td>Focused Build: Central Note for Focused Build 2.0 SP06 for SAP Solution Manager 7.2 SP11</td>
</tr>
</tbody>
</table>

Note

If the target support package is not ST-OST SP06 do not try to implement SAP note 2910105. Instead implement the corresponding central SAP note to the target ST-OST support package.
In addition, consider reading and implementing these recommended SAP Notes.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2541761</td>
<td>Focused Build: Release Planning</td>
</tr>
</tbody>
</table>

5.5 Activating SALM_FB Service

1. Start transaction SOLMAN_SETUP in your working client.
2. Goto Focused Build in SOLMAN_SETUP.
3. Goto step 1.2 Setup Steps
4. Execute Manual Activities FB ICF Services

5.6 Defining System Aliases for OData Services

In defining system aliases, you configure OData services for Focus Build’s UI5 applications.

To define system aliases, follow these steps:

1. Start transaction SOLMAN_SETUP in your working client.
2. Goto Focused Build in SOLMAN_SETUP.
3. Execute step 1.4 Enable Gateway Services

5.7 Activating BC-Sets

To activate relevant bc-sets, follow these steps:

2. Activate the following bc-set:
   - /SALM/TESTSUITE
   - /SALM/72SP06/KPI_FRAMEWORK

   **Caution**

   If you have already configured and adjusted the KPI framework with predecessor SP of Focused Build, you should not activate the above bc-set /SALM/72SP04/KPI_FRAMEWORK.

3. (optional) To avoid overwriting existing customizing adjustments, perform a comparison before activating the following bc-set.
   - Start customizing comparison by choosing the icon highlighted in the screenshot below.
5.8  (Optional) Enabling and Displaying Rich Text

To enable rich text editing, follow these steps:

1. Maintain the relevant business type of the transaction type in view CRMV_ITSM_SWITCH. (Content of this view is transportable within a custom request.)
   - For WP/BR/WI/RISK, entry: CRM_ITSM_COM = BUS2000116
   - For incidents/defect, entry: CRM_ITSM_COM = BUS2000223

2. Maintain individual text types in transaction CRMC_TEXT.
   - In the table shown below, add the fields for which you want to activate rich text.
To display the rich text component in CRM and enable rich text editing, continue with these steps:

3. Choose the configure page icon.

4. Choose the edit icon (highlighted below) to enter edit mode.

5. Search for Available Assignment Blocks.

6. Select GSTEXT.
7. Add it to the Details tile.

8. Create a request.

9. Check that you can see a new Text tab as shown below.
5.9  UI2 Cache Maintenance

- Please refer to 2319491 - How to clean up the cache after applying changes that affect SAP Fiori apps
- Run report /UI5/APP_INDEX_CALCULATE
- Clear local browser cache
  - Reason: To avoid views and resources being displayed from local browser cache
- Run report /UI2/INVALIDATE_GLOBAL_CACHES
  - Reason: This cache clearing is mandatory to verify the translations integrated for ex-tiles, groups, catalogs in launchpad admin

5.10 Changes to User Roles

Consider changes to user roles delivered by SAP.
  - Respective role copies in the customer namespace must be adapted accordingly.
Changes of Focused Build-specific roles are documented in the Focused Build-specific security guides and in the roles' descriptions in the system.
6 Setup: Focused Build – Upgrade SPS 6 to SPS 7

6.1 Getting Started

If a support package stack (SPS) upgrade of Focused Build does not apply to you, please skip ahead to chapter 8 Setup: Focused Build SPS 8.

6.2 Delta Configuration

1. Start the SAP Solution Manager Launchpad in your browser.
2. In the Launchpad group Focused Build - Tool Lead click on tile Configuration Focused Build.
3. Re-run all activities which are flagged as Update needed

6.2.1 Activating the Piece List

To activate the piece list, follow these steps:
1. Start the SAP Solution Manager Launchpad in your browser.
2. In the Launchpad group Focused Build - Tool Lead click on tile Configuration Focused Build.
3. Goto step 1.2 Setup Steps
4. Execute Automatic Activities Activate Piece List and Activate Piece List 2
5. (optional) Verify activation in transaction SCC3.

As a result, your system loads the predefined customizing options.

6.2.2 Changes to AGS_WORK_CUSTOM Table Entries

In SOLMAN_SETUP step 1.2 Setup Steps execute activity Maintain AGS_WORK_CUSTOM automatically.

6.2.3 Implementation of SAP Notes

Read the following central note before proceeding with the primary Focused Build configuration. Manual activities and bc-sets of this note must be implemented after activating the piece list.
In addition, consider reading and implementing these recommended SAP Notes.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2955721</td>
<td>Focused Build: Central Note for Focused Build 2.0 SP07 for SAP Solution Manager 7.2 SP12</td>
</tr>
<tr>
<td>2541761</td>
<td>Focused Build: Release Planning</td>
</tr>
</tbody>
</table>

### 6.2.4 Activating SALM_FB Service

1. Start transaction `SOLMAN_SETUP` in your working client.
2. Goto Focused Build in `SOLMAN_SETUP`.
3. Goto step 1.2 Setup Steps
4. Execute Manual Activities FB ICF Services

### 6.2.5 Defining System Aliases for OData Services

To define system aliases, you configure OData services for Focus Build's UI5 applications.

1. Start transaction `SOLMAN_SETUP` in your working client.
2. Goto Focused Build in `SOLMAN_SETUP`.
3. Execute step 1.10 Enable Gateway Services

### 6.2.6 Activating BC-Sets

To define system aliases, follow these steps:

1. Start transaction `SOLMAN_SETUP` in your working client.
2. Goto Focused Build in `SOLMAN_SETUP`.
3. Execute step 1.4 Test Suite Extensions Activity Activate Test Suite Configuration
4. Click on the navigation link and activate bc-set `/SALM/TESTSUITE`

⚠️ Caution

If you have already configured and adjusted the KPI framework, Test Suite/Steps or Fix Pace Approval Procedure with a predecessor Support Package of Focused Build, you should not directly activate the above bc-set(s). Rather proceed with step 5.
5. To avoid overwriting existing customizing adjustments, perform a comparison before activating any of the previously mentioned bc-set(s).
   - Select the respective bc-set above
   - Start customizing comparison by choosing the icon highlighted in the screenshot below.
   - Confirm no customizing will be overwritten and activate the previously checked bc-set.

6. **Execute step 1.10 Test Suite Extensions Activity Activate Test Steps Configuration**

7. Click on the navigation link and activate bc-set /SALM/TEST_STEPS

   **Caution**
   If you have already configured and adjusted the KPI framework, Test Suite/Steps or Fix Pace Approval Procedure with a predecessor Support Package of Focused Build, you should not directly activate the above bc-set(s). Rather proceed with step 8.

8. To avoid overwriting existing customizing adjustments, perform a comparison before activating any of the previously mentioned bc-set(s).
   - Select the respective bc-set above
   - Start customizing comparison by choosing the icon highlighted in the screenshot below.
   - Confirm no customizing will be overwritten and activate the previously checked bc-set.

9. **Execute step 1.2 Setup Steps Activity Configure KPI-Framework**

10. Click on the navigation link and activate bc-set /SALM/KPI_HIERARCHY

   **Caution**
   If you have already configured and adjusted the KPI framework, Test Suite/Steps or Fix Pace Approval Procedure with a predecessor Support Package of Focused Build, you should not directly activate the above bc-set(s). Rather proceed with step 11.
11. To avoid overwriting existing customizing adjustments, perform a comparison before activating any of the previously mentioned bc-set(s).
   - Select the respective bc-set above
   - Start customizing comparison by choosing the icon highlighted in the screenshot below.

[Image of Business Configuration Sets: Activation]

   - Confirm no customizing will be overwritten and activate the previously checked bc-set.

12. Execute step 1.2 Setup Steps Activity Activate Fix Pace Configuration
13. Click on the navigation link and activate bc-set /SALM/FIXPACE_APPROVALPROCEDURE

   ![Caution](image)

   If you have already configured and adjusted the KPI framework, Test Suite/Steps or Fix Pace Approval Procedure with a predecessor Support Package of Focused Build, you should not directly activate the above bc-set(s). Rather proceed with step 14.

14. To avoid overwriting existing customizing adjustments, perform a comparison before activating any of the previously mentioned bc-set(s).
   - Select the respective bc-set above
   - Start customizing comparison by choosing the icon highlighted in the screenshot below.

[Image of Business Configuration Sets: Activation]

   - Confirm no customizing will be overwritten and activate the previously checked bc-set.

15. Execute step 1.2 Setup Steps Activity Configure Task Type Visibility
16. Click on the navigation link and activate bc-set /SALM/TASKTYPEVISIBILTY

6.2.7 Configuring Active Import Feedback

To configure the Active Import Feedback, follow these steps:
1. Go to transaction SOLMAN_SETUP and execute the activity Check Active Import Feedback Job under Focused Build step 1.1. Check Prerequisites which proves if the background job for Active Import Feedback is regularly scheduled.

2. Extend the authorization of the user SM_CHM by assigning the role SAP_OST_FB_CHM which executes the background job and the subsequent activities.

3. Go to transaction SOLMAN_SETUP and check step 3 Check Software Prerequisites under Change Control Management -> Managed System Setup if you have installed the latest SAP Solution Tools Plug-in (ST-PI) onto the managed systems. ST-PI is a plug-in in the managed system providing a major Application Programming Interface (API) for interacting with SAP Solution Manager.

4. Go to transaction SOLMAN_SETUP step 1.8 Batch Import and execute the activity Activate Import Feedback BadI to activate the BadI implementation /SALM/RBI_IMPORT_FEEDBACK:

5. Go to transaction SOLMAN_SETUP step 1.8 Batch Import and execute the activity Configure Active Import Feedback.

6.2.8 (Optional) Make Requirement Description obligatory

The 'Description' field is intended to describe the Requirement content in detail.

By default, the maintenance of the 'Description' field is optional.

If you want to make the maintenance of this field obligatory before saving a newly created Requirement, go to Focused Build in transaction SOLMAN_SETUP to step 1.6 Requirements Management Configuration and under Automatic Activities set the radio button Make Requirement Description obligatory and execute the activity.

6.2.9 (Optional) Enabling and Displaying Rich Text

To enable rich text editing, follow these steps:
1. Maintain the relevant business type of the transaction type in view CRMV_ITSM_SWITCH. (Content of this view is transportable within a custom request.)
   o For WP/BR/WI/RISK, entry: CRM_ITSM_COM = BUS2000116
   o For incidents/defect, entry: CRM_ITSM_COM = BUS2000223

2. Maintain individual text types in transaction CRMC_TEXT.
   o In the table shown below, add the fields for which you want to activate rich text.

To display the rich text component in CRM and enable rich text editing, continue with these steps:

3. Choose the configure page icon.

4. Choose the edit icon (highlighted below) to enter edit mode.
5. **Search for Available Assignment Blocks.**

   ![View Configuration - Google Chrome](image1)

   **Available Assignment Blocks**

   **Displayed Assignment Blocks**

6. **Select GSTEXT.**

   ![View Configuration - Google Chrome](image2)

   **Displayed Assignment Blocks**

7. **Add it to the Details tile.**

   ![View Configuration - Google Chrome](image3)

   **Displayed Assignment Blocks**
8. Create a request.

9. Check that you can see a new Text tab as shown below.

### 6.3 UI2 Cache Maintenance

- Please refer to [2319491 - How to clean up the cache after applying changes that affect SAP Fiori apps](#)
- Run report `/UI5/APP_INDEX_CALCULATE`
- Clear local browser cache
  - Reason: To avoid views and resources being displayed from local browser cache
- Run report `/UI2/INVALIDATE_GLOBAL_CACHES`
  - Reason: This cache clearing is mandatory to verify the translations integrated for ex-tiles, groups, catalogs in launchpad admin

### 6.4 Changes to User Roles

Consider changes to user roles delivered by SAP.
- Respective role copies in the customer namespace must be adapted accordingly.
Changes of Focused Build-specific roles are documented in the Focused Build-specific security guides and in the roles' descriptions in the system.
7 Setup: Focused Build – Upgrade SPS 7 to SPS 8

7.1 Getting Started

If a support package stack (SPS) upgrade of Focused Build does not apply to you, please skip ahead to chapter 8 Setup: Focused Build SPS 8

7.2 Delta Configuration

1. Start the SAP Solution Manager Launchpad in your browser.
2. In the Launchpad group Focused Build - Tool Lead click on tile Configuration Focused Build.
3. Re-run all activities which are flagged as Update needed

7.2.1 Activating the Piece List

To activate the piece list, follow these steps:
1. Start the SAP Solution Manager Launchpad in your browser.
2. In the Launchpad group Focused Build - Tool Lead click on tile Configuration Focused Build.
   If the tile is not available by default, it can be found in the tile catalogue.
3. Goto step 1.2 Setup Steps
4. Execute Automatic Activities Activate Piece List
5. (optional) Verify activation in transaction SCC3.

As a result, your system loads the predefined customizing options.

Caution

Since default customizing for Focused Build is provided via the piece list and it could happen that changes have taken place for e.g. configuration of email notification or setting Requirements description as obligatory, these adjustments need to be re-performed because it will be reseted by the activation.

7.2.2 Changes to AGS_WORK_CUSTOM Table Entries

In SOLMAN_SETUP step 1.2 Setup Steps execute activity Maintain AGS_WORK_CUSTOM automatically.
7.2.3 Implementation of SAP Notes

Read the following central note before proceeding with the primary Focused Build configuration. Manual activities and bc-sets of this note must be implemented after activating the piece list.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3034068</td>
<td>Focused Build: Central Note for Focused Build 2.0 SP08 for SAP Solution Manager 7.2 SP13</td>
</tr>
</tbody>
</table>

In addition, consider reading and implementing these recommended SAP Notes.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2541761</td>
<td>Focused Build: Release Planning</td>
</tr>
</tbody>
</table>

7.2.4 Activating SALM_FB Service

1. Start transaction SOLMAN_SETUP in your working client.
2. Goto Focused Build in SOLMAN_SETUP.
3. Goto step 1.2 Setup Steps
4. Execute Manual Activities FB ICF Services

7.2.5 Defining System Aliases for OData Services

In defining system aliases, you configure OData services for Focus Build’s UI5 applications.

To define system aliases, follow these steps:

1. Start transaction SOLMAN_SETUP in your working client.
2. Goto Focused Build in SOLMAN_SETUP.
3. Execute step 1.4 Enable Gateway Services

7.2.6 Activating BC-Sets

To define system aliases, follow these steps:

1. Start transaction SOLMAN_SETUP in your working client.
2. Goto Focused Build in SOLMAN_SETUP.
3. Execute step 1.4 Test Suite Extensions Activity Activate Test Suite Configuration
4. Click on the navigation link and activate bc-set /SALM/TESTSUITE
Caution
If you have already configured and adjusted the KPI framework, Test Suite/Steps or Fix Pace Approval Procedure with a predecessor Support Package of Focused Build, you should not directly activate the above bc-set(s). Rather proceed with step 5.

5. To avoid overwriting existing customizing adjustments, perform a comparison before activating any of the previously mentioned bc-set(s).
   - Select the respective bc-set above
   - Start customizing comparison by choosing the icon highlighted in the screenshot below.

   ![Business Configuration Sets: Activation]
   - Confirm no customizing will be overwritten and activate the previously checked bc-set.

6. Execute step 1.10 Test Suite Extensions Activity Activate Test Steps Configuration
7. Click on the navigation link and activate bc-set /SALM/TEST_STEPS

Caution
If you have already configured and adjusted the KPI framework, Test Suite/Steps or Fix Pace Approval Procedure with a predecessor Support Package of Focused Build, you should not directly activate the above bc-set(s). Rather proceed with step 8.

8. To avoid overwriting existing customizing adjustments, perform a comparison before activating any of the previously mentioned bc-set(s).
   - Select the respective bc-set above
   - Start customizing comparison by choosing the icon highlighted in the screenshot below.

   ![Business Configuration Sets: Activation]
   - Confirm no customizing will be overwritten and activate the previously checked bc-set.

9. Execute step 1.2 Setup Steps Activity Configure KPI-Framework
10. Click on the navigation link and activate bc-set /SALM/KPI_HIERARCHY
Caution

If you have already configured and adjusted the KPI framework, Test Suite/Steps or Fix Pace Approval Procedure with a predecessor Support Package of Focused Build, you should not directly activate the above bc-set(s). Rather proceed with step 11.

11. To avoid overwriting existing customizing adjustments, perform a comparison before activating any of the previously mentioned bc-set(s).
   - Select the respective bc-set above
   - Start customizing comparison by choosing the icon highlighted in the screenshot below.

   ![Business Configuration Sets: Activation](image)

   - Confirm no customizing will be overwritten and activate the previously checked bc-set.

12. Execute step 1.2 Setup Steps Activity Activate Fix Pace Configuration
13. Click on the navigation link and activate bc-set /SALM/FIXPACE_APPROVALPROCEDURE

Caution

If you have already configured and adjusted the KPI framework, Test Suite/Steps or Fix Pace Approval Procedure with a predecessor Support Package of Focused Build, you should not directly activate the above bc-set(s). Rather proceed with step 14.

14. To avoid overwriting existing customizing adjustments, perform a comparison before activating any of the previously mentioned bc-set(s).
   - Select the respective bc-set above
   - Start customizing comparison by choosing the icon highlighted in the screenshot below.

   ![Business Configuration Sets: Activation](image)

   - Confirm no customizing will be overwritten and activate the previously checked bc-set.

15. Execute step 1.2 Setup Steps Activity Configure Task Type Visibility
16. Click on the navigation link and activate bc-set /SALM/TASKTYPEVISIBILITY
7.2.7 Configuring Active Import Feedback

To configure the Active Import Feedback, follow these steps:

1. Goto transaction SOLMAN_SETUP and execute the activity Check Active Import Feedback Job under Focused Build step 1.1. Check Prerequisites which proves if the background job for Active Import Feedback is regularly scheduled.

2. Extend the authorization of the user SM_CHM by assigning the role SAP_OST_FB_CHM which executes the background job and the subsequent activities.

3. Goto transaction SOLMAN_SETUP and check step 3 Check Software Prerequisites under Change Control Management -> Managed System Setup if you have installed the latest SAP Solution Tools Plug-in (ST-PI) onto the managed systems. ST-PI is a plug-in in the managed system providing a major Application Programming Interface (API) for interacting with SAP Solution Manager.

4. Goto transaction SOLMAN_SETUP step 1.8 Batch Import and execute the activity Activate Import Feedback BadI to activate the BadI implementation /SALM/RBI_IMPORT_FEEDBACK:

5. Goto transaction SOLMAN_SETUP step 1.8 Batch Import and execute the activity Configure Active Import Feedback.

7.2.8 (Optional) Make Requirement Description obligatory

The 'Description' field is intended to describe the Requirement content in detail.

By default, the maintenance of the 'Description' field is optional.

If you want to make the maintenance of this field obligatory before saving a newly created Requirement, goto Focused Build in transaction SOLMAN_SETUP to step 1.6 Requirements Management Configuration and under Automatic Activities set the radio button Make Requirement Description obligatory and execute the activity.
7.2.9  My Defects: Configuring automatic Actions for Email Notification

With Focused Build Requirements-to-Deploy SP08 the following automatic Actions for E-Mail Notification for the Focused Build Defect are provided:

- S1DM_MAIL_REPORTER
- S1DM_MAIL_PROCESSOR

These automatic actions are shipped to Customers inactively.

In case that a customer would like to use these automatic actions, he/she has to perform the following steps:

- Copy the respective mail action into the customer namespace to avoid implications in case of reactivating the piece list.
- Set the previously copied automatic PPF Actions to ‘active’ within the Action Profile of the Focused Build Defect (S1DM_ACTIONS)
- Assign a customer own Mail Form in the Method Call of the PPF Action.

With the Status Change of a Defect, an automatic E-Mail Notification will be sent out to the relevant Focused Build User.

7.2.10  (Optional) Enabling and Displaying Rich Text

To enable rich text editing, follow these steps:

1. Maintain the relevant business type of the transaction type in view CRMV_ITSM_SWITCH. (Content of this view is transportable within a custom request.)
   - For WP/BR/WI/RISK, entry: CRM_ITSM_COM = BUS2000116
   - For incidents/defect, entry: CRM_ITSM_COM = BUS2000223

2. Maintain individual text types in transaction CRMC_TEXT.
   - In the table shown below, add the fields for which you want to activate rich text.
To display the rich text component in CRM and enable rich text editing, continue with these steps:

3. Choose the configure page icon.

4. Choose the edit icon (highlighted below) to enter edit mode.

5. Search for Available Assignment Blocks.
6. Select **GSTEXT**.

7. Add it to the **Details** tile.
8. Create a request.

9. Check that you can see a new Text tab as shown below.

7.3 UI2 Cache Maintenance

- Please refer to [2319491 - How to clean up the cache after applying changes that affect SAP Fiori apps](#)
- Run report `/UI5/APP_INDEX_CALCULATE`
- Clear local browser cache
  - Reason: To avoid views and resources being displayed from local browser cache
- Run report `/UI2/INVALIDATE_GLOBAL_CACHES`
  - Reason: This cache clearing is mandatory to verify the translations integrated for ex-tiles, groups, catalogs in launchpad admin

7.4 Changes to User Roles

Consider changes to user roles delivered by SAP.
  - Respective role copies in the customer namespace must be adapted accordingly.

Changes of Focused Build-specific roles are documented in the Focused Build-specific security guides and in the roles’ descriptions in the system.
8 Setup: Focused Build SPS 8

8.1 Getting Started

Installation of Focused Build 2.0 SPS 8 is a prerequisite to set up Focused Build for configuration. To install Focused Build, the specific SAP Solution Manager 7.2 component to download is ST-OST 200.

- For more information, see Focused Build installation instructions on SAP Support Portal.
- If you are upgrading Focused Build from SPS 2, SPS 3, SPS 4, SPS 5, SP06 or SPS 7 to SPS 8, check the table of contents and refer to the corresponding Setup: Focused Build chapters in this guide instead of the chapters 9 and 10.

Both SAP Solution Manager's support consultant role and the customer's counterparts should perform the activities in the following sub-chapters.

⚠️ Caution

Be sure to follow the sequence of setup steps described in the following sub-chapters. Namely, activate the piece list before you implement SAP Note 3034070.

8.2 Activating the Piece List

To activate the piece list, follow these steps:

1. Start the SAP Solution Manager Launchpad in your browser.
2. In the Launchpad group Focused Build - Tool Lead click on tile Configuration Focused Build.
3. Goto step 1.2 Setup Steps
4. Execute Automatic Activities Activate Piece List

As a result, your system loads the predefined customizing options.

8.3 Implementation of SAP Notes

Read the following central note before proceeding with the primary Focused Build configuration. The note includes:

- Technical and organizational prerequisites regarding configuration
- Post-installation instructions

Manual activities of this note must be implemented after activating the piece list.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3034068</td>
<td>Focused Build: Central Note for Focused Build 2.0 SP08 for SAP Solution Manager 7.2 SP13</td>
</tr>
</tbody>
</table>
In addition, consider reading and implementing these recommended SAP Notes.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2541761</td>
<td>Focused Build: Release Planning</td>
</tr>
</tbody>
</table>

8.4 Setting Up Transaction Types

The appendix provides a table of Focused Build transaction types and their descriptions. The following Focused Build transaction types require set up.

To set up these transaction types for use in Focused Build, follow these steps:

2. Enter the data as listed in the following table.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Sequence No</th>
<th>Field Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARM_ADD</td>
<td>According to customer requirements</td>
<td>S1IT</td>
</tr>
<tr>
<td>CHARM_ADD</td>
<td>According to customer requirements</td>
<td>S1RK</td>
</tr>
<tr>
<td>CHARM_ADD</td>
<td>According to customer requirements</td>
<td>S1CR</td>
</tr>
<tr>
<td>CHARM_ADD</td>
<td>According to customer requirements</td>
<td>S1MJ</td>
</tr>
<tr>
<td>CHARM_ADD</td>
<td>According to customer requirements</td>
<td>S1CG</td>
</tr>
<tr>
<td>CHARM_ADD</td>
<td>According to customer requirements</td>
<td>S1TR</td>
</tr>
<tr>
<td>CHARM_ADD</td>
<td>According to customer requirements</td>
<td>S1HF</td>
</tr>
<tr>
<td>CHARM_ADD</td>
<td>According to customer requirements</td>
<td>S1BR</td>
</tr>
<tr>
<td>CHARM_ADD</td>
<td>According to customer requirements</td>
<td>S1MT</td>
</tr>
<tr>
<td>CHARM_ADD</td>
<td>According to customer requirements</td>
<td>S1IR</td>
</tr>
<tr>
<td>PROCESS_TYPE_ADD</td>
<td>According to customer requirements</td>
<td>SMFG</td>
</tr>
<tr>
<td>PROCESS_TYPE_ADD</td>
<td>According to customer requirements</td>
<td>SIDM</td>
</tr>
<tr>
<td>SMUD_TYPE_S1BR</td>
<td>According to customer requirements</td>
<td>FBBR</td>
</tr>
<tr>
<td>ENH_APP</td>
<td>According to customer requirements</td>
<td>X</td>
</tr>
</tbody>
</table>

8.5 Copying Customizing Entries for Project Management

To get Project Management working, copy standard customizing entries from client 000 into the working client.
To copy customizing entries for Project Management, follow these steps:

1. Start the SAP Solution Manager Launchpad in your browser.
2. In the Launchpad group Focused Build - Tool Lead click on tile Configuration Focused Build.
3. Goto step 1.2 Setup Steps
4. Execute Activity Project Management Configuration

8.6 Activating All Services

To activate all services for IT Service Management, Change Request Management, and Product and Portfolio Management, follow these steps:

1. Start transaction SICF_INST.
2. Activate the following services: ^
   - SM_CRM_UI
   - SALM_FB

If the services are activated successfully, a green traffic light icon appears.

3. (optional) Add a logout screen. Follow these instructions to Configure a Logout Screen for SAP Fiori Launchpad.
4. Enter the following URL at Redirect to URL:

8.7 Activating BC- Sets

To activate relevant bc-sets, follow these steps:

2. Activate the following bc-set:
   - /SALM/KPI_HIERARCHY
   - /SALM/TESTSUITE
   - /SALM/TEST_STEPS
Caution

If you have already configured and adjusted the KPI framework, Test Suite/Steps or Fix Pace Approval Procedure with a predecessor Support Package of Focused Build, you should not directly activate the above bc-set(s). Rather proceed with step 3.

3. To avoid overwriting existing customizing adjustments, perform a comparison before activating any of the previously mentioned bc-set(s).
   - Select the respective bc-set above
   - Start customizing comparison by choosing the icon highlighted in the screenshot below.

   ![Business Configuration Sets: Activation](image)

   - Confirm no customizing will be overwritten and activate the previously checked bc-set.

8.8 Setting Up System Roles

The appendix provides a table of system roles. Any initially delivered system roles are based on those roles.

To check existing system roles, follow these steps:

2. View SMSY_ROLES.

As a result, a given system may show a different set of system roles. There are two options:

- Adjust the release dashboard customizing
- Adjust the system roles

To adjust system roles, follow these steps:
1. Start transaction MAINT_ROLES.
   - (Optional) Create additional roles from this view.

2. Use the up and down arrows to change the order of system roles according to the sequence transport landscape.
   - For a customer's already-defined set of system roles, adjust the customizing of the release dashboard and batch import.

3. In the customizing of SAP Solution Manager, choose **SAP Solution Manager** ‡ **Focused Build** ‡ **Dashboard Configurations** ‡ **Document KPI Framework** to adjust the system role dependencies.

   **Recommendation**
   Consider having different system roles for different systems. For example, a development system in the development branch gets the system role C-Development System and another development system in the maintenance branch gets the role 2-Maintenance Development System.

### 8.9 Adding an Entry to the HTTPURLLOC Table

Depending on the HTTPURLLOC table's current configuration, a new entry may be necessary to open Web Dynpro applications of Focused Build with the correct URL.

To add a new entry to the HTTPURLLOC table, follow these steps:

1. Start transaction SE16.
2. Add entry `/WEBDYNPRO/SALM/*` after the entry `/WEBDYNPRO/SAP/*`, but before entry `/*`

For more information, see the Wiki page: **How to Maintain the Table HTTPURLLOC?**
9  Configuration: Focused Build Activities

9.1  Import Control: Background Processing

Import control in the Requirements-to-Deploy scenario provides options for mass deployment.

- Standard import customizing defines deployment rules for imports executed from a task list. The task list imports normal changes (which receive a preliminary import status) and urgent changes.
- Batch import customizing defines deployment rules for imports in a release context.
  - /SALM/BATCH_IMPORT_TRIGGER manages the import of normal changes.

**Recommendation**

If you configure several systems for batch import, several background processes should also be available with job class C. Following this recommendation, 10 parallel systems need 10 background processes.

9.1.1  Import Variants Delivered via the Piece List

The following import variants are delivered via the piece list:

- /SALM/RELEASE_PRE
  For imports into PRE-PRD of everything included in one release
- /SALM/RELEASE
  For imports into PRE-PRD of everything included in one release
- /SALM/INTEGRATION_TEST
  For imports of defect corrections of release test phase into PRE-PRD
- /SALM/QAS
  For imports into QAS
- /SALM/STD_CHANGE
  For imports of Standard Changes into QAS or PRE
- /SALM/STD_CHANGE_PRD
  For imports of Standard Changes into PRD

9.1.2  (Optional) Setting Batch Import Variants

You can adjust standard customization and maintain the system-related data for import control. An adjustment of the batch import variants node is not mandatory because a default customization is already provided by the piece list. As a prerequisite, the piece list must be successfully activated.
To adjust batch import variants, follow these steps:

1. In the customizing of SAP Solution Manager, choose **SAP Solution Manager ➤ Focused Build ➤ Release Deployment and Batch Import ➤ Configure Release Deployment & Batch Import**.

2. Copy the respective variant you would like to adjust to avoid any interferences with Focused Build’s future support packages and piece lists.

3. Make changes to import control data available for adjusting:
   - Date and time validity
   - Weekday specifications

### 9.1.3 Changes to System Roles in Import Configuration

Adjust import configuration according to your requirements and system landscape. As a prerequisite, the piece list must be successfully activated. As a result, standard customizing is provided. The **Import Config** field of the **Import Configuration** menu option, as shown in the screenshot below, depends on the system role. If system roles differ from the recommended set of system roles, **Import Config** must be copied to adjust **SysRole ID**. For further information about recommended system roles, refer to chapter Setting Up System Roles.

### 9.1.4 (Optional) Setting Import Sequence of Systems

For special use cases, imports must be performed sequentially, system after system (such as ERP and BW).

To set the import sequence of systems, follow these steps:

1. Choose **Maintain Import Sequence of Systems** from the left-side panel, as shown in the screenshot below.

2. Maintain **System**, **Client**, and **Imp. Seq.** (short for import sequence).
If such a use case is not applicable, the node can be left empty.

9.1.5 Setting Up System Landscape in Maintain Landscape Data

To set up your system landscape within the Maintain Landscape Data view, follow these steps:

1. Select Maintain Landscape Data from the left-side navigation panel, as shown in the screenshot below.

2. Adjust your system landscape per Import Config entry:
   - Under Solution ID, maintain a dedicated solution.
   - The Release Component can be maintained with a wildcard (*).
   - For a non-ABAP system, select the Non-ABAP checkbox.
   - If you have more than one system for an Import Config entry, create one entry per system.
   - If you have the same system with different clients in different Import Config entries, create each entry with a different ID.

   Note
   - Please keep in mind that Maintain Landscape Data is considered master data, which needs to be maintained on each SAP Solution Manager individually.
   - In addition, if you create additional releases, those must be maintained here, or you must maintain the Release Component with a wildcard (*).
3. Maintain clients per Import Config and system.
   o A sequence can be used in the same way as for the systems previously.
   o The standard RFC Type is Trusted RFC.

   ![Change View "Maintain System Clients" Overview](image)

   **Note**

   Additional authorization is required for communication (for example, for reading the import buffer). The user of the RFC that connects to the managed system (TMW RFC for the communication client) must have authorization for the TMW_PROJECT_LOCK function group in the managed system for the \_RFC authorization object. The fallback solution is a client 000 connection.

### 9.1.6 Starting Imports Based on Variant

To start and schedule an import based on variant, follow these steps:

1. Start transaction SE38.
   o Alternatively, start transaction SA38
2. Run /SALM/BATCH\_IMPORT\_TRIGGER.
3. Select the relevant Release(s) to Import.
   **Note**

   The first release of your release component is always the active one. Completed releases are not shown in the list.

4. Select the relevant Import Variant.
5. (optional) To run /SALM/BATCH\_IMPORT\_TRIGGER regularly, select the **Enable Automatic Rescheduling** checkbox and set the frequency in minutes.
9.2 Configuring Active Import Feedback

To configure the Active Import Feedback, follow these steps:

1. **Goto transaction SOLMAN_SETUP and execute the activity Check Active Import Feedback Job under Focused Build step 1.1. Check Prerequisites which proves if the background job for Active Import Feedback is regularly scheduled.**

2. **Extend the authorization of the user SM_CHM by assigning the role SAP_OST_FB_CHM which executes the background job and the subsequent activities.**

3. **Goto transaction SOLMAN_SETUP and check step 3 Check Software Prerequisites under Change Control Management -> Managed System Setup if you have installed the latest SAP Solution Tools Plug-in (ST-PI) onto the managed systems. ST-PI is a plug-in in the managed system providing a major Application Programming Interface (API) for interacting with SAP Solution Manager.**

4. **Goto transaction SOLMAN_SETUP step 1.8 Batch Import and execute the activity Activate Import Feedback BadI to activate the BadI implementation /SALM/RBI_IMPORT_FEEDBACK:**

6. Repeat the previous step for all required variants.
5. Goto transaction SOLMAN_SETUP step 1.8 Batch Import and execute the activity Configure Active Import Feedback

9.2.1 (Optional) Setting Up Batch Import Housekeeping

To set up batch import housekeeping, follow these steps:

1. Run report /SALM/BATCH_IMPORT_CLEAN_LOGS.
2. Set the schedule in days, as shown in the screenshot below.

   ![Clean BI Run Log Tables](image)

   Recommendation

   Schedule the report daily to keep your database working.


   ![Batch Import Log Delete](image)

For more information on batch import housekeeping, see SAP note 2774831 - Focused Build - Release/Batch Import: cleanup of logs.
9.3 Solution Readiness Dashboard: Data Extraction

9.3.1 Extracting Data

To extract data for Solution Readiness Dashboard, follow these steps:

1. Start the SAP Solution Manager Launchpad in your browser.
2. In the Launchpad group Focused Build - Tool Lead click on tile Configuration Focused Build.
3. Goto step 2 Standard Jobs
4. In step 2.1 Maintain System User an appropriate background user can be created.
5. In step 2.2 Schedule Jobs schedule all jobs. Especially the job for report /SALM/DATA_EXTRACTION_PPMITSM will be scheduled.

9.3.2 Cleanup of Extraction Data

To cleanup extraction data, follow these steps:

1. Start the SAP Solution Manager Launchpad in your browser.
2. In the Launchpad group Focused Build - Tool Lead click on tile Configuration Focused Build.
3. Goto step 1.9 Focused Build Dashboard Configuration
4. Execute manual activity Cleanup of Extraction Data
   - To cleanup extraction data for unused projects.
   - To compress transactional historic data on a weekly basis.

9.3.3 Additional Extraction Job for Release Dashboard

The extraction job /SALM/DATA_EXTRACTION_PPMITSM throws the event SAP_EXTRACTORExtent.
You can use this event to schedule the job:

- `SALM/CREATE_RELEASE_CACHE` event periodic in SM36.

  **After the job** `/SALM/DATA_EXTRACTION_PPMITSM` **has run, all caches are invalidated and** `/SALM/CREATE_RELEASE_CACHE` **populates them again. The scheduling of this job is necessary to speed up the initial load time of the Release Dashboard.**

  **Recommendation**

  Run program `/SALM/DATA_BUFFER_DELETE` after each customization change of KPI values (maintenance view: `/salm/vc_kpi`) or CRM status schema.

### 9.3.4 Data Extraction for Test Management Dashboard

To extract data for Test Management Dashboard, follow these steps:

1. Start the SAP Solution Manager Launchpad in your browser.
2. In the Launchpad group **Focused Build - Tool Lead** click on tile **Configuration Focused Build**.
3. Goto step **2 Standard Jobs**
4. In step **2.1 Maintain System User** an appropriate background user can be created.
5. In step **2.2 Schedule Jobs** schedule all jobs. Especially the job for report `/SALM/TSD_DATA_EXTRACTION` will be scheduled.

### 9.3.5 Transfer of Recorded Times

To transfer recorded times, follow these steps:

1. Start the SAP Solution Manager Launchpad in your browser.
2. In the Launchpad group **Focused Build - Tool Lead** click on tile **Configuration Focused Build**.
3. Goto step **2 Standard Jobs**
4. In step **2.1 Maintain System User** an appropriate background user can be created.
5. In step **2.2 Schedule Jobs** schedule all jobs. Especially the job for report `DPR_CATS_CPR_TRANSF` will be scheduled.

### 9.4 Configuration for Conversion Project Support

This chapter is only required when you want to use the Simplification Item Management Application in your Conversion Project.

#### 9.4.1 Schedule background job for Progress Dashboard

1. Start transaction `SE38`, choose report `/SALM/SIM_PROGRESS_EXTRACT`, click on Execute (F8).
2. In the next screen, open the F4-help for Analysis GUID. Choose the Readiness Check Analysis for which you want to extract the data in the Progress Dashboard.

3. In the menu, choose Goto – Variants – Save as Variant. Provide a Variant Name and a Description. Click on Save.

4. Start transaction SM36. Provide a meaningful Job Name. Click on Step.

5. Provide the User who should execute the job. In the "ABAP program"-section, enter report /SALM/SIM_PROGRESS_EXTRACT in the Name field. In field Variant, enter the variant you created in step 3. Click on Save.

6. Go one step back and click on Start Condition. Define a suitable Date/Time. Flag Periodic Job and click on Period values. The report must be executed Daily, choose it and click on Save. In the "start time" window, click also on Save.

7. In the "Define Background Job" window, click also on Save. The Background job is now scheduled, you can check the job log from transaction SM37.

9.4.2 Maintain selection of Transaction Types and Project for Follow-Up Documents

With Support Package 8 it is possible to define which transaction types are allowed as follow-up type for conversion activities. By default, without maintaining any entry in view /SALM/SIM_RC_TT, it is S1BR (Requirement) and S1IT (Work Package) with multiple assignment allowed, the assignment of Projects is possible as well.

Customers who want to use their own custom transaction types in the Readiness Check integration can activate this in the following way:

1. Go to transaction SM30 and open view /SALM/SIM_RC_TT:

2. Create a new entry. For field "Analysis GUID" open the F4-help and select the Readiness Check for which you want to change the default follow-up types.
3. Select two transaction types in the related fields. With the flag "Multiple Assignment Allowed" you can specify whether the merge of several conversion activities into one follow-up document is allowed.

With the flag "Project Assignment Allowed" you can specify whether conversion activities can be assigned to Project.

4. To ensure a proper status update from the custom transaction types to the conversion activities go to transaction SM34 and open table AIC_SETTINGS2. In the top tree, select your first custom transaction type that you assigned in step 3. In the structure, click on "Assign Actions".

Adjust the Update from Follow-Up to Conversion Activities according to your needs by assigning the action S1_SETPREDOC to the status where the update to the predecessor document should take place.

9.5 Activating Virus Scan Profiles

To activate the virus protection in your development system, follow these steps:

1. Start transaction /n/IWFND/VIRUS_SCAN.

2. Search and activate the virus scan profile /UI5/UI5_INFRA_APP/REP_DT_PUT.
   - Ensure that the Virus Scan Switched Off checkbox is not selected, as shown in the screenshot below.

3. Start transaction VSCANPROFILE to check virus protection.
9.6 Configuring Multilevel Categorization

Multilevel categorization lets you sort business transactions into as many as four levels. It integrates functions such as auto-completion and item determination based on categories. It searches for related problems, knowledge articles, and change requests.

To configure multilevel categorization for Focused Build, follow these steps:

1. Start transaction SM_CRM.
2. Choose Service Operations and then Categorization Schemas.
3. Create a new categorization schema and name it **FOCUSED_BUILD**.

![Categorization Schemas](image)

4. Assign the application areas as follows:

- **Application ID**: Service Order
- **Parameter**: Transaction Type / Catalog Category
- Choose all S1*/D except S1TR/D (test requests) and save your selection.

5. Assign the application areas as follows:
- **Application ID**: Service Request
- **Parameter**: Transaction Type / Catalog Category
6. Upload the categorization schema `FB_General.txt`:
   - Choose S1DM/D and save your selection.
   - Start transaction CATEGOTOOL.
   - Select Import Schema.

   ![Image of Export and Import Categorization Schema]

   - Select Import as highlighted in the screenshot below to upload schema into the schema previously created in the WebClient UI.

   ![Image of Create a Draft Schema Referring to the Selected Schema]

   - In transaction SM_CRM, navigate to the categorization schema search.
   - Choose FOCUSED_BUILD.
Choose a future date and time.

Release the schema.

For schema samples, view attachments in SAP Note 2955721. For more information about multilevel categorization, navigate to SAP Note 2451880 for the Multilevel Categorization guide.

9.7 Changes to AGS_WORK_CUSTOM Table Entries

In SOLMAN_SETUP step 1.2 Setup Steps execute activity Maintain AGS_WORK_CUSTOM automatically.

<table>
<thead>
<tr>
<th>Parameter Key</th>
<th>Parameter Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IM_CRM_UI_PPF_900</td>
<td>HF_SET_STATUS</td>
</tr>
<tr>
<td>IM_CRM_UI_PPF_901</td>
<td>/SALM/COPY_DOCUMENT</td>
</tr>
<tr>
<td>PARTNER_FCT_DEVELOPER_S1CG</td>
<td></td>
</tr>
<tr>
<td>PARTNER_FCT_DEVELOPER_S1MJ</td>
<td></td>
</tr>
<tr>
<td>PARTNER_FCT_OWNER_S1BR</td>
<td></td>
</tr>
<tr>
<td>UIC_PROC_TYPE_SPECIFIC_01</td>
<td>AIC_CMCD_H/AICCMCOVERVIEW_S1MR</td>
</tr>
<tr>
<td>UIC_PROC_TYPE_SPECIFIC_02</td>
<td>AIC_CMCD_H/AICCMCHEADEREF_S1MR</td>
</tr>
<tr>
<td>UIC_PROC_TYPE_SPECIFIC_03</td>
<td>/SALM/CMCR_H/CMCROVERVIEW_S1MT</td>
</tr>
<tr>
<td>UIC_PROC_TYPE_SPECIFIC_04</td>
<td>/SALM/CMCR_H/CMCRDETAILS_S1MT</td>
</tr>
<tr>
<td>UIC_PROC_TYPE_SPECIFIC_05</td>
<td>/SALM/REL_TRANS/RELATEDTRANSACTIONS_S1MT</td>
</tr>
<tr>
<td>UIC_PROC_TYPE_SPECIFIC_08</td>
<td>/SALM/CMCD_H/CMCDDETAILS_S1HF</td>
</tr>
<tr>
<td>UIC_PROC_TYPE_SPECIFIC_09</td>
<td>/SALM/CMCD_H/CMCDDETAILS_S1SG</td>
</tr>
<tr>
<td>UIC_PROC_TYPE_SPECIFIC_SALM_01</td>
<td>/SALM/CMCD_H/CMCDOVERVIEW_S1MR</td>
</tr>
<tr>
<td>UIC_PROC_TYPE_SPECIFIC_SALM_02</td>
<td>/SALM/CMCD_H/CMCDDETAILS_S1MR</td>
</tr>
<tr>
<td>USER_STATUS_DESIGN_COMPL_S1BR</td>
<td></td>
</tr>
<tr>
<td>/SALM/IMPORT_PREPROD_CHECK</td>
<td></td>
</tr>
</tbody>
</table>

In case that you utilize another System Role, for instance ‘2’ for your Pre-production System, the following value for the new Parameter ‘/SALM/IMPORT_PREPROD_CHECK’ is required: IMPORT_INTO_2_OK.

9.8 Requirements Management: Customization Options

There are several options to customize Requirements Management because requirements and work packages can relate in various ways to each other. Navigate to the customizing of SAP Solution Manager, in SOLMAN_SETUP step 1.6 Requirements Management Configuration execute activity Customizing Requirements Management. Ensure the work packages and the
business requirements transaction types are customized correctly. Ensure those entries match the entries in the following table.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Type: BR Requirement</td>
<td>S1BR</td>
</tr>
<tr>
<td>Process Type: Defect Message</td>
<td>S1DM</td>
</tr>
<tr>
<td>Process Type: Work Item (with TR)</td>
<td>S1MJ</td>
</tr>
<tr>
<td>Process Type: Work Item (without TR)</td>
<td>S1CG</td>
</tr>
<tr>
<td>Process Type: Urgent Change</td>
<td>S1HF</td>
</tr>
<tr>
<td>Process Type: Work Package</td>
<td>S1IT</td>
</tr>
<tr>
<td>Process Type: Master Work Package</td>
<td>S1MT</td>
</tr>
<tr>
<td>Process Type: CR for IT Requirement</td>
<td>S1IR</td>
</tr>
<tr>
<td>Process Type: Risk</td>
<td>S1RK</td>
</tr>
<tr>
<td>Process Type: Defect Correction</td>
<td>S1TM</td>
</tr>
<tr>
<td>Required relationship between requirement and work packages</td>
<td>n:m</td>
</tr>
</tbody>
</table>

Note

For the above table entry Required relationship between requirement and work packages, there are several customizing options:
- 1:1
- 1:n
- n:m

9.8.1 Setting Default Values for Effort, Value, and Story Points

To set default values, follow these steps:

1. In the customizing of SAP Solution Manager, choose SAP Solution Manager ➤ Focused Build ➤ Work Package Configuration ➤ Define Default Values for Effort, Value and Story Points.
2. Set default values for transaction types of the dropdown of the fields Value Points, Effort Points, and Story Points. This ensures a standardization for the rating of requirements, work packages, and work items.

Within the second view of customizing node Default Values for Ranges, set default ranges for the search fields in Requirements Management and Mass Change Operations application. This allows a search for requirements, work packages, and work items in the standardized way. A range selection is meaningful when it covers all values that are maintained in the view Default Values for Transaction Types.
Initially, the customizing/view cluster above is empty. This allows the setting of all values in Value Points, Effort Points, and Story Points fields of your requirements, work packages, and work items. As a starting point, you can activate the bc-set /SALM/VALEFFSTORYPT_CUST in transaction SOLMAN_SETUP step 1.2 Setup Steps execute activity Define Values for Effort, Value and Story Points. for default customizing.

9.8.2  (Optional) Make Requirement Description obligatory

The ’Description’ field is intended to describe the Requirement content in detail. By default, the maintenance of the ’Description’ field is optional. If you want to make the maintenance of this field obligatory before saving a newly created Requirement, goto Focused Build in transaction SOLMAN_SETUP to step 1.6 Requirements Management Configuration and under Automatic Activities set the radio button Make Requirement Description obligatory and execute the activity.

9.9  (Optional) Set Up of E-Mail Notification for Work Packages and Work Items

You can set up your system to send e-mails to users regarding Change Request Management tasks and change transactions. To enable this function for work packages and work items, copy the provided email actions into the customer namespace and follow SAP Help Portal’s standard customizing steps for Change Request Management.

9.10  (Optional) Enabling and Displaying Rich Text

To enable rich text editing, follow these steps:

1. Maintain the relevant business type of the transaction type in view CRMV_ITSM_SWITCH. (Content of this view is transportable within a custom request.)
   - For WP/BR/WI/RISK, entry: CRM_ITSM_COM = BUS2000116
   - For incidents/defect, entry: CRM_ITSM_COM = BUS2000223

2. Maintain individual text types in transaction CRMC_TEXT.
In the table shown below, add the fields for which you want to activate rich text.

<table>
<thead>
<tr>
<th>Text Object</th>
<th>Text Object Description</th>
<th>ID</th>
<th>Text ID Description</th>
<th>Formatted</th>
<th>HTML-Text</th>
<th>Converter Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRM_ORDERS</td>
<td>Transaction Header</td>
<td>T005</td>
<td>Comment</td>
<td>✓</td>
<td>✓</td>
<td>CL_CRM_TEXT_FORMAT_CONVERSION</td>
</tr>
<tr>
<td>CRM_ORDERS</td>
<td>Transaction Header</td>
<td>T015</td>
<td>Description</td>
<td>✓</td>
<td>✓</td>
<td>CL_CRM_TEXT_FORMAT_CONVERSION</td>
</tr>
<tr>
<td>CRM_ORDERS</td>
<td>Transaction Header</td>
<td>T010</td>
<td>Reply</td>
<td>✓</td>
<td>✓</td>
<td>CL_CRM_TEXT_FORMAT_CONVERSION</td>
</tr>
<tr>
<td>CRM_ORDERS</td>
<td>Transaction Header</td>
<td>T019</td>
<td>Description</td>
<td>✓</td>
<td>✓</td>
<td>CL_CRM_TEXT_FORMAT_CONVERSION</td>
</tr>
</tbody>
</table>

To display the rich text component in CRM and enable rich text editing, follow these steps:

1. Choose the configure page icon.

2. Choose the edit icon (highlighted below) to enter edit mode.

3. Search for Available Assignment Blocks.
4. Select GSTEXT.

5. Add it to the Details tile.
6. Create a request.

7. Check that you can see a new Text tab as shown below.

9.11 Activating Required BadIs

To activate required BadIs, follow these steps:

1. In the customizing of SAP Solution Manager, in SOLMAN_SETUP step 1.2 Setup Steps execute activity Activation of Required BadIs. Choose SAP Solution Manager ‡ Focused Build ‡ Work Package Configuration ‡ Activation of required BadIs ‡ Activation of COM_PARTNER_BADI.
2. From this view (shown above), activate the implementation /SALM/ITR_PARTNER.

3. Activate the implementation /SALM/FIELDCHECKS.
   - Found in the customizing of SAP Solution Manager
   - Found via SAP Solution Manager ‣ Focused Build ‣ Work Package Configuration ‣ Activation of required BadIs ‣ Activation of CRM_ORDER_FIELDCHECK_NEW

9.12 Release Management: Activation of Features

9.12.1 Activating Enhanced Release Management Functionalities

To use the enhanced Release Management functionalities of Focused Build, follow these steps:

1. In the customizing of SAP Solution Manager, in SOLMAN_SETUP step 1.7 Release Management execute activity Enhance Release Management Functionality.

2. Maintain your Solution Sublandscape ID with the relevant cycle transaction type S1MR.

9.12.2 Checking Release Management Profiles

To check new release management profiles, follow these steps:

1. In SOLMAN_SETUP step 1.7 Release Management execute activity Checking Release Management Profile.
2. Check whether all entries are available.
   - If no entries are available, reference the following chapter: Activating the Piece List.

9.12.3 Activating Cross-System Lock for Development Clients

Please note the following prerequisites:
- RFC connections (including CSOL_BACK RFC destination) have been generated.
- Required entry in table BCOS_CUST on the managed development system has been created.

To activate cross-system lock, follow these steps:

1. Implement the following SAP notes:

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
<th>SAP Solution Manager</th>
<th>Managed System</th>
</tr>
</thead>
<tbody>
<tr>
<td>2402504</td>
<td>ChaRM: Back RFC Check Support</td>
<td>(X)</td>
<td>X</td>
</tr>
<tr>
<td>2468171</td>
<td>ChaRM: Dump DBIF_RSQL_TABLEUNKNOWN for table /SDF/TMW_ADM on shadow systems</td>
<td>(X)</td>
<td>X</td>
</tr>
</tbody>
</table>

2. Install the newest SAP Solution Tools Plug-in (ST-PI) on your managed development system.

3. For the dedicated development system (maintenance and project development systems), choose On for Upon-Saving Checks.
   - To do so, go to SAP Solution Manager launchpad.
     - Navigate to the landscape view and choose On as shown in the screenshot below.
9.13  Defining System Aliases for OData Services

In defining system aliases, you configure OData services for Focus Build's UI5 applications.

To define system aliases, follow these steps:

1. Start transaction SOLMAN_SETUP in your working client.
2. Goto Focused Build in SOLMAN_SETUP.
3. Execute step 1.4 Enable Gateway Services

9.14  (Optional) Replacing Dynamic My Documents Tile with Static Version

Please refer to SAP note 2804107 - Focused Build: My Documents static tile exchange.

9.15  Configuring Exceptions for Naming of Automatically-Created KPI Documents

This functionality is delivered active. The default option for document title generation for automatically-created documents is:

\(<\text{Document Type technical ID}>_{<\text{Name of structure node where document is created}>}_{<\text{File Extension}>}\)

Within this configuration, you have the following options:

- Deactivate the automated document creation
- Define exceptions of the above naming rule

To define exceptions, follow these steps:

1. Start transaction SPRO.
2. Select SAP Reference IMG.
3. Navigate to SAP Solution Manager ➔ Focus Build ➔ Documentation ➔ Exceptions for naming of automatically created KPI documents.

4. Select the option Exceptions for naming of automatically created KPI documents.

5. In the table (shown below), specify:
   - Solution Name
   - Solution Manager Document Type
   - For Prefix Option (used during auto-creation of documents), choose between:
     - No prefix used
     - Self-defined prefix
     - Technical document type
   - For Title Option (used during auto-creation of documents), choose between:
     - Enter at runtime
     - Name of structure

<table>
<thead>
<tr>
<th>Solution Name</th>
<th>Solution Manager Document Type</th>
<th>Prefix Option</th>
<th>Title Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>S10100000001</td>
<td>Technical Document Type</td>
<td>No prefix used</td>
<td>Enter at runtime</td>
</tr>
<tr>
<td>S10100000002</td>
<td>Technical Document Type</td>
<td>No prefix used</td>
<td>Enter at runtime</td>
</tr>
<tr>
<td>S10100000003</td>
<td>Technical Document Type</td>
<td>No prefix used</td>
<td>Enter at runtime</td>
</tr>
<tr>
<td>S10100000004</td>
<td>Technical Document Type</td>
<td>No prefix used</td>
<td>Enter at runtime</td>
</tr>
</tbody>
</table>
9.16 Test Suite: Configuration Activities

9.16.1 Configuring Test Suite Extensions

To configure the Test Suite extensions for Focused Build, follow these steps:
1. Navigate to Customizing for SAP Solution Manager ‣ Focused Build ‣ Test Suite Extensions.
2. Use the following views:
   - Defect Status Aggregations
   - Define Work Package Status Values for Test Preparation Tiles
   - Test Steps

Alternatively, to configure the Test Suite extensions for Focused Build, follow these steps:
1. Start Test Suite Administration from SAP Solution Manager launchpad.
2. Access and maintain the views on the tab page Test Suite Extension:
   - Check Report
     - Check configurations and user authorizations
   - Defect Status Aggregations
     - Maintain the defect status aggregation
   - Work Package Status Values for Test Preparation Tiles
     - Maintain work package statuses for test preparation tiles of the Test Suite dashboard
   - Test Steps
     - Execute report /SALM/TM_TS_TD_SMUD_LAY_TYPEF in transaction SE38. Solution Documentation list view is enhanced by filter types Test Steps <Original> and Test Steps <Reference>
     - Define general settings for the test steps application (such as execution mode, available languages, status-based execution lock, and others)
     - Define status settings for status of steps (such as label, default status, and evidence required)
     - Define custom fields which can be used as result attributes during design of test steps documents
     - Define folders to group and organize test steps documents in the designer application
     - Define status aggregation rules which will aggregate step status to test case status during test execution
     - Define settings of the test steps table view showing steps in design time and execution time

9.16.2 Checking Test Suite Configurations

To check Test Suite configurations, follow these steps:
1. Start the Check Report from SAP Solution Manager launchpad.
2. Choose between general checks and Test Suite checks.
   - To check if the assignments between the Test Suite and the project or the solution are correct, select General Checks and select a solution or project.
To check configurations for the Test Suite, select Test Suite Checks. If you select this option, the following status information is displayed:

- Activations for ICF services
- Customizing for the Test Suite

### 9.16.3 Mapping Defect Status Aggregations

Use a customized schema for defect processing that contains multiple defect statuses. To get a simplified representation of these defect statuses, you can consolidate the multiple customized defect statuses to a limited set of aggregated statuses.

- For example, you could use a customized schema for defect transaction types S1DM or SMIN. To account for multiple status values, you could map several defect statuses, such as Proposed Solution, Complete and Resolved to the aggregated status Solution Provided.

**Note**

Focused Build uses the following set of five aggregated status values:

- Created
- In Progress
- Awaiting Information
- Solution Provided
- Confirmed

To map defect statuses, follow these steps:

1. In the customizing for SAP Solution Manager, choose SAP Solution Manager ➤ Focused Build ➤ Test Suite Extensions ➤ Defect Status Aggregations.
2. Alternatively, you can access this mapping table by choosing Defect Status on the Test Suite Extension tab page of the Test Suite Administration.
3. Map the detailed statuses of the defect transaction types to aggregated values as desired.

### 9.16.4 Setting Work Package Status Values for Test Preparation Tiles

In the Test Suite dashboard, define additional tiles for the test preparation view to display the number of work packages without test cases.

Customize the status values of work packages (S1IT) for which you require additional tiles. Consider the following status values:

- To be developed
- In development
- To be tested

To set the status values of work packages, follow these steps:
1. In Customizing for SAP Solution Manager, choose SAP Solution Manager  
   Focused Build  
   Test Suite Extensions  
   Define Work Package Status Values for Test Preparation Tiles.
   - Alternatively, you can access this mapping table by choosing Define Work Package Status Values for Test Preparation Tiles on the tab page Test Suite Extension of Test Suite Administration.

2. Add the work package status values as prompted.

9.16.5 (Optional) Enable application state for My Test Executions

My Test Executions supports the application state which allows you to share the state of an application via a link. By default the application state works in a transient mode and data is not persisted on the server.

For this to work, the following FLP configuration parameters will have to be maintained using transaction /UI2/FLP_CUS_CONF.

For this to work, the following FLP configuration parameters will have to be maintained using transaction /UI2/FLP_CUS_CONF.
For more information, see:
- Setting Parameters in SAP Fiori Customizing
- Cleanup of Expired Application State

9.16.6 Configuring Test Steps

Make sure that you have activated the bc-set /SALM/TEST_STEPS. Please refer to chapter 8.7 Activating BC-Sets.

9.16.6.1 Test Steps Designer Folder Maintenance

With the Test Steps Designer's customizing activity, Folders for Test Steps Designer, create and maintain folders to group test cases of test steps.

9.16.6.2 Customer Fields for Test Steps Result Attributes Maintenance

In the customizing activity Customer Fields for Test Steps Result Attributes, maintain fields to store result values during execution times for test cases.

A sample field for "MATERIAL_DOC" could contain the following:
- **Label**: Material Document
- **Data Element**: CHAR10
- **Rendering**: Input Field
9.17 Project Management: Configuration of Project Templates

9.17.1 Creating Project Templates

To create project templates, follow these steps:

1. Download the project template XML files from the following SAP Note:

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3034068</td>
<td>Focused Build: Central Note for Focused Build 2.0 SP08 for SAP Solution Manager 7.2 SP13</td>
</tr>
</tbody>
</table>

2. Choose My Projects from SAP Solution Manager launchpad to start Project Management.
3. Choose Projects and Import Project.
4. In the Application field, select XML File.

5. In the File field, choose Browse to navigate to the file that you want to import.
6. Choose Import Selected Data.
7. Under Data for Import, select Structures and Resources.
8. Choose Check.
9. Choose Import.

10. After uploading all XML project files, convert them into a project template.
11. In Project Management, navigate to Portfolio and Project Administration.
12. On the left navigation pane, choose Project Management Templates.
13. Choose **Project Administration** in the top navigation area.

14. Choose **Create**.

15. Enter the following settings to create your template project (reference both table and screenshot below):

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proj. Template</td>
<td><code>&lt;Your choosing&gt;</code></td>
</tr>
<tr>
<td>Template Type</td>
<td>Project</td>
</tr>
<tr>
<td>Template</td>
<td>One of the projects provided, for example, <code>&lt;Template: Focused Build_Build_Project&gt;</code></td>
</tr>
<tr>
<td>New Checklist Templates</td>
<td>None</td>
</tr>
<tr>
<td>Original Language</td>
<td>English</td>
</tr>
</tbody>
</table>

16. Release the project template by setting the status to **released**.

**Note**

After creating templates, you can delete the previously-uploaded projects again. Please refer to chapter Deletion of Obsolete Projects.
10 Configuration: Focused Build-Based Implementation Project

10.1 Target Group

This chapter targets the methodology and tool coach who plans and prepares for a Focused Build-based implementation project.

10.2 Prerequisites for Project Preparation

Please note the following technical and the content-related prerequisites for a planned Focused Build project.

10.2.1 Technical Prerequisites

Technical prerequisites include configuration of systems listed below:

- Solution Manager configuration
  - General (SOLMAN_SETUP): mandatory configuration, managed systems configuration (per system under test), embedded search
  - Involved standard capabilities (Solution Documentation, Change Request Management basic setup, Test Suite, IT PPM)
- Users with required roles and authorization, and business partners
- Focused Build-specific configuration

10.2.2 Content-Related Prerequisites

See the tables below for required customer master data. The data should result from conceptual discussions with the customer. Consider the solution, Release Management, and Project Management among other factors for a planned Focused Build project.

<table>
<thead>
<tr>
<th>Solution Name</th>
<th>such as Corporate Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical Name</td>
<td>such as CORP_SOL</td>
</tr>
<tr>
<td>Production</td>
<td></td>
</tr>
<tr>
<td>Branches (at least Development and Design)</td>
<td>Maintenance</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Document Types and templates</strong></td>
<td></td>
</tr>
<tr>
<td>such as (BPD) Business Process Description</td>
<td></td>
</tr>
<tr>
<td>such as (CG) Configuration Guide</td>
<td></td>
</tr>
<tr>
<td>such as (FIT) Functional Integration Test</td>
<td></td>
</tr>
<tr>
<td>such as (FS) Functional Specification type WRICEF</td>
<td></td>
</tr>
<tr>
<td>such as (FS) Functional Specification type Gap</td>
<td></td>
</tr>
<tr>
<td>such as (FS) Functional Specification type Interface</td>
<td></td>
</tr>
<tr>
<td>such as (SFT) Single Functional Test</td>
<td></td>
</tr>
<tr>
<td>such as (TD) Technical Design</td>
<td></td>
</tr>
<tr>
<td>such as (UAT) User Acceptance Test</td>
<td></td>
</tr>
<tr>
<td>such as (UC) Use Case</td>
<td></td>
</tr>
<tr>
<td>such as (UG) User Guide</td>
<td></td>
</tr>
<tr>
<td>such as (MO) Mock-up</td>
<td></td>
</tr>
<tr>
<td>such as (TM) Training Material</td>
<td></td>
</tr>
<tr>
<td><strong>Content to be imported (such as Best Practice for S/4HANA x.xx US)</strong></td>
<td></td>
</tr>
<tr>
<td>such as “SAP Best Practices for SAP S/4HANA, on-premise edition 1602 US”</td>
<td></td>
</tr>
<tr>
<td><strong>Involved Systems / Landscape (Logical Component Group(s), Technical Systems)</strong></td>
<td>Log Comp Grp.</td>
</tr>
<tr>
<td>S4HANA</td>
<td>Sandbox</td>
</tr>
<tr>
<td></td>
<td>Development</td>
</tr>
<tr>
<td></td>
<td>Quality Assurance</td>
</tr>
<tr>
<td></td>
<td>Pre-Production</td>
</tr>
<tr>
<td></td>
<td>Production</td>
</tr>
<tr>
<td><strong>Release Management</strong></td>
<td></td>
</tr>
<tr>
<td>Number of planned Releases</td>
<td>2</td>
</tr>
<tr>
<td>Duration in days</td>
<td>180</td>
</tr>
<tr>
<td>Go-Live Date for 1st Major Release</td>
<td>October 1st 2017</td>
</tr>
<tr>
<td><strong>Project Management</strong></td>
<td></td>
</tr>
<tr>
<td>Project Templates</td>
<td>Lean or Activate Roadmap based template</td>
</tr>
</tbody>
</table>
### 10.3 A Solution with Branches, System Landscape, and Document-Type Assignment

#### 10.3.1 Definition of Solution

A solution can be defined as the sum of a company’s systems, applications, and processes. It acts as a container for versions of solution documentation, one of which is the production version.

**Recommendation**

The general recommendation is to use only one solution to reflect the entire system landscape and its documentation, even for large and interconnected companies.

#### 10.3.1.1 Creating a Solution

As an assumed prerequisite condition, the customer is not yet using any solution in their SAP Solution Manager system.

To create a solution, follow these steps:

1. Enter **Solution Administration** via transaction SOLMA DM or SAP Solution Manager launchpad (Section **Project and Process Management** † **Solution Documentations**), as shown in the screenshot below.
2. Select the global functions icon as shown below and select **Create Solution**.

As a result, the solution is created and accessible via transaction `SOLADM` and SAP Solution Manager launchpad.

3. Provide a name, a technical name, and confirm.

10.3.2 Definition of a Branch

A branch represents a version of the solution documentation that contains processes, libraries, and systems. With the branch concept, it is possible to distinguish between documentation that describes productive processes and documentation that describes processes currently in design or build.

Typically, a solution contains a production branch, a maintenance branch, and a development branch.

- The production branch represents the productive version of the entire solution documentation.
- The maintenance branch represents the editable version of the productive solution documentation. It provides a safe environment for performing changes.
- The development branch represents the documentation of a future solution documentation.

For an SAP S/4HANA implementation, we recommend the following branch structure:
Caution

The development branch must be enabled for Change Control.

The design is the branch to be used during Build Design Support.

10.3.2.1 Setting Up Branches

To create the best practice branch structure, follow these steps:
1. Ensure that you are in the correct solution in transaction SOLADM.
2. Select the Branches tab to view the production and maintenance branches as shown below:

   ![Branches Screenshot]

3. Mark the production branch and choose Create.
4. From the below screen that appears, which confirms the parent branch (in this case: production branch), select Implementation Branches (Best Practice).
5. Enable change control for the development branch and confirm.

As a result, the branches for the solution look like the below screenshot.

**Note**

For Focused Build setup, it is mandatory that you create at least one additional branch (such as design) below the development branch.
10.3.3 Definitions Regarding System Landscape

Certain functions of SAP Solution Manager (like Solution Documentation) refer to a certain system. For example, the documentation of an S/4 process in the design branch refers to an S/4 sandbox system. In SAP Solution Manager, logical component groups and logical components are used to model the system landscape for the use of SAP Solution Manager functions like Solution Documentation.

Key Definitions:
A logical component group (LCG) is a high-level view on an application. It is a group of logical components which contain systems of a kind (S/4HANA, ERP Logistics, ERP Human Resources, CRM, or PORTAL). LCGs are used to depict the execution runtime (of process steps, for example). The LCG is a release independent placeholder for concrete systems.

A logical component (LC) refers to the concrete technical systems of a system track typically belonging to the same transport landscape and having the same product version. Assigned technical systems of logical components are classified according to their system role (such as development system, quality assurance system).

Demo Landscape: The prototype uses a demo landscape, which is a simulation of transport landscape. The demo landscape uses different clients in the same system. For more information on how to create a demo landscape, see the appendix.

10.3.3.1 Setting Up a Logical Component Group

To create an LGC, follow these steps:
1. Ensure that you are in the correct solution in transaction SOLADM.
2. Choose the System Landscape tab to display the branches created, as shown in the screenshot below.
3. Choose Maintain Logical Component Groups.

As a result, a screen appears showing all LCGs that are available for this solution.
4. Choose Create to create a new LCG for the SAP S/4HANA landscape.

5. In the next screen, provide a name and description of the logical component group to be created.

6. Select the technical system type.
   - For an SAP S/4HANA system, ABAP Application Server ABAP is applicable.

7. Close the next screen.

As a result, the view shows that a logical component group has been created. The view shows that the LGC is assigned to all branches of the solution.

With this result, you can implement best practice content.

10.3.4 Assigning a Sandbox System

At the start of an SAP S/4HANA project, the customer might not have built up the full system landscape yet. However, the customer will most likely have an SAP S/4HANA sandbox to perform the fit-gap analysis. This makes the sandbox system the relevant system for the activities to be documented in the import and design branches.
In this example, we assume that a system S4H / client 100 acts as an SAP S/4HANA sandbox. To make a system assignment, the system must be known to SAP Solution Manager. That means the system must exist in LMDB and an RFC exists (preferably, the managed system setup was executed).

For the prototype, use the demo landscape instead of an SAP S/4HANA system.

To use a demo landscape, follow these steps:

1. Ensure that you are in the correct solution from transaction SOLADM.
2. Choose the System Landscape tab to display the branches and the logical component group created.

4. In the following screen, select the Import branch and the logical component Import-Global.
5. Navigate to the sandbox system field.
6. Open the search help to get related system/client information for the sandbox role.

8. For the Design branch, assign the same system/client for the sandbox role.
9. Choose OK.

10. Repeat steps 4 to 9 for all branches according to this table and input from the customer’s landscape, entered in chapter: Content-Related Prerequisites.

<table>
<thead>
<tr>
<th>Logical Component</th>
<th>System: Client (Role)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import</td>
<td>SMD:900 (Sandbox)</td>
</tr>
<tr>
<td>Design</td>
<td>SMD:900 (Sandbox)</td>
</tr>
<tr>
<td>Development</td>
<td>SMD:901 (Development)</td>
</tr>
<tr>
<td></td>
<td>SMD:902 (QA)</td>
</tr>
<tr>
<td></td>
<td>SMD:903 (Preproduction)</td>
</tr>
<tr>
<td>Production</td>
<td>SMD:904 (Production)</td>
</tr>
</tbody>
</table>

In our example, the result looks like this:

![Solution Administration](image)

10.3.5 Considerations If Process Management Is Already in Use

If the customer is already using Process Management in SAP Solution Manager, the customer also actively uses a solution. There should be an initial discussion with the customer regarding whether the same already-created solution should be used for SAP S/4HANA implementation.

Keeping the definition of solution in mind (see chapter Definition of a Solution), it is likely that an SAP S/4HANA project will use an already-created solution. If there is still a need to create a separate solution, reference the steps described in the previous sections.

If an existing solution should be used, the following general considerations apply. If you are unsure what is the best approach on how to deal with the solutions/branches in a certain customer situation, please reach out to MCC to request support.

Branch Setup
We recommend separating an SAP S/4HANA implementation from other implementation projects or the maintenance of the current solution. To do this, we recommend a branch structure of Development => Design => Import under the production branch. This structure can co-exist with other branches under the production branch.
The screenshot below shows a branch structure example. The green highlight shows an example of two existing branches, which are used by the customer for maintenance and other projects than an SAP S/4HANA implementation project. The red highlight shows the branch structure for an SAP S/4HANA implementation project.

Both branch structures release their content to the production branch. If the same processes, process steps, or other objects change in different branches at the same time, there must be conflict resolution before releasing the changes.

Since an SAP S/4HANA implementation is working with a different set of systems, there shouldn’t be the need to invest much effort in conflict resolution.

System Landscape Setup

This is similar to the greenfield situation. There is a need for logical component groups for SAP S/4HANA landscapes, including logical components and systems. If those are already created by the customer, they should be re-used. If not, they must be created.

Import Best Practice Content

No changes compared to the greenfield situation. The best practice import should be done in the import branch.

### 10.3.6 Creating and Assigning Document Types to a Solution

To ensure a smooth transition to Build Execution, all results documents should be available and uploaded to SAP Solution Manager at the end of the FitGap/Delta Design. The management of these documents becomes easier if:

- All necessary document types are available.
- There is no ambiguity regarding which document types to use.
- It is clear where a document type should be stored.
- The correct templates for each document type are readily available.
- Examples for document types and templates are shipped in the name range 0SAP_XX as shown in the table below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Document Type</th>
<th>Status Schema</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functional Specification type Gap</td>
<td>0SAP_01</td>
<td>SAP Default Status Schema</td>
</tr>
<tr>
<td>Functional Specification type WRICEF</td>
<td>0SAP_02</td>
<td>SAP Default Status Schema</td>
</tr>
<tr>
<td>Functional Specification type Interface</td>
<td>0SAP_03</td>
<td>SAP Default Status Schema</td>
</tr>
</tbody>
</table>
To create your own document types based on standard types, follow these steps:

1. Navigate to Solution Administration ➔ Global Functions ➔ Document Type Administration.

2. Reduce the list of document types by entering 0SAP in the search field.

3. Right-click on the entry to be copied and select Copy, as shown in the screenshot below.
4. In the dialog box shown in the screenshot below, enter target document type (such as ZSAP_XX) and related description.
5. Confirm selections by choosing **OK**.

6. Repeat this for all standard document types (0SAP_XX).

**Note**

Some document types may need corrections on the **Usage** tab for certain document types. For example, the functional specification for interface does not consider composite interface. For this document type, navigate to the **Usage** tab and select in the **Documentation** area:

- Composite Interface <Ref>
- Composite Interface <Orig>
- Interface <Ref>

**Recommendation**

Configuration of two areas (documentation and test cases) for the same document type should be avoided.

7. Enter a search term that reflects your naming convention (such as ZSAP).
8. Select **Enter**.
9. Select one of the listed entries and choose the edit icon.
10. Choose **Upload** to upload your own document template for the selected document type.

11. Use dialog box to browse for the document template and select **Upload**.

12. Choose the eyeglasses icon to switch back to view mode.

13. Save the new document type.

14. Repeat the upload for all customer document types (ZSAP_XX).

15. Exit **Document Type Administration**.

16. In **Solution Administration**, select the **Document Type** tab.

17. Ensure that **All** is selected on the right side.

18. Enter the search term based on your naming convention (ZSAP).

19. Select all relevant entries to put into the scope for your solution as highlighted in the screenshot below.
10.3.7 Configuring Document KPI Framework

To configure document KPI framework, follow these steps:

1. Start transaction SPRO.
2. Open the IMG note for Document KPI Framework:

   ![SAP Solution Manager Implementation Guide]

   - Focused Build
   - General Information for Focused Build Customizing
   - Project Management Configuration
   - Integration
   - Release Management Configuration
   - Work Package Configuration
   - Work Item Configuration
   - Retract
   - Template Protection
   - Define Branch Mappings
   - Document KPI Framework

   **Note**

   Document types must be changed from 0SAP_XX to the types created in the previous section (see Creating and Assigning Document Types to a Solution) for the following KPIs:

   - **KPI**
     - FSPEC
     - SFTEST
     - TSPEC

3. Select the KPI and select Define relevant transaction types.

4. Select transaction type and select Define Classification Mapping.
5. Select the first entry and choose Copy.

6. Adjust Doc. Type entry.

7. Scroll up the table and delete the original entry with OSAP_XX as Doc. Type.

8. Repeat steps 5–7 for all classifications in this table so it looks like the screenshot below.
9. Repeat steps 1–8 for KPI SFTEST.
10. (optional) Extend the entries by Document Type = 9SAP_TCS to have automated test cases considered for the document KPI rating.
   - This entry represents test steps and automated test scripts for the KPI.

11. Repeat steps 1–8 for KPI TSPEC for each transaction type S1CG and S1NC

10.3.8 Configuring E-Mail Notifications on Document Status Change

The e-mail notification will be sent to the e-mail address maintained in business partner information:

- Use the transaction BP for business partner in your system
- Search for the user and check the e-mail under Communication of the business partner form

To customize the e-mail notification, follow these steps:

1. Start transaction SPRO.
2. Choose SAP Reference IMG.
3. Follow the path: SAP Solution Manager ▼ Focus Build ▼ Documentation ▼ Activate BAdI for Email Notifications and select the first checkmark.
Select the next option **Configure E-Mail Notifications on Document Status Change.**

As a result, the customizing table appears (shown below) with the following parameters:

- Solution Name
- Document Type
- Document Status
- Notified Role

Choose **New Entries** to create and save new parameters.

**Note**

- F4-help/contextual help is available for all input fields.
- The creator of the document is always the owner of the newly-created document.
- A status change of the document triggers the release of an e-mail notification. A delay in notification delivery is possible.
- The e-mail notification (see below) contains the document name and a link to the document, found in the **MyDocuments** application.
10.3.9 Importing Best Practice Content into the Import Branch

Please note the following prerequisites:

- A suitable LCP exists
  - It is not mandatory to have the technical system assigned to the logical component and logical component group
- SAP Note 2194123 is implemented

To import best practice content, follow these steps:

1. Ensure that you are in the correct solution in transaction SOLADM or go via launchpad group Focused Build - Tool Lead à Solution Administration.

2. Select the Imports tab for Focused Build Solution (following screenshot highlight 1) and choose Import on the left side (following screenshot highlight 2).

3. On the next screen, choose SAP Best Practices Packages (following screenshot highlight 1) and select the appropriate best practice package (following screenshot highlight 2).

4. Choose Next (following screenshot highlight 3).
Note

If nothing is displayed, please revisit SAP note 2194123, Setup HTTP connections to import SAP Best Practices Packages into Solutions.

5. Select the Import from the Import Branch (following screenshot highlight 1), select New deployment (following screenshot highlight 2), and provide a name for the deployment.

6. Choose Import (following screenshot highlight 3).

As a result, a background job initiates the importing of content.

When finished, a message appears and confirms the successful import.
10.3.9.1 Checking Imported Best Practices Content

To check imported best practice content, follow these steps:

1. From the SAP Solution Manager launchpad, choose Focused Build - Architect (following screenshot highlight 1), and select the Solution Documentation tile (following screenshot highlight 2).

![Screenshot 1](image1)

2. From the import branch of the newly-created solution (as in the screenshot below), look for a new folder called SAP Best Practices Import under Business Processes.
   - Seeing this folder visually confirms the import of a best practices package into SAP Solution Manager.

![Screenshot 2](image2)

   **Note**

   In the above screenshot, the top banner labelled Focused Build Prototype - Import shows the selected solution and branch.
   - To switch to another solution, select Global Functions ➔ Solution.
   - To switch to a different branch in the selected solution, use the branch dropdown field.

3. Expand the import branch's content (Business Processes ➔ SAP Best Practices Import ➔ <Best Practice Package> ➔ <Best Practice Process> ➔ Process Step) to reveal the imported best practice content.

As a result, the elements of the selected item are displayed in the lower half of the screen. Here you can find not only all executables/transactions and configuration relevant for a process, but also assets such as process diagrams and links to documentation. Links include test scripts, which can be used in the scope of the solution validation workshops.
10.3.9.2 Releasing Scope-Relevant Processes into the Design-Branch

Once the imported best practice processes have been scoped and it is clear which are relevant for the customer, they can be released to the design branch. (The import branch is merely a staging area for scoping purposes, nothing is changed or modeled here.)

To release to the design branch, follow these steps:
1. Right-click (right select) on a relevant best practice process.
2. Choose Subtree Changes ➔ Release Changes.
3. Confirm.
As a result, the selected process has now been released to the design branch, where gaps are documented, and the best practice process can be adjusted.

10.3.10 Creating Change Control Landscape

To create a change control landscape in Solution Administration, follow these steps:

1. Select the desired solution and select the Change Control Landscape tab.
2. Right-click (right select) an empty area in the table.
3. From the dropdown menu that appears, select New.

4. Enter the name, the technical name, and confirm.

5. Assign the Logical Component Group, which is reflected by the Change Control Landscape.
6. Select the Scope check box.
10.3.11 Configuring Branch Mapping

Except for the maintenance branch and the production branch, all branches are standard type branches.

To configure the design and development branch of your solution sub-landscape, follow these steps:

1. Start transaction SPRO.
2. In the customizing of SAP Solution Manager, choose SAP Solution Manager ‹ Focused Build ‹ Documentation ‹ Define Branch Mapping.
3. Select New Entries.
4. Enter the Solution Sublandscape ID as shown below.
5. Select the Branch Type as shown below.
6. Repeat steps 3 and 4 as shown below.

10.3.12 Alignment of Default Values

Align meaningful default values with your project team. After that, you can perform the respective customizing (see chapter: Setting Default Values for Effort, Value and Story Points).

10.3.13 Allowlist Object Maintenance

For using standard change documents, it is required to maintain the objects on the Allowlist as according the documentation found on help.sap.com.
10.4 Release Management: Configuration

10.4.1 Configuring Release Planning

To configure release planning, follow these steps:

1. Select Release Management tile in the launchpad.

2. In the navigation area, select Focused Build ➔ Release Planning.

3. Select Create ➔ Major and Minor Releases

4. Under Select Change Control Landscape, assign Major Release to Development Branch and enter further relevant data as shown below.
5. Check Major Release schedule and select Release Versions for which you want to create release cycles.


7. Confirm creation of release cycle.

8. Navigate to release cycle.

9. Select the related entry in the release table.
10. Select the business role **Release Manager**.

11. Switch to edit mode by selecting the **Edit** option.

12. Confirm to assign your business partner.

13. Select **Actions ➢ Switch to "Prepare" Phase**.
14. Confirm to create the task list.

There is no active task list assigned to the cycle. Do you want to create or assign the task list now?

Yes  No

15. Check the status of prerequisites and choose Next.

16. Choose Next after confirming the following:
   - Task List Variant: S1RL
   - Branch: Development
   - Development System: (As assigned)
   - Transport Tracks Overview: (As assigned)
Caution

To avoid inconsistencies, Central Change and Transport System should not be set to active.

17. To complete task list creation, select Create.

As a result, a message appears that states the task list has been created. Also, the release enters the prepare phase.

18. Select Edit (following screenshot highlight 1), select the Related Transactions tab (following screenshot highlight 2), and select the previously-created task list in the column Transaction ID (following screenshot highlight 3).

19. Navigate to the task list drill down and select node Track (Source System…) (following screenshot highlight 1).
20. Choose Lock/Unlock Group (following screenshot highlight 2).

21. Check that status is unlocked for task group Track.
10.4.2 Preparing Release Component for Batch Import

Please refer to Setting Up System Landscape in Maintain Landscape Data.

10.4.3 Adjusting Release Profile Mapping

An adjustment of release profile mapping is required if you are creating a new release component or change control landscape for use in Focused Build.

To define release profile mapping, follow these steps:

3. Map the release type together with the release component by selecting New Entries.
4. Use F4 help to select Solution Name and Branch Type. For the Branch Type you have the following options:
   o MASTER - Production Branch (used for production branch mapping)
5. Use F4 help to select Release Profile:
   o  `/SALM/STANDARD` for standard branches like development, design, or import branch

6. Use F4 help to select Batch Import Var ("var" is shorthand for "variant"), which should be used if you execute the Release Import from task list.

7. When the option Early Reassignment is switched on, you can automatically reassign open change documents to the successor release already, when the release is switched to phase **Test**. When the option Early Reassignment is switched off, the automatic reassignment of open change documents to the successor release is executed only, when the release is switched to phase Hypercare.

8. When the option Cross Project Reassignment is switched on, open change documents can be reassigned to the successor wave/release of a project different than the current one. An additional popup will appear to choose the target project and wave. When the option Cross Project Reassignment is switched off, open change documents will be reassigned to the successor wave/release of the current project. No additional popup will appear.

⚠️ **Caution**

Only change documents that have not reached status **Handed over to Release** can be reassigned to a successor release.

10.5  Setting Up Projects

For the prototype example, we create:

- 1 Main Project
- 2 build projects

### 10.5.1 Creating Projects

You can use the following template projects to set up the prototype’s project structure.

![Project Templates](image)

To create the project structure, follow these steps:

1. From SAP Solution Manager launchpad, choose **Focused Build - Project Manager ‡ Project Management**
2. In the project management app, select **Easy Project Setup**

3. Maintain the fields shown in the screenshot shown below and select **Step 2**.

![Easy Project Setup Screenshot](image-url)
4. Maintain the fields shown in the screenshot shown below and select **Step 3**.

5. Maintain the fields shown in the screenshot shown below and select **Step 4**.
6. Maintain the fields shown in the screenshot shown below and select **Step 5**.

7. Maintain the fields shown in the screenshot shown below and select **Create Projects**.
10.5.2 Assigning Actual Release to Projects

To assign the actual release to build projects and a Main Project, follow these steps:

1. In Project Management, select Detail while the root node is selected, as highlighted in the screenshot below.

   As a result, the Detail panel opens (see the following screenshot).

2. Maintain the Actual Release by selecting the pencil icon in the lower right corner, as highlighted in the screenshot below.
3. Maintain the actual release's Component (Change Control Landscape) and the release Number.

You can also assign consecutive releases to consecutive waves of a project.

To assign the actual release to a project wave, follow these steps:
1. In Project Management, select Detail while the wave node is selected.
2. In the Detail panel that opens, pencil icon in the lower right corner.
3. Maintain the Component (Change Control Landscape) and the release Number for the dedicated wave.
10.5.3 [optional, if Easy Project Setup utilized] Assigning Sub-Projects to Main Project

To assign sub-projects the Main Project, follow these steps:

1. In Project Management, select one or several build projects, as highlighted in the screenshot below.
2. Choose Assign Main Project, as highlighted in the screenshot below.

3. Select an available Main Project in the dialog box that appears (as shown in the screenshot below).
4. Choose Assign.
Note

This procedure also works the other way around. If you select a Main Project first, select **Assign Build** instead of **Assign Main Project**. As a result, the following dialog box displays available build projects.

### 10.5.4 (Optional) Adding Waves for Template Build Projects

The template build projects are shipped with 2 waves and 3 sprints, which is sufficient for a prototype.

To add waves for template build projects, follow these steps:

1. In each build project, copy an existing wave so that you get 4 waves with 3 sprints each.
   - To copy a wave, select an existing wave and select ⌘ in the lower right corner, as highlighted in the screenshot below.
2. Maintain the mandatory fields (marked with *) and select **Create**.

As a result, the newly-created wave will be inserted after the previously-selected wave (copy template).

![Create New Wave](image)

Note

If you need to change the wave sequence, it can be realized via adjustment of the **Sort Number**.

![Wave Sequence](image)

3. Repeat steps 1–2 until you get the desired wave number per build project.

### 10.5.5 Adjusting Wave Relationships between Main and Build Projects

To add waves from sub-projects to a related wave in the Main Project, follow these steps:

1. In the Main Project, select the structure’s root project node.
2. Choose **Wave Relationship**.
3. From the Wave Relationship's Header area, view available waves in the current Main Project.

4. Select the plus icon on the right-hand side of the Details area to add wave relationships, as highlighted in the screenshot below.

5. In the next dialog box Assign Project Waves to Current Wave, select Search.
   - Here you can apply filters to restrict the search.

6. Within the search result, check all waves in scope, as highlighted in the screenshot below.
   - For instance, if you are creating a relationship for wave 1, select all waves 1 of all build projects assigned to the Main Project.
   - Select OK.

7. Once you are finished with the creation of the relationships, choose Save.
Define further relationships according to this table:

<table>
<thead>
<tr>
<th>Main Project</th>
<th>Sub Project</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wave 1</td>
<td>BUILD 1 - Wave 1</td>
</tr>
<tr>
<td></td>
<td>BUILD 2 - Wave 1</td>
</tr>
<tr>
<td>Wave 2</td>
<td>BUILD 1 - Wave 2</td>
</tr>
<tr>
<td></td>
<td>BUILD 2 - Wave 2</td>
</tr>
<tr>
<td>Cross Wave</td>
<td>All waves from all sub-projects</td>
</tr>
</tbody>
</table>

9. (Optional) Check start dates, end dates, and duration of related waves between main and sub projects.
   - See highlighted fields in the screenshot below.
   - Adjust dates and duration, if needed.
10.5.6 Project Milestones Maintenance

For the Solution Readiness Dashboard to provide meaningful data regarding overdue statuses, maintain related dates for the milestones.

Single Update of Milestone
This can be done for each milestone separately while navigating in the structure to the related milestone.

Mass Update of Milestones

To update multiple milestones in a table view, follow these steps:

1. Select Table and List Display in the PPM UI.

2. Select the settings icon (highlighted below) to create a view to simplify the maintenance.

3. Select view Milestone Due Date Maintenance.
As a result, you see just the relevant columns to be able to enter or adjust the milestone dates.

**Note**

To further simplify the view, select a filter for the table so that you see milestones only, as shown in the highlighted screenshots below.

10.5.7 Release of Q-Gates

To get the date for the next Q-Gate visible in the Solution Readiness Dashboard, change the status of that Q-Gate to **Released**, as highlighted in the screenshot below.
10.5.8 (Optional) Assigning Dedicated Release Numbers to Waves

This section is relevant if:

- You have several waves per project.
- You would like to deploy to production after the end of a wave (instead of the end of the project).

The following screenshot shows a standard approach without the need of Wave/Release Number mapping.

The following screenshot shows a special approach that requires Wave/Release Number mapping.
To assign Wave/Release Number mapping for this special approach, follow these steps:

1. In the build project, select the root project element in the structure ‡ Work Package ‡ Schedule.

2. Open search help of the Release Number field for the relevant wave (following screenshot highlight 1).

3. Select the corresponding release number entry in the list (following screenshot highlight 2).

As a result, there is a new assignment of release to wave, as shown in the following screenshot.
10.5.9 Releasing Wave or Sprint

To be able to start sprint execution, the related sprint needs to be released in the project structure.

To release sprint in the project structure, follow these steps:

1. Navigate to the related sprint in the project structure.

2. Open the Details view.

3. Select Release in the dropdown list.

As a result, sprint is released so Work Packages and Work Items can be handed over to development.

Note

If you set the related Wave to Released all underlying Sprints will be released as well. Thus, if you prefer to do an iterative Sprint planning, you should not release the Wave.

10.5.10 Release of Project Header

To be able to create test plans for a project and assigning Work Packages, the status on the project header must be set to Released.
10.6 Configuration of Fix Pace

10.6.1 Activation of Enhanced Approval Procedure

In this configuration activity, you activate the enhanced approval procedure functions. These functions include the following:

- Restriction of the approval procedure functions using authorization object SM_APP_AP.
- Definition of a substitute who can also approve or reject your requests for change.
- Assignment of business partner groups to approval steps.
  - To do so, you must first create a business partner group (type: organization) in the organizational model.

As a prerequisite, the following entry has been created according to instructions and the table in chapter: Maintaining Transaction Types.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>&lt;space&gt;</td>
</tr>
<tr>
<td>Field Name</td>
<td>ENH_APP</td>
</tr>
<tr>
<td>Sequence Number</td>
<td>001</td>
</tr>
<tr>
<td>Field Value</td>
<td>X</td>
</tr>
</tbody>
</table>

10.6.2 Configuring Change Document visibility in Attribute Pane

1. Navigate to transaction SOLMAN_SETUP
2. Select Process Management
3. Goto step 5 Configure Solution Documentation Model
4. In the section Manual Activities execute activity Define Related Documents Visible at Attribute pane
5. Activate the Enhancement Implementation AGS_CRM_API_LCO_CD
10.6.3 Configuring Standard Change – Allowlist

Note

Technical Prerequisites: https://help.sap.com/viewer/8b923a2175be4939816f0981b73856c7/LATEST/en-US/e4c2f7cbab41468a98fbc6d69aed3499.html

To configure standard change, follow these steps:

1. Navigate to Change Control Management - Administration Cockpit.
2. Choose Allowlist Objects (following screenshot highlight 1).
3. Choose Set Switch (Preceding screenshot highlight 2).
   - From here, you can set the object check on global or local for the respective development system(s), as shown in the screenshot below.

4. Adjust Allowlist customizing or workbench objects for selected systems and clients, as needed.
   - Specify customizing objects on table key entry level
   - Specify workbench objects on object name level.
Note

In the above view, wildcards (*) can be used. Also, the change log can be used to track who maintained which objects and when they were maintained.

10.6.4 Integration of an Electronic Signature

To integrate an electronic signature, please refer to chapter: Configuring Electronic Signature for Change Request Management.
11 Configuration: Standalone Extensions

11.1 Activating the Piece List

This activity is valid for all standalone extensions.

To activate the piece list, follow these steps:

1. Start the SAP Solution Manager Launchpad in your browser.
2. In the Launchpad group Focused Build - Tool Lead click on tile Configuration Focused Build.
3. Goto step 1.2 Setup Steps
4. Execute Automatic Activities Activate Piece List

As a result, your system loads the predefined customizing options.

11.2 Test System Refresh: Configuration Overview

Here is an overview of steps to configure the test system refresh scenario. Detailed instructions can be found in following subsections. The steps are based on an example simulation landscape.

- Adjust the task list.
  - Create a task list variant for a new customer.
  - Copy task list variant SAP0 (for phase or release cycle) to the new task list variant.
  - Copy header and footer tasks of task list variant SAP0 to the new task list variant.
  - Register the new task Refresh Test System.
  - Add the task list Activity Refresh Test System to the newly created task list variant.

- Adjust the phase controller configuration accordingly.
  - Assign new task list variant to participant.
  - Assign new task list variant to phase model.

- Create a change cycle and assign the appropriate landscape and branch.
  - Assign your new task list variant to your new change cycle and create a task list.

Note

It is possible to use test system refresh for variant SAP0 (for phase or release cycle) or SAP1 (for continual cycle). It is also possible to add the additional task to the SAP standard task list variant. The entry should then be checked after each import of a support package.
11.2.1 Simulation Landscape

The simulation landscape for Focused Build refresh test system looks as follows:

```
+----------------+        +----------------+
| PRD SRD, 001  |        | MAINT DEV, 001 |
|                |        |                |
| QAS TRG, 001   |        |                |
|                |        |                |
| DSM Client 001 |        |                |
```

11.2.2 Prerequisites

Please note the following prerequisites for refresh test system:

- The task list only scenario has been established,
- Transports have been created for the simulation landscape via the task list only scenario,
- The tracking functionality has been activated for the simulation landscape,
- The authorization object S_CTS_ADMI has been granted to the TMSADM user.
- The package /SALM/RTS_MS must be deployed to each managed system, where the refresh is to be performed.
- For more details please have a look at KBA Article: 2920329

11.2.3 Changes to the Task List

Make changes to the task list by first creating a new task list variant via one of the following paths:

- In the customizing of SAP Solution Manager, choose SAP Solution Manager \(\rightarrow\) Capabilities (Optional) \(\rightarrow\) Change Control Management \(\rightarrow\) Schedule Manager \(\rightarrow\) Create Customer-Specific Variant for Task Lists.
- Start transaction SOLMAN_SETUP \(\rightarrow\) Change Control Management \(\rightarrow\) Change Request Management \(\rightarrow\) Make Settings for Task List.
As a result, the task list variant that is adapted depends on the respective task list usage of the respective customer. Subsequent sections will only use the SAP0/ZAP0 variant for the phase cycle.

11.2.3.1 Creation of Customer-Specific Task List Variant ZAP0

To create a new task list variant, follow the IMG path as pictured below:

- Choose SAP Solution Manager › Capabilities (Optional) › Change Control Management › Extended Configuration › Schedule Manager › Create Customer-Specific Variant for Task Lists.

As a result, the new task list variant ZAP0 is a copy of the task list variant SAP0.
In addition, the new customizing has been saved to the following transport request:

<table>
<thead>
<tr>
<th>Variant</th>
<th>Description</th>
<th>Buffer</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZAP0</td>
<td>Variant for Task List method test system</td>
<td>Transport Request Remains in Import Buffer after 1m.</td>
</tr>
</tbody>
</table>

### 11.2.3.2 Copying Variant SAP0 to Task List Variant ZAP0 for Project Type Phase Cycle

To copy the variant for project type phase cycle, follow these steps:

1. Start transaction SPRO.
2. Under SAP reference IMG, choose SAP Solution Manager › Capabilities (Optional) › Change Control Management › Schedule Manager › Define Additional Tasks for Task Lists.
3. Mark all entries with task list variant SAPO and project type Phase Cycle.
4. Choose Copy.

5. Perform this step for each selected task of the task list variant SAP0 with project type Phase Cycle and replace it with the new task list variant ZAP0.

As a result, all tasks of task list variant SAP0 are copied to the new task list ZAP0.
11.2.3.3 Copying Variant SAP0 to Task List Variant ZAP0 for Header and Footer Tasks

To copy the variant for header and footer tasks, follow these steps:

1. Start transaction SPRO.
2. Under SAP reference IMG, choose SAP Solution Manager ‹ Capabilities (Optional) ‹ Change Control Management ‹ Schedule Manager ‹ Create Customer-Specific Header and Footer Tasks.
3. Mark all entries with task list variant SAP0 and project type Phase Cycle.
4. Choose Copy.

Choose Copy.

5. Perform this step for each selected header and footer task of the task list variant SAP0 with project type Phase Cycle and replace it with the new task list variant ZAP0.

As a result, all header and footer tasks of task list variant SAP0 are copied to the new task list ZAP0.

11.2.3.4 Checking Refresh Test System Task

To check the Refresh Test System task, follow these steps:


2. Enter table SCMAPROGRAMS and choose Maintain:

3. Check the entry for the report /SALM/RTS_REFRESH_SYSTEM.
11.2.3.5 Adding Refresh Test System to the Task List Variant ZAP0

To add the new task list activity Refresh Test System to the customer task list variant ZAP0, follow these steps:

1. In customizing SAP Solution Manager, choose SAP Solution Manager » Capabilities (Optional) » Change Control Management » Schedule Manager » Define Additional Tasks for Task Lists.

   Note

   This configuration step can only be performed after the SAP add-on package ST-OST 200, SPS 4 has been successfully implemented in your SAP Solution Manager system.

2. Choose New Entries.

3. Fill in the fields as follows:

   o Project Type = Phase Cycle
   o Type of Role = O
   o Number = 4000
   o Description = Refresh Test System
   o Program Name = /SALM/RTS_REFRESH_SYSTEM
   o Task Type = Transaction/Online Program
As a result, the new task Refresh Test System calling the program `/SALM/RTS_REFRESH_SYSTEM` is now available for target systems with role type {O}.

11.2.3.6 Creating a Change Cycle and Assigning Customer Own Task List

Variant to Task List

Two types of change cycles available with SAP Solution Manager release 7.2 are offered for selection:

- **Continual cycle (transaction SMA1)**
  - This cycle should only be used if a deployment of transports (which will be imported only once and do not stay in buffer) is required:
    - On demand
    - On a daily basis
    - On defined weekdays

- **Phased cycle (transaction SMIM)**
  - This cycle is based on a consolidated import for the change cycle. It can be used for the following:
    - Implementation projects
    - Maintenance

  **Note**

  Urgent changes, preliminary imports, and status-dependent imports can be processed in parallel. The import is executed as Import Subset. The assigned transport requests stay in buffer for re-import and are examined by the consolidated import again.

To create a change cycle, follow these steps:

1. Launch SAP Fiori Launchpad via transaction SM_WORKCENTER.
3. Select SOLMANPRO as business role to open the CRM WebUI.
4. Select Create ‣ Change Cycle from the left navigation frame.

5. Choose Phase Cycle from the dialog box that appears.

6. Enter a meaningful description for your new Change Cycle and assign the relevant landscape and maintenance branch.

To create a task list for your phase cycle, follow these steps:
1. As shown in the screenshot below, choose Actions and select Set Phase to Scope.
2. Clear the dialog box by selecting **Yes**.

As a result, a guided procedure opens. To continue, follow these steps:

3. Check statuses under **Check Prerequisites**, since the system automatically shows if all technical prerequisites to generate a task list for your change cycle are met.

4. Define the scope.
   - For the mandatory field **Task List Variant**, select your task list variant **ZAP0** via the F4 help:

5. Proceed with guided procedure instructions up to Step 4, **Complete**, as shown in the screenshot below.
6. Select Create.

As a result, since the scope of your new phase cycle is fully-defined, the system automatically generates the referring task list.

11.2.4 Executing the Refresh Test System Scenario

This action consists of the following parts:

- Execute Delta Run: Calculate the delta to another system
- Perform the system copy
- Execute Refresh Run: Add calculated delta to another system
- Perform the import via Change Request Management

To get started executing the Refresh Test System scenario, follow these steps:

1. Execute the new task Refresh Test System, which is available for the target system TRG.

2. Choose D Delta Run: Calculate Delta to another System from the dropdown list in the dialog box and choose Run.
3. From the next dialog box, select the source system (production system SRD, client 001) from the list and choose `Select`.

![Select Application Mode Image]

4. (Recommended) Choose `Yes` to initiate a system update of the central transport tracking information, based on the delta calculation.

![Refresh Tracking Information Image]

As a result, you receive a system message confirming the delta calculation was performed successfully.

![Delta calculation saved to database Image]

The delta calculation of transports is saved to the following tables:

- `/SALM/DELTA_C`
- `/SALM/DELTA_H`

To continue with performing the system copy and adding calculated delta to another system, follow these steps:

5. Perform the system copy.
6. Execute the task `Refresh Test System` again.
7. Select the option `Refresh Run: Add Calculated Delta to another System` from the dropdown list in the dialog box and choose `Run`. 
8. Select the source system (production system SRD, client 001) from the list and choose Select.

9. Choose the existing delta calculations:

10. Select one of the available delta calculations.
    o If more than one exists, select the most current one and choose Continue.
11. Choose the OK (checkmark) icon:

As result, the list of transports, displayed in the above dialog box, are re-added to the import buffer of the refreshed test system TRG.

To continue with performing the import via Change Request Management, follow this step:

12. Trigger the import to system TRG via the task list (import project all).

11.2.5 Available BADI Definition: /SALM/RTS_FILTER_DELTA_BAdI

If there are specific customer requirements, the delta calculation for another system can be influenced with the help of a BAdI implementation for the BAdI definition /SALM/RTS_FILTER_DELTA_BAdI.

The coding in the BAdI method must be customer-specific, developed based on the individual customer requirements.

For more information, please refer to documentation of the BAdI /SALM/RTS_FILTER_DELTA_BAdI.

11.3 Retrofit Automation: Configuration Activities

11.3.1 Basic Configuration for SAP Solution Manager and Configuration for Change Request Management

Be sure to satisfy the following prerequisites to the basic configuration of your SAP Solution Manager system:

- Ensure that your Solution Manager 7.2 system has software component ST-OST 200, SP08 installed.
  - Navigate to System ‡ Status...
Choose the details icon under the Product Version field, as highlighted below.

- Read the documentation and descriptions available in the implementation guide.
  - Start transaction SPRO.
  - Navigate to SAP Solution Manager Implementation Guide ‡ SAP Solution Manager ‡ Mandatory Configuration ‡ Basic Configuration: Guided Procedure.

To start the basic configuration of SAP Solution Manager, start transaction SOLMAN_SETUP.
From here, you can navigate to the guided procedures under Mandatory Configuration, as highlighted in the screenshot below.

The following guided procedures contain configuration steps relevant for the Change Request Management scenario:

- **System Preparation**: Make preliminary settings for SAP Solution Manager configuration, such as creating dialog users with the required authorizations, implementing the central correction note, and configuring web service.
- **Infrastructure Preparation**: Set up the SLD connections, establish LMDB synchronization, set up Java connectivity, set up SAP BW, set up e-mail communication, and enable the gateway services.
- **Basic Configuration**: Navigate through all configuration steps, which you have to perform to enable basic scenarios in SAP Solution Manager. As part of the basic configuration, set up the connection to SAP, schedule relevant background jobs, and activate piece lists that contain important settings such as standard customizing.
- **Infrastructure Preparation**: Configure the infrastructure to run SAP Solution Manager.
- **Managed Systems Configuration**: Connect managed systems to the Solution Manager via RFC. This is important, since Change Request Management requires a READ, TMW, and TRUSTED RFC connection to every managed system/client.

**Note**

To ensure that Change Request Management works perfectly with managed systems, a minimum SP level is required. Please check SAP Note 907768 for further details.

Before continuing with configuration for retrofit automation, please ensure that you completed the following:

- Satisfied the SAP Solution Manager configuration prerequisites.
- Performed SAP Solution Manager basic configuration according to guided procedure documentation.
- Performed basic configuration for Change Request Management.
### 11.3.2 Activation of the Piece List

The standard customizing of SAP Change Request Management and all other IT Service Management areas are delivered via a customizing piece list. This piece list must be activated as part of transaction SOLMAN_SETUP. It copies the standard customizing from Client 000 into the working client of SAP Solution Manager.

Activating the piece list again will overwrite all existing standard customizing with the content of the piece list. Therefore, it is strictly recommended to copy all transaction types into the customer namespace before starting to use Change Request Management.

⚠️ **Caution**

The existing BC sets of Change Request Management are not designed to be activated within an SAP Solution Manager 7.2 system since the customizing piece list replaces them.

### 11.3.3 Implementation of Mandatory SAP Notes

Implement or verify the correct implementation of the central SAP Solution Manager note, based on the SPS level of your SAP Solution Manager system.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3034068</td>
<td>Central Note for Focused Build ST-OST 200 (composes all fixes with the shipment of SP04)</td>
</tr>
</tbody>
</table>

In addition, check whether all retrofit relevant SAP Notes have been implemented for this SAP Solution Manager release and the managed system. For more information, see appendix section Key SAP Notes.

Finally, ensure that the following Focused Build-specific SAP Notes are implemented for SAP Solution Manager:
### 11.3.4 Checking for Correct Retrofit Setup

As a prerequisite for using retrofit, ensure that the cross system object lock is activated.

To check that the retrofit parameter is active to use retrofit automation, follow these steps:

1. Navigate to SPRO ‏ ‏SAP Solution Manager Implementation Guide ‏ ‏SAP Solution Manager ‏ ‏Capabilities (Optional) ‏ ‏Change Control Management ‏ ‏Retrofit ‏ Define Retrofit Parameters,
2. Check that the NO_CSOL parameter is active, as shown in the screenshot below.

![Configuration Table for Retrofit Extension](image)

#### Note

Writing a CSOL entry could trigger a CSOL dialog box in case of a conflict. This needs to be prevented.
Perform the retrofit as a background process in batch.
As a result, dialog boxes are not processed, but result in aborting the job.

11.3.5 Activating Retrofit Automation Scenario for Target Transport Creation

Retrofit target transports are created automatically when you use the Retrofit Automation. The following scenarios are available for the automatic Retrofit target transport creation:

- **AUTO_TOC**: Transport of copies (ToCs) as Retrofit target. Transports without conflicts are retrofitted via the retrofit automation job. The retrofitted objects are recorded into a ToC which can be released and imported into the test system automatically.
- **AUTO_TR**: Original transport as Retrofit target. Transports without conflicts are retrofitted via the retrofit automation job. The retrofitted objects are recorded into an automatically created transport.
- **AUTO_CD**: Change document as Retrofit target. Transports without conflicts are retrofitted via the retrofit automation job. The retrofitted objects are recorded into an automatically created transport. The transport is linked to an automatically created change document.

Note
Please note that only one of the scenarios mentioned above can be active at the same time!

11.3.5.1 Retrofit Automation Scenario AUTO_TOC

To enable the scenario Transport of copies as Retrofit target (AUTO_TOC), please follow these steps:

1. Start transaction SPRO and navigate to SAP Solution Manager Implementation Guide ➜ SAP Solution Manager ➜ Focused Build ➜ Retrofit ➜ Activate Retrofit Automation Scenarios
Choose New Entries.

Open the search help of field Parameter ID, choose parameter AUTO_TOC and set it to active as shown in the screenshot below.
Navigate to SAP Solution Manager Implementation Guide ⇒ SAP Solution Manager ⇒ Focused Build ⇒ Retrofit ⇒ Business Add-Ins

Activate the following BAdI implementations:
- After Retrofit BAdI implementation (/SALM/AFTER_RETROFIT)
- BAdI Implementation for Automatic Transport Assignment (/SALM/RETRO_AUTO_IMPL)

Valid for ST-OST 200 SPOS and higher: Implement SAP Note 2867769 into the managed project development system (Retrofit system) to enable the automatic Retrofit target ToC release after Retrofit has been successfully executed.

Perform the following activities if you want to enable the automatic ToC import into target systems of the project/implementation landscape:
- Navigate to SAP Solution Manager Implementation Guide ⇒ SAP Solution Manager ⇒ Focused Build ⇒ Retrofit ⇒ Define Target Systems for Importing Retrofit ToCs

Choose New Entries.

Enter a target system/client for each source development system/client in your project/implementation landscape. Use the option "Direct Target" to indicate which systems are direct target systems (consolidation) of the source system.

Example:
Target ToCs from the Retrofit system SMD:100 should be imported into the QA system SMQ:100 (consolidation target) and into the Pre-Production system SMT:100 (delivery target). Make the following entries:
Note

To enable ToC imports into systems which are not direct targets of the source system, the function group /SALM/RTS_RFC_API must be transported from the Solution Manager to these target systems (e.g. with a ToC). The S_RFC authorization to execute the function module /SALM/TMS_MGR_FORWARD_TR_REQ and S_CTS_ADMI authorization to forward transports to the import queue must be assigned to the Retrofit Automation user.

11.3.5.2 Retrofit Automation Scenario AUTO_TR

To enable the scenario Original transport as Retrofit target (AUTO_TR), please follow these steps:

1. Start transaction SPRO and navigate to SAP Solution Manager Implementation Guide ➤ SAP Solution Manager ➤ Focused Build ➤ Retrofit ➤ Activate Retrofit Automation Scenarios
Choose **New Entries**.

![New Entries](image)

Open the search help of field **Parameter ID**, choose parameter **AUTO_TR** and set it to active as shown in the screenshot below.

![New Entries: Overview of Added Entries](image)

### 2. Navigate to SAP Solution Manager Implementation Guide 
- SAP Solution Manager 
- Focused Build 
- Retrofit 
- Business Add-Ins

- **Retrofit**
  - Activate Retrofit Automation Scenarios
  - Specify Retrofit Target Task List for Retrofit Automation
  - Specify Mapping Rules for Target Change Document Creation
  - Define Target Systems for Importing Retrofit ToCs
  - Define Retrofit Automation E-Mail Settings
  - **Business Add-Ins**
    - Activate Retrofit Release BAdI Implementation
    - Activate During Retrofit BAdI Implementation
    - Activate After Retrofit BAdI Implementation
    - **Activate BAdI Implementation for Automatic Transport Assignment**

Activate the following BAdI implementations:
- BAdI Implementation for Automatic Transport Assignment (**/SALM/RETRO_AUTO_IMPL**)
- Optional: After Retrofit BAdI implementation (**/SALM/AFTER_RETROFIT**). This BAdI implementation must be active only if you want to use the "Release Target Transport" option.

### 3. Navigate to SAP Solution Manager Implementation Guide 
- SAP Solution Manager 
- Focused Build 
- Retrofit 
- Specify Retrofit Target Task List for Retrofit Automation
Choose New Entries.

Create an entry for each source system and task list and enter the Retrofit system and target task list ID. Check the option Release Target Transport to release target transports automatically.

**11.3.5.3 Retrofit Automation Scenario AUTO_CD**

To enable the scenario Change document as Retrofit target (AUTO_CD), please follow these steps:

1. Start transaction SPRO and navigate to SAP Solution Manager Implementation Guide ➤ SAP Solution Manager ➤ Focused Build ➤ Retrofit ➤ Activate Retrofit Automation Scenarios

Choose New Entries.
Open the search help of field Parameter ID, choose parameter AUTO_CD and set it to active as shown in the screenshot below.

2. Navigate to SAP Solution Manager Implementation Guide ➤ SAP Solution Manager ➤ Focused Build ➤ Retrofit ➤ Business Add-Ins

   Activate the BAdl implementation for Automatic Transport Assignment (/SALM/RETRO_AUTO_IMPL).

3. Navigate to SAP Solution Manager Implementation Guide ➤ SAP Solution Manager ➤ Focused Build ➤ Retrofit ➤ Specify Retrofit Target Task List for Retrofit Automation

   Choose New Entries.
Create an entry for each source system and task list and enter the Retrofit system and target task list ID. The option **Release Target Transport** is NOT relevant for **AUTO_CD** scenario.

Create an entry for each relevant source and target transaction type. (Optional) Define and map additional data (such as appointments, texts, partner functions) on change document creation.

**Example for mapping of texts between relevant source and target transaction type:**
Example for mapping of partner functions between source and target transaction type:

### 11.3.6 Activating Retrofit Automation Scenario Full Scope

The **Full Scope** scenario enables you to extend the scope of the Retrofit Automation program by including mixed transports. Mixed transports are transports which contain not only auto-import objects but objects of other Retrofit categories as well. If the full scope option is active, the Retrofit Automation program will process auto-import objects from mixed transports as well as transports which contain auto-import objects only.

To enable the scenario **Full Scope (AUTO_FULL)**, please follow these steps:

1. Start transaction SPRO and navigate to SAP Solution Manager Implementation Guide ‡ SAP Solution Manager ‡ Focused Build ‡ Retrofit ‡ Activate Retrofit Automation Scenarios
2. Choose New Entries.

3. Open the search help of field Parameter ID, choose parameter AUTO_FULL and set it to active as shown in the screenshot below.
11.3.7 Activating Retrofit Automation Scenario Stop at Failed Retrofit

The Stop at Failed Retrofit scenario enables you to change the processing behavior of the Retrofit Automation program. If the option is active, the Retrofit Automation program will cancel the processing of further transports if auto-import for a transport was not successful.

To enable the scenario Stop at Failed Retrofit (AUTO_STOP_AT_ERROR), please follow these steps:

1. Start transaction SPRO and navigate to SAP Solution Manager Implementation Guide \ SAP Solution Manager \ Focused Build \ Retrofit \ Activate Retrofit Automation Scenarios

2. Choose New Entries.
3. Open the search help of field **Parameter ID**, choose parameter **AUTO_STOP_AT_ERROR** and set it to active as shown in the screenshot below.

![New Entries: Overview of Added Entries](image)

<table>
<thead>
<tr>
<th>Parameter ID</th>
<th>Description</th>
<th>Active?</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO_STOP_AT_ERROR</td>
<td>Stop at failed Retrofit (Auto-Import)</td>
<td>✓</td>
</tr>
</tbody>
</table>

### 11.3.8 Define Retrofit Automation E-Mail Settings

Automated e-mail notifications (messages communicating success or errors with retrofit activities) can be sent to the owners of the processed transports as part of retrofit automation. You can switch on or switch off the successful or incomplete retrofit e-mails and define which e-mail forms should be used.

Please ensure the following prerequisites are fulfilled:

- Retrofit automation job has been scheduled.
- E-mail address has been maintained for the relevant business partner and the business partner remains linked to the user who owns the TR to retrofit. (This is necessary for the sending of the relevant e-mail.)
- E-mail setup **SCOT** has been properly configured.

The following default e-mail text objects (of **Document Class**: TX, general text) are available for access via transaction **SE61**:

![Document Maintenance: Initial Screen](image)

- **Document Class**: General text
- **Language**: English
- **Name**: `/SALM/RETRO_MAIL_SUCCESS`
• `/SALM/RETRO_MAIL_SUCCESS`: For automated success messages of successful retrofit activities.

Dear User,

your retrofit activities have automatically been completed by the system.
The retrofitted transports are:

(see below)

Best Regards,
Release and Change Management

• `/SALM/RETRO_MAIL_ERROR`: For automated error messages of failed or incomplete retrofit activities.

Dear User,

your retrofit activities could not be completed automatically. Please take manual action and complete the retrofit activities at the earliest possibility.
The relevant transports are:

(see below)

Best Regards,
Release and Change Management

To specify retrofit automation e-mail settings, follow these steps:

1. Start transaction SPRO.

2. Navigate to SAP Solution Manager Implementation Guide ➤ SAP Solution Manager ➤ Focused Build ➤ Retrofit ➤ Define Retrofit Automation E-Mail Settings

3. Choose New Entries.

4. Define task list-specific e-mail settings by entering a task list ID in the Task List field.
   o Alternatively, enter `GLOBAL` as a default for task list independent settings.
11.3.9 Activating Additional Retrofit Functions

The following additional functions can be added to the menu of the retrofit tool:

- **Display Change Document** (DISP_CD): Navigate from the retrofit tool into the change document.

- **Do Single Retrofit Automation** (SALM_AUTO_WITH_TOC): Trigger retrofit automation for a single transport from the retrofit list. The retrofit target transport is created automatically based on the active retrofit scenario (AUTO_TOC / AUTO_TR / AUTO_CD).
  - This feature supports auto-import and mixed transports; parameter AUTO_FULL is not required. For example, if you have activated ToCs as retrofit target, you can use this additional function to execute auto imports with ToCs as target requests in the retrofit screen, such as for mixed requests with green and red objects.

- **Analyze BW Transformations** (SALM_BW_ANALYSIS): If the BW scenario is activated, you can use this function to compare transformations between the development and retrofit system.

- **Display Conflicts** (SALM_DISPLAY_CONFLICT): For a transport request in the retrofit list with yellow and red objects, show all objects with conflicts in the retrofit system and the corresponding transport requests.

- **Call SNOTE Implementation** (SALM_SNOTE): Navigate from the retrofit tool into transaction SNOTE of the retrofit system.

- **Create Retrofit Target Transport** (SALM_TARGET_TR): Create a target transport (original transport) for a single transport from the retrofit list.

To activate the additional Retrofit functions, follow these steps:

1. Navigate to SAP Solution Manager Implementation Guide » SAP Solution Manager » Focused Build » Retrofit » Activate Retrofit Automation Scenarios
2. Choose New Entries.
   - Open the search help of field Parameter ID, choose a parameter for an additional function (e.g. DISP_CD) and set it to active as shown in the example below.

<table>
<thead>
<tr>
<th>Parameter ID</th>
<th>Description</th>
<th>Active?</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISP_CD</td>
<td>Display change document</td>
<td>✔️</td>
</tr>
</tbody>
</table>

3. Repeat steps 2-3 for all additional Retrofit functions you want to use.
4. Start transaction SM30 and navigate to view /TMWFL/ADDFUNC.
5. Create new entries for all additional Retrofit functions you want to use:

7. (Relevant for function Display Change Document only) Navigate to SAP Solution Manager Implementation Guide ➤ SAP Solution Manager ➤ Capabilities ➤ Change Control Management ➤ Retrofit ➤ Define Retrofit Parameters and activate parameter Show Change_ID Field:

8. (Relevant for function Display Change Document only) Navigate to SAP Solution Manager Implementation Guide ➤ SAP Solution Manager ➤ Focused Build ➤ Retrofit ➤ Business Add-Ins and activate Retrofit Release BAdI implementation /SALM/RETRO_RELEASE.
11.3.10 Setting Up the Batch Job for Retrofit Automation

To set up the batch job for retrofit automation, follow these steps:

1. Start transaction SE38.
2. Navigate as follows: /SALM/RETRO_AUTOMATION → F8.
3. In the Task List field, enter the current task list ID for maintenance.

As a result, you can start the retrofit automation via this report.

Consider the following recommendations when scheduling the report:

Variants
- Create a variant for each retrofit queue.

Multiple Steps
- Avoid creating multiple jobs.
- Create multiple steps in one job with the same program, but different variants which have been defined.
- Create different jobs only when there is a different scheduling requirement.

Scheduling Interval and Period
- Schedule the job at least daily.
- Fast scheduling is possible, such as an hourly run.
- Watch the steps and queue size for processing, as some runtime is required.

11.3.11 Roles and Authorizations

Relevant roles and authorizations are those available for SAP Solution Manager Change Request Management and retrofit, delivered by ST. The retrofit report is either executed by a dialog user or (if the report is scheduled in a background job) by a system user. There are no Focused Build-specific authorizations or roles defined for using the retrofit automation feature.

Below are notable considerations.

For scheduling the retrofit report:
- Authorization to schedule a report in the background (transaction SM37)
In SAP Solution Manager system:

- Authorization for authorization object SM_CM_RFIT (activity Display) is needed.
- CRM authorizations for the creation of target change documents (only relevant for scenario Change Document as Retrofit Target)
- Authorization for transaction SE38 or SA38

In both DEV systems (maintenance and development track):

- Authorization for authorization object S_RFCACL for the usage of the trusted RFC – connection from the SAP Solution Manager system to the DEV systems.
- Authorization role SAP_CM_MANAGED DEVELOPER RETRO.

In TEST system (development track):

- Import authorization to import retrofit transport of copies (ToCs) in the test system (only relevant for scenario ToC as Retrofit Target)
- Authorization for authorization object S_RFC for functional module /SALM/TMS_MGR_FORWARD_TR_REQ and S_CTS_ADMI authorization to forward transports to the import queue. These authorizations are required only for scenario ToC as Retrofit Target with automatic ToC imports into systems which are not direct targets of the source system.

In DEV System (development track):

- For the Original Transport as Retrofit Target scenario: Authorization to release transports

TMW RFC User

The following authorizations are needed. They should already be maintained accordingly if the RFCs and RFC users have been generated using SOLMAN_SETUP.

In DEV system (development track):

- Retrofit target transport request/ToC creation authorization
- For the ToC as Retrofit Target scenario: Authorization to release ToC

11.4 Retrofit for BW: Configuration Activities

As a prerequisite for using retrofit, ensure that the cross system object lock is activated.

To check that the retrofit parameter is active to use retrofit automation, follow these steps:

1. Navigate to SPRO ‹ SAP Solution Manager Implementation Guide ‹ SAP Solution Manager ‹ Capabilities (Optional) ‹ Change Control Management ‹ Retrofit ‹ Define Retrofit Parameters,
2. Check that the `NO_CSOL` parameter is active, as shown in the screenshot below.

![Configuration Table for Retrofit Extension](image)

### 11.4.1 Retrofit without Implemented Focused Build Retrofit for BW

Before implementing the Focused Build Retrofit for BW, SAP's standard scenario for retrofit classifies the following critical BW objects as Manual Retrofit:

- File Data Source (ISFS)
- Transfer Rule (ISMP)
- Transfer Structure (ISTS)
- Data Source (RSDS)
- Transformation (TRFN)
- Routine (ROUT)
- BW Formula (RSFO)

This is also valid if these critical BW objects were newly-created in the maintenance development system, as the enhanced retrofit scenario cannot detect conflicts between the source and the retrofit target system.
11.4.2 Setup of a Simulation Landscape for Focused Build Retrofit for BW

The detailed configuration steps, which are described in this Configuration Guide are based on an exemplary SAP BW Simulation Landscape for Focused Build Retrofit for BW:

SAP Solution Manager System
- XSC, Client 100

Maintenance Development System for SAP BW
- XB1, Client 285

Retrofit Target System for SAP BW
- XB3, Client 885

Source System for SAP BW MAINT DEV System
- XR3, Client 286

Source System for SAP BW Retrofit Target System
- XR7, Client 286

Please be aware, that for successful testing of Focused Build Retrofit for BW the Simulation Landscape has to comprise the source systems (such as SAP ERP) of the SAP BW development systems as well.

For instance, if you intend to create a data source (for instance for a specific database table), in the SAP BW maintenance development system (System XB1, Client 285), this object must first exist in the referring source system (System XR3, Client 286).

Note

For successful testing of Focused Build Retrofit for BW, the simulation landscape must comprise the source systems (such as SAP ERP) of the SAP BW development systems as well.

- For instance, if you intend to create a data source (for instance for a specific database table), in the SAP BW maintenance development system (System XB1, Client 285), this object must first exist in the referring source system (System XR3, Client 286).
For the retrofit itself, the same prerequisite is valid: This means that, at first, the source system XR7, client 286 has to be provided with the object in question before the retrofit of the referring data source from XB1, client 285 to the SAP BW retrofit target system XB3, client 885 can be executed successfully.

Exemplary simulation landscape for Focused Build Retrofit for BW:

11.4.3 Implementation of Relevant SAP Notes

Ensure that the following SAP Notes are implemented for SAP Solution Manager or the managed system.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
<th>SAP Solution Manager</th>
<th>Managed System</th>
</tr>
</thead>
<tbody>
<tr>
<td>2932155</td>
<td>Focused Build - Retrofit for BW: Wrong Categorization of BW Objects</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2208176</td>
<td>Retrofit: error about nonexistence of function module TRINT_GET_TLOGO</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>2223092</td>
<td>Retrofit: Error TK103 during auto-import language objects</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2311560</td>
<td>Function module RSO_GETRELATED does not work</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2339934</td>
<td>Saving queries takes a very long time in retrofit scenario</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2355901</td>
<td>SP36: Determination of transformations for retrofit</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2395235</td>
<td>SP37: Determination of transformations for retrofit (II)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>SAP Note</td>
<td>Description</td>
<td>SAP Solution Manager</td>
<td>Managed System</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>2401952</td>
<td>730SP17: Development class of transformation is reset to $TMP during re-import</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2729126</td>
<td>Wrong categorization of Retrofit objects</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>2736254</td>
<td>Retrofit: Classification of Object is incorrect</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>2712878</td>
<td>Retrofit: Refine Information and enhance LOG and fix of categorization error</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>2733681</td>
<td>Retrofit: Performance improvement Retrofit overview</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2735729</td>
<td>Retrofit: Error message improvement</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>2741354</td>
<td>Retrofit: Wrong categorization of workbench and customizing objects</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>2743604</td>
<td>Retrofit: Refresh of Retrofit overview shows no new entries</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2744352</td>
<td>Focused Build: Report /SALM/START_RETRO_OVERVIEW does not support multiple Retrofit systems for the same task list</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>2754926</td>
<td>Retrofit: Small fixes for Retrofit Overview Screen</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>2765929</td>
<td>Improvement of report /SALM/CM_SHOW_CSOL_CONFLICT</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>2777400</td>
<td>Retrofit: Performance improvement II</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>2775346</td>
<td>Wrong result getting transport requests for a change document</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>2780786</td>
<td>Retrofit: Requests for other systems are displayed in selection screen</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

If you already use the enhanced retrofit scenario on your system, some of the above SAP Notes may already be implemented.

For more information on authorizations, settings, and RFC users, see the following SAP Notes:

- SAP Note 2257213 - Authorizations for RFC users for SAP Solution Manager 7.2 SP02 and higher
- SAP Note 2451511 - Retrofit: Authorization for BC-Set creation
- SAP Note 2697234 - Retrofit: BC-SET creation fails because of settings in SCC4

11.4.4 Switching on Standard Transport Management in Preparation of SAP BW-Environment

In the BW transport connection tool, you can first store all changed objects locally before they are assigned to a transport request. (The BW transport connection tool cannot be used for Change Request Management and Focused Build Retrofit for BW.)

Since the cross-system object lock entries are not created when objects are later assigned to a transport request, activate the SAP Standard Transport Management Connection (SAP TMS) for SAP BW.
To switch on SAP TMS, follow these steps:

1. Start transaction RSA1.
2. Choose Transport Connection in the left-side navigation frame.
3. Navigate to Edit ‡ Transport ‡ Switch-On Standard:

Switch to the standard transport management connection for both of the following:

- SAP BW maintenance development system
- SAP BW project/release development system

11.4.5 Database Table RSLOGSYSMAP Maintenance

For source system-dependent BW objects in table RSLOGSYSMAP: Maintain how the source system should change after a transport is imported with a source system-dependent object.

- For instance, the connected SAP ERP Source System is different for SAP BW development and SAP BW QAS system.
In the table shown in the screenshot below, the original source system (field: LOGSYSORG) must be the source system for SAP BW development (such as SAP ERP DEV). The target source system (field: LOGSYSNEW) must be the source system for SAP BW QAS (such as SAP ERP QAS).

To maintain this mapping, start transaction SM30 of your SAP BW systems and make the required entries in table RSLOGSYSMAP.

11.4.6 Importing Remote API for Focused Build Retrofit for BW to Source- and Retrofit System

The transport retrofit for BW extension remote (remote API) is bundled with the SAP Solution Manager system XSC and needs to be imported in both the following:

- SAP BW project development system XB3 (retrofit target system)
- SAP BW maintenance development system XB1 (source system)

To import remote API, follow these steps:

1. In SAP Solution Manager, start transaction SE09, transport organizer.
2. Choose Request/Task ‣ Create from the menu.
3. Create an empty transport of copies (in our example: XSCK900055).
4. Save the development package for the retrofit for BW extension remote APIs to your newly-created transport of copies:
   - Start transaction SE80.
   - Enter /SALM/* as package and choose the input help (arrow icon)
   - Select development package /SALM/RETRO_BW_MS on the following dialog box and choose OK.
   - Mark development package /SALM/RETRO_BW_MS with the cursor.
   - With a right-click, select Write Transport Entry from the menu.
   - Choose All Entries. (all objects of the development package are saved to the transport request) on the following dialog box.
   - In the dialog box, enter the transport order number of your newly-created transport of copies as the transport order, and save the transported packages.
5. Display your transport of copies in transaction SE09:
   - Switch to change mode and navigate to the Objects tab.
Enter the referring namespace `/SALM/` (R3TR NSPC /SALM/) as a new entry in the object list of your transport of copies.

Release the objects of your transport of copies.

As target for the transport of copies, enter the QAS SAP Solution Manager system.

6. Put the transport of copies to the import queues of the source and retrofit target system:
   - Start transaction STMS on the QAS SAP Solution Manager system.
   - Select Overview ‣ Imports from the menu.
   - Display the import queue of SAP Solution Manager system.
   - Mark your transport of copies (`XSCK900055`) with the cursor and choose Request ‣ Forward ‣ System from the menu.
   - Enter the source system (XB1).
   - Forward the transport of copies to the import queue of the retrofit target system.

7. Import the retrofit for BW extension remote APIs in the source system:
   - Start transaction STMS in the source system XB1 and navigate the menu options to Overview ‣ Imports
   As a result, the import queue of the source system XB1 is displayed, as shown in the screenshot below.

8. Import the retrofit for BW extension remote APIs in the retrofit target system:
   - Mark the transport of copies (`XSCK900055`) with the cursor and choose the Import Request icon.
   - Start transaction STMS in the retrofit target system XB3 and choose the menu options Overview ‣ Imports.
   As a result, the import queue of the retrofit target system XB3 is displayed, as shown in the screenshot below.
9. Mark the transport of copies (XSCK90055) with the cursor and choose the Import Request icon.

11.4.7 Activating Retrofit for BW scenario

To enable the scenario Retrofit for BW (AUTO_BW), please follow these steps:

1. Start transaction SPRO and navigate to SAP Solution Manager Implementation Guide \ SAP Solution Manager \ Focused Build \ Retrofit \ Activate Retrofit Automation Scenarios
2. Choose **New Entries**.

3. Open the search help of field **Parameter ID**, choose parameter **AUTO_BW** and set it to active as shown in the screenshot below.

11.4.8 Activating BAdI Implementation /SALM/RETRO_RELEASE

To activate the BAdI implementation /SALM/RETRO_RELEASE (enhancement implementation: /SALM/RETRO_EXTENSIONS), follow these steps:

1. Using the IMG path of SAP Solution Manager, navigate to **SAP Solution Manager ➤ Focused Build ➤ Retrofit ➤ Business Add-ins ➤ Activate Retrofit Release BAdI implementation**.
2. Select the **Active(IMG)** checkbox, as highlighted in the screenshot below.

Note

The BAdI implementation /SALM/RETRO_RELEASE is required to apply additional logic for the successful conflict detection and object classification at transport release regarding the described critical BW object types.

11.4.9 Activating BAdI Implementation /SALM/AFTER_RETROFIT

In a non-conflict case, the BAdI implementation /SALM/AFTER_RETROFIT is required to delete the old BW object GUID after successful retrofit, and, in a second step, assign the adequate GUID to the critical SAP BW object.
In addition, the original system is adjusted automatically and the critical SAP BW object is saved to the retrofit target transport request.

To activate the BAdI implementation `/SALM/AFTER_RETROFIT` (enhancement implementation: `/SALM/RETRO_EXTENSIONS`), follow these steps:

1. Using the IMG path of SAP Solution Manager, navigate to SAP Solution Manager ➔ Focused Build ➔ Retrofit ➔ Business Add-Ins ➔ Activate After Retrofit BAdI implementation.
2. Select the Activate(IMG) checkbox, as highlighted in the screenshot below.

11.4.10 Deleting Retrofit-Critical Objects

In the control table for objects used in retrofit scenarios, there is an entry for each critical SAP BW object type, as the enhanced retrofit cannot perform a conflict detection for these objects. Therefore, the enhanced retrofit puts all critical SAP BW objects to Manual Retrofit. As we are implementing the Focused Build retrofit for BW, we must delete designated entries (see below) from the table.

To delete the retrofit-critical objects, follow these steps:

1. Using the customizing path of SAP Solution Manager, navigate to SAP Solution Manager ➔ Capabilities (Optional) ➔ Change Control Management ➔ Retrofit ➔ Define Values for Retrofit Scenarios.
2. Delete the following entries from the table, using the delete icon, as shown in the screenshot below.
11.4.11 Deactivating Retrofit Parameter SCEN_BW

The retrofit parameter SCEN_BW (BW scenario for SAP standard functionality of enhanced retrofit), is set to Active by default. The Focus Build retrofit for BW parameter should be used instead of the BW scenario for SAP standard retrofit. Therefore, you must deactivate retrofit parameter SCEN_BW.

To deactivate SCEN_BW, follow these steps:

1. Using the customizing path of SAP Solution Manager, navigate to SAP Solution Manager ➤ Capabilities (Optional) ➤ Change Control Management ➤ Retrofit ➤ Define Retrofit Parameters.

2. For parameter BW Scenario for Retrofit, use the dropdown menu to change the value to Parameter Inactive.

11.4.12 Additional Authorizations for TMW RFC USER

The TMW RFC user (in our case: SMTMXSC) requires additional authorization for the new function group /SALM/FGR_RETRO_BW_MS on the BW development systems:

- Authorization object S_RFC for the function module RS_TRFN_GET_RETROFIT_TRANIDS. This RFC authorization has been embedded in the SAP Role SAP_SOLMAN_TMW_702.
- Authorization object S_TRANSPRT with values TTYPE = 'TRAN' and ACTVT = '02'. This authorization is included in the SAP standard role SAP_SOLMAN_TMW_702.
- Authorization object S_TABU_DIS with values DICBERCLS = 'BWC', 'SC' and ACTVT = '03'. This authorization is required for retrofit according to SAP note 2451511.
- Auth. object S_RS_ADMWB with value ACTVT = '03'. This authorization is included in the SAP standard role SAP_SOLMAN_READ_702.
For more information, see SAP Note 2257213 - Authorizations for RFC users for SAP Solution Manager 7.2 SP02 and higher.

11.4.13 Retrofit with Implemented Focused Build Retrofit for BW

After implementing the Focus Build Retrofit for BW, non-conflicting critical SAP BW objects are classified green (set for auto-import).

In a conflict case, a critical BW object is classified red (set for manual retrofit).

11.5 Repack for Change Request Management: Configuration Activities

11.5.1 Overview

This section covers repack functionality and configuration. It addresses complex system landscapes with dual development tracks that deliver one or more production systems.

For example, there is one development track used for maintenance of the production system(s) and another development track used for implementation and enhancement projects. As part of the preparation of the go live of such a project, you need to document this as a change to your up-and-running production system(s). Therefore, this project needs to be passed as a change through the maintenance track, which adds the benefit of performing a dress rehearsal in this track.

The project that needs to be passed through the maintenance track consists of many changes (most likely over 100) respective of its transport requests. To improve the performance during the technical transport and the handling during cut over and go
live, the transport requests of the implementation project can be repacked into one change (respective of its transport) of the maintenance cycle.

**Note**

Package distribution for managed system: The package `SALM/CHARM_REPACK_MS` must be deployed to each managed development system where the repack is to be performed.

### 11.5.2 Roles and Authorizations

#### TMW User

This user, maintained in the RFC connection, needs the authorization object `S_RFC` with the following values:

<table>
<thead>
<tr>
<th>Authorization Object</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_RFC</td>
<td>ACTVT</td>
<td>16</td>
</tr>
<tr>
<td>RFC_NAME</td>
<td>/SALM/CHARM_REPACK</td>
<td></td>
</tr>
<tr>
<td>RFC_NAME</td>
<td>/SALM/CHARM_REPACK_CHECK</td>
<td></td>
</tr>
<tr>
<td>RFC_NAME</td>
<td>/SALM/CHARM_REPACK_UPDATE_TR</td>
<td></td>
</tr>
<tr>
<td>RFC_NAME</td>
<td>TR_OBJECTS_OF_REQ_AN_TASKS_RFC</td>
<td></td>
</tr>
<tr>
<td>RFC_NAME</td>
<td>TMW_TM_GET_HISTORY</td>
<td></td>
</tr>
<tr>
<td>RFC_NAME</td>
<td>RFC_TYPE</td>
<td>FUNC</td>
</tr>
</tbody>
</table>

**Caution**

These authorizations are not added via transaction `SOLMAN_SETUP` or `LMDB` when you create the RFCs.

#### Change/Transport Manager

The repack is integrated in the business role `SALM/SM_SM_PRO`. To use it, you need to have the following roles assigned:

- `SAP_OST_SM_CRM_UIU_SM_PRO`
- `SAP_OST_FB_CRM_UIU_CM`
- `SAP_OST_FB_CRM_UIU`

The user who performs the repack requires the authorization object `SM_FIELD` with the following values:

- `SM_FIELD`
  - **Business transaction type**: SMHF, SMMJ
  - **Field name**: `/SALM/REPACK`, `/SALM/XLD`

This authorization is included in the role `SAP_OST_CM_TRANSPORT_M`.

#### Configuration User
To configure repack via transaction `SPRO`, the configuration user needs to have `SAP_OST_FB_CM_ITSM_CONFIG`.

### 11.5.3 Choosing Repack Options

During the repack process, the guided procedure offers several options. For more details, see the bulleted items below the screenshots.

To start the repack procedure, follow these steps:

1. Choose repack scenario from options shown in the below screenshot.
   - **Repack by Transport**: In the next step, you can select transport requests freely from the source system.
   - **Repack by Change Cycle**: In the next step, you can select transport requests assigned to a given change cycle.

2. If you selected **Repack by Transport** in step 1, choose source options from those shown in the below screenshot:
   - **Source System**: Choose the dropdown arrow to select the relevant source system (if multiple systems are available). The source system is the system where the repack takes place.
   - **Start Date/End Date**: Show transport requests that were imported into the source system during a particular period.
   - **Show Open Transports**: Select if open transport requests should be shown in the result list. (Start/end dates not considered.)
   - **Show ToC**: Select if ToCs should be shown in the result list.

3. If you selected **Repack by Change Cycle** in step 1, choose source options from those shown in the below screenshot:
   - **Source System**: Choose the dropdown arrow to select the relevant source system (if multiple systems are available).
   - **Change Cycle**: Select the change cycle to display all assigned transport requests that were imported into the source system.

4. Choose target options from those shown in the below screenshot.
   - **Workbench Request**: Select a target workbench request (if multiple requests are available).
   - **Customizing Request**: Select a target customizing request (if multiple requests are available).
- **Change Originality**: Change originality of workbench objects to the source system.
- **Add Directory Locks**: If transport locks exist for objects that should be repacked in the source system, the function deletes these locks to add the locks for the repack target transport request.
- **ToC into Customizing**: Repack transports of copies into target customizing transport (otherwise, they are repacked into target workbench transport).
- **Add CSOL**: Add cross-system object lock for the target repack transport request

### 11.5.4 Setting Default Values for Repack Configuration Options

This section describes the customizing parameters in the table /SALM/REPACK_CUS. These parameters allow you to set default values for the repack options.

To set default values, follow these steps:

1. Start transaction SPRO.
2. Under SAP Reference IMG, navigate to SAP Solution Manager ➔ Focused Build ➔ Change Control Management Extensions ➔ Repack ➔ Repack Configuration.

3. From the displayed customizing table /SALM/REPACK_CUS, choose default value options as detailed in the bulleted items below:
   - **SET_CSOL**: Defines the default value for Add CSOL option. Set to X if this option should be checked by default.
   - **SET_DIRLOCK**: Defines the default value for Add Directory Locks option. Set to X if this option should be checked by default.
   - **SET_ORIGINALITY**: Defines the default value for Change Originality option. Set to X if this option should be checked by default.
11.5.5 Configuring Status-Dependent UI Element Control

Using Repack, the object lists of transports that were imported into the current system can be copied into other transports. The contained object entries are not changed.

But there might be a situation where changes in the object list are necessary. For example: In BW systems, there are objects like data sources that receive a different key when they are imported into a system. As only the original keys are copied for these object entries, errors may occur later when the transports are released.

To handle this, the enhancement spot /SALM/CM_REPACK_POST_STEPS can be implemented and activated. It currently contains the BAdI definition /SALM/CM_REPACK_POST_STEPS. Its method PERFORM_POST_REPACK is called after the actual repack for each target transport. It allows you to change the object list and update the target transport.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IS_REPACK_SYSTEM</td>
<td>Importing</td>
<td>System, where Repack is performed</td>
</tr>
<tr>
<td>IV_DESTINATION</td>
<td>Importing</td>
<td>Logical Destination to Repack system</td>
</tr>
<tr>
<td>IT_SOURCE_TRS</td>
<td>Importing</td>
<td>Table with source transport requests</td>
</tr>
<tr>
<td>IV_TARGET_TR</td>
<td>Importing</td>
<td>Target transport request</td>
</tr>
<tr>
<td>IV_TARGET_TRFUNCTION</td>
<td>Importing</td>
<td>Type of target transport (workbench/customizing)</td>
</tr>
<tr>
<td>IV_CSOL</td>
<td>Importing</td>
<td>Flag for Cross System Object Lock</td>
</tr>
<tr>
<td>IV_DIRECTORY_LOCK</td>
<td>Importing</td>
<td>Flag for Directory Lock</td>
</tr>
<tr>
<td>IV_ORIGINALITY</td>
<td>Importing</td>
<td>Flag for Originality</td>
</tr>
<tr>
<td>CT_OBJECTS</td>
<td>Changing</td>
<td>changed object list - will replace originals</td>
</tr>
<tr>
<td>CT_KEYS</td>
<td>Changing</td>
<td>changed key entries - will replace originals</td>
</tr>
<tr>
<td>CV_UPDATE_TARGET</td>
<td>Changing</td>
<td>Target Transport needs to be updated</td>
</tr>
<tr>
<td>CV_SUCCESS</td>
<td>Changing</td>
<td>method was executed successfully</td>
</tr>
<tr>
<td>CT_MESSAGES</td>
<td>Changing</td>
<td>table with messages</td>
</tr>
</tbody>
</table>

This BAdI can be implemented and activated by using the SPRO activity SAP Reference IMG, navigate to SAP Solution Manager ➦ Focused Build ➦ Change Control Management Extensions ➦ Repack ➦ Activate After Repack BAdI
Please also check the delivered implementation /SALM/IM_CM_REPACK_ADD_SAMPLE. It will add a simple comment to the object list.

11.5.6 Usage of Repack with CSOL

If cross-system object lock (CSOL) is activated for the system where the repack should be executed, repacking locked objects can cause errors. This will happen even if CSOL is configured to Warning only.

To prevent these errors, add the parameter `CSOL_WARN_DIA_FREE_STRATEGY` within transaction DNO_CUST04. This is also described in SAP Note 1591120 - CSOL: Inconsistency in non-SAP GUI application scenario.

This customizing defines the consequences after lock conflict warning. For example, when you save changes to a transport request, CSOL calculates the lock conflicts with the following results:

- If there are no conflicts, the save will be done successfully.
- If there are error conflicts, the application will report an error.
- If there is overall warning conflict, it depends on the value of the field `CSOL_WARN_DIA_FREE_STRATEGY`:
  - If there is the value CANCEL_WARNING, the saving is cancelled and reported. The repack is not executed.
  - If there is the value IGNORE_WARNING, the saving continues. No error is reported and lock entries are added. Repack is executed.

If the `CSOL_WARN_DIA_FREE_STRATEGY` customizing entry is not added, the default behavior is equivalent to the setting CANCEL_WARNING.
11.6 Simple IT Request: Configuration

11.6.1 Overview

This section covers the functionality of Simple IT Request and its configuration.

With Simple IT Request, business users can consume any SAP Solution Manager-based IT service via a catalog Fiori application as a single point of entry. This includes an intuitive user interface for post-processing of used services (My Requests Fiori application).

The IT organization can create and maintain the respective service catalog and its services via CRM UI in SAP Solution Manager. The service catalog is based on the multi-level categorization of CRM transactions and can be structured with respect to the business user perspective. The services are based on CRM transaction templates. They can be created and maintained using standard ITSM and ChaRM functions in SAP Solution Manager.

The service consumption starts in the service catalog where predefined content of transaction templates is displayed as services. When a service is consumed, a defined transaction is created based on predefined data from the template and additional information submitted by the service consumer. For example, the service authorization issues are defined via an incident template. The service consumer finds this service in the catalog, adds information about the authorization he is missing and submits the request. This generates an incident transaction with predefined information such as the support team as well as additional information added by the service consumer.
The processing of requests is handled just like any other transaction via CRM UI by assigned message processors, support teams and others. Communication in terms of queries to the requester (and vice versa) happens via the My Requests Fiori application from requester perspective and CRM UI from request processor perspective.

11.6.2 Roles and Authorizations

Service Requester
The service requester can access the service catalog via a Fiori application. The requester can access their own services that were requested via the My Requests app.

This includes the option to review the status of their request, answer to questions raised by the processor, manage attachments (create, edit, delete), and set user status via action buttons (withdraw, reject, confirm).

- The relevant Fiori applications are accessible via transaction SM_WORKCENTER.
- For service requesters, the following composite role is available: SAP_OST_SSR_REQUESTER_COMP

Note

If the approval-based workflow for service requests should be available for service requesters, the additional role SAP_OST_FB_ITSM_S4RQ_CREATE is required.

Service Manager

The service manager maintains the service catalog and its hierarchy via CRM UI and a dedicated business role (/SALM/SM_PRO). Within this business role, the service manager can create, maintain, or delete transaction templates (=services) such as incident template, service request template, and others. Besides the basic definition of the service, including its pre-defined data (such as involved parties, priority, and long text), the service manager also defines the layout of the service form in the catalog application. The service manager can maintain the categorization schema to define the structure of the services that appear in the catalog application. The service manager also has access to the service catalog via a Fiori App.

Both UIs (catalog maintenance in CRM UI, service catalog application) are accessible via transaction SM_WORKCENTER.

For service managers, the following composite role is available: SAP_OST_SSR_MANAGER_COMP

Request Approver
If an approval is required in the workflow of a request, the respective approver can find the request in the Fiori application My Inbox or in the CRM UI via transaction SM_WORKCENTER. The approver requires the additional role SAP_OST_FB_ITSM_S4RQ_APPROVE.

### 11.6.3 Standard Configuration Considerations

Simple IT Request is delivered with predefined customizing for business roles and authorization roles. The predefined customizing for a standard configuration must be activated via the piece list. (see chapter: Activating the Piece List). SAP recommends adapting predefined customizing to the customer-specific implementation of SAP Solution Manager. Consider the following areas when adapting the standard configuration.

#### Service Catalog Structure

The service catalog structure is maintained by means of categorization schemas via CRM UI. This can be done with the authorizations of the service manager role and CRM business role /SALM/SM_PRO. In standard configuration, the standard categorization schema SAP_SM_TEMPLATE_V2 is used.

If this schema does not reflect the structure of your set of services, you can create a specific categorization schema. This custom schema then needs to be assigned to the transaction templates and transactions representing services and service requests used in Simple IT Request.

You can also define two separate categorization schemas to reflect two different perspectives on your services:

- To organize your services within the catalog and provide an intuitive navigation for business users.
- To categorize requested services with IT internal attributes, such as for internal routing or reporting.

Accordingly, you find two sections of multi-level categorizations in each template transaction (incident template, problem template, service request template, request for change template).

#### Business Role

The standard configuration delivers the CRM business role /SALM/SM_PRO for maintenance of services and catalog structure by the service manager role via CRM UI. If you would like to include functions of this business role into customized business roles, consider the specific navigation bar profile /SALM/S1SOLMANPRO. This profile includes work centers S1–CHANGE,
S1-SUPPORT and SRV-OPERAT, which are relevant for activities of the service manager mentioned above. For instance, the work center S1-SUPPORT includes the link groups S1-IM-CR, S1-IM-SR to create and search for incident-related transactions and templates. These groups contain links such as S1-IMT-CR to create incident templates. The latter refers to CRM UI component /SALM/INCIDENTM via target ID S1TIMTCR.

In addition, the UI configurations also need to be adjusted if other business roles are used. Include the assignment block Simple IT Request Setup referring to CRM UI component /SALM/ITSMSSRFS into the configuration of the corresponding business role.

Transaction Templates and Transactions

In standard configuration, the following transaction types and templates are defined and ready for immediate use:

- S4IT – Incident Template
- S4PT – Problem Template
- S4ST – Service Request Template
- S4CT – Request for Change Template
- S4AT – Service Request Template (with approval workflow)

Based on these template types, services can be created with the service manager role. These services then trigger the generation of a transaction of the defined type (see table /SALM/ITSM_SSRTM):

- S4IT triggers SMIN
- S4PT triggers SMPR
- S4ST triggers SMRQ
- S4CT triggers SMCR
- S4AT triggers S4RQ (with approval workflow)

This mechanism follows the general approach of Simple IT Request as described above. (To integrate custom-specific templates or transaction types, see chapter: Customizing Options.) All relevant tables that need to be maintained are highlighted. Adjustments to authorization roles, categorization schemas, and CRM business roles, including UI configurations, also might be necessary if you use new or other transaction types for Simple IT Request. Further details can be found in this configuration guide in the referring chapters.

Authorization Role

Two composite authorization roles are delivered with Simple IT Request. The roles cover the activities of service requesters and service managers as described above.

Service Requester

SAP_OST_SSR_REQUESTER_COMP includes the following single roles:
• SAP_OST_SSR_REQUESTER
• SAP_SM_CRM_UIU_FRAMEWORK
• SAP_SM_CRM_UIU_SOLMANPRO_PROC
• SAP_SOCM_REQUESTER
• SAP_SUPPDESK_CREATE

Service Manager
SAP_OST_SSR_MANAGER_COMP includes the following single roles:
• SAP_OST_SM_CRM_UIU_SM_PRO
• SAP_OST_SSR_MANAGER
• SAP_SM_CRM_UIU_FRAMEWORK
• SAP_SM_CRM_UIU_SOLMANPRO_CHARM
• SAP_SM_CRM_UIU_SOLMANPRO_CREA
• SAP_SM_CRM_UIU_SOLMANPRO_PROC
• SAP_SOCM_REQUESTER
• SAP_SUPPDESK_CONFIG
• SAP_SUPPDESK_CREATE

We recommend copying these roles into the customer namespace. Adjust them to customer specifics if necessary, and generate the referring profiles.

The adjustments to customer specifics typically cover the following authorization objects and use cases.

Service Requester
Role: SAP_OST_SSR_REQUESTER
Object: /SALM/SSRG
Use Case: Restrict access to services by defining authorization groups (customizing table /SALM/ITSM_SSRAG), which can be assigned on transaction template level by the service manager.

Role: SAP_OST_SSR_REQUESTER
Object: CRM_SS_CCAT
Use Case: Restrict access to groups of services based on the categorization schema.

Role: SAP_OST_SSR_REQUESTER
Object: CRM_ORD_LP, CRM_ORD_PR
Use Case: Restrict access to transaction types of transaction templates and transactions. Especially when having custom specific transaction types such as ZMIN, ZMIT and others. These need to be added here.

Service Manager
Role: SAP_OST_SSR_MANAGER
Object: /SALM/SSRG
Use Case: Restrict access to services by defining authorization groups (customizing table /SALM/ITSM_SSRAG), which can be assigned on transaction template level by the service manager.

Role: SAP_OST_SSR_MANAGER
Object: CRM_SSCCAT

Use Case: Restrict access to groups of services based on the categorization schema.

Role: SAP_OST_SSR_MANAGER
Object: CRM_ORD_LP, CRM_ORD_PR

Use Case: Restrict access to transaction types of transaction templates and transactions, especially for custom-specific transaction types such as ZMIN, ZMIT, and others. These need to be added here.

### 11.6.4 Activation of SICF Services

Use transaction SICF and activate/check the following services:

- /sap/bc/bsp/salm/itsm_ssrc
- /sap/bc/bsp/salm/itsm_ssrm
- /sap/bc/ui5_ui5/salm/itsm_ssrc
- /sap/bc/ui5_ui5/salm/itsm_ssrm
- /sap/opu/odata/salm/itsm_ssr_catalog_srv
- /sap/opu/odata/salm/itsm_ssr_myrequests_srv

### 11.6.5 Defining System Aliases for oData Services

For the UI5 applications of the Simple IT Request solution, OData services system aliases must be defined.

To define system aliases for oData services, follow these steps:

1. **Start transaction** /n/IWFND/MAINT_SERVICE
   - Enter /n in front to start the transaction from SAP GUI.
2. **Filter for service** /SALM/ITSM_SSR_CATALOG_SRV, Simple IT Request Catalog.
3. **In the ICF Nodes screen area**, select the oData entry
4. **Check whether the status to the oData service is green.**
   - If the status is not green, select **ICF Node** and choose **Activate**.
5. **Check that the system alias for the local SAP Solution Manager is assigned.**
To add it, select Add System Alias.

Select New Entries.

Add the entry as shown in the screenshot below.

- Save.

Repeat all Steps for the service /SALM/ITSM_SSR_MYREQUESTS_SRV as well.

### 11.6.6 Configuration Options

This section describes the configuration options of Simple IT Request. The options can be adjusted in different tables. Further details, standard configuration settings, and configuration examples can be found in the corresponding documentation and customizing tables in your SAP Solution Manager system.

<table>
<thead>
<tr>
<th>Option</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition of Service Templates for Catalog Selection</td>
<td>/SALM/ITSM_SSRSR</td>
<td>Define the template transaction types that can be used to create catalog services.</td>
</tr>
<tr>
<td>Template Mapping to Simple IT Request Transaction Type</td>
<td>/SALM/ITSM_SSRTM</td>
<td>Define the mapping between template transaction type and transaction type which is created if a service is consumed.</td>
</tr>
<tr>
<td>Copy Control for Transaction Types</td>
<td>CRMV_PR_COPY_MA</td>
<td>Define standard copy control between template transaction types and transaction types.</td>
</tr>
<tr>
<td>Customizing of General Settings</td>
<td>/SALM/ITSM_SSRST</td>
<td>Define General Settings for the Simple IT Request using Parameters.</td>
</tr>
<tr>
<td>Definition of Available Layout Fields for Simple IT Request Apps</td>
<td>/SALM/ITSM_SSRLF</td>
<td>Define the transaction fields that can be selected within the layout component during maintenance of a service (such as Description, Priority, Urgency, Contact Person). If customer-specific layout fields require a value-help, an additional BADi-implementation needs to be created. Please refer to the existing implementations (/SALM/ITSM_SSR_DEFAULT_VHI) of BADi /SALM/ITSM_SSR_FLDVALHELP_BADI.</td>
</tr>
<tr>
<td>Define Activities for Simple IT Request</td>
<td>/SALM/ITSM_SSRAC</td>
<td>Define status activities which are visualized as options in the My Request app, depending on the current user status of the transaction. (For example, Withdraw to set a transaction to status Withdrawn.)</td>
</tr>
</tbody>
</table>
### 11.6.7 Configuring Manual Activities

To configure manual activities for Simple IT Request, follow these steps:

1. Start transaction `SPRO`.
2. Select **Simple IT Request** as highlighted in the screenshot below.
3. Open activity General Settings for Simple IT Request and fill the fields as shown in the screenshot below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Number</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASP_CAT_TYPE</td>
<td></td>
<td>C</td>
</tr>
<tr>
<td>ASP_PROC_TYPE</td>
<td>0</td>
<td>S4IT</td>
</tr>
</tbody>
</table>

- **ASP_PROC_TYPE**: This parameter needs to be set to one of the template transaction types used in Simple IT Request. If you don’t plan to use the standard transaction types, please adapt the value `S4IT` to your needs. This Parameter needs only to be set once and is mandatory!
- **ASP_CAT_TYPE**: Catalog type to which the transaction type `ASP_PROC_TYPE` is assigned within the multi-level categorization schema (typically C or D). This Parameter needs only to be set once and is mandatory!
- **MYREQ_TXT_LOGON_LANGU_ONLY**: Activating this Parameter using Value ‘X’ enables the MyRequests App to show only texts in the User’s logon language, while the standard behavior is to show all texts, independent on the logon language. This parameter is optional and only needs to be set once.
- **CAT_USE_BADI**: Activating this Parameter using Value ‘X’ enables both Applications (Catalog and MyRequests) to use a custom BAdI-Implementation when working with a Categorization layout field (see chapter 11.6.12 for detailed information on this topic). This Parameter is optional, only needs to be set once and requires a custom Implementation of BAdI /SALM/ITSM_SSR_FLDVALHELP_BADI.
- **LINK_CAT1_SHOW**: Activating this Parameter using Value ‘X’ enables the Catalog App to show the Categorization Panel when accessing a Request Template using a direct HTTP Link. Only the top category level will be shown. If not set, the Categorization Panel is hidden. This parameter is optional and only needs to be set once.
- **TREE_DEFAULT**: Activating this Parameter using Value ‘X’, enables the Catalog App to use the List-/Tree-View instead of the Category View as default view. This parameter is optional and only needs to be set once.
- **SKIP_CONTENT_SRV**: Activating this Parameter using Value ‘X’, enables the MyRequests App to skip the Content Server on the Frontend-side when trying to access attachments. If set, the file content is transferred directly to the End-user. If not set, the Backend provides a Link to the Content Server to access the requested file. This parameter is optional and only needs to be set once.

4. Open activity Template Mapping to Request Transaction Type and fill the fields as shown in the screenshot below.
11.6.8 Implementation of Key SAP Notes

Implement or verify the correct implementation of the following SAP Notes.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2955721</td>
<td>Central Note for Focused Build ST-OST 200 (composes all fixes with the shipment of SP06)</td>
</tr>
</tbody>
</table>

11.6.9 (Optional) My Inbox Integration

With Simple IT Request, approval-based workflows are supported. You can find transaction types S4AT (template) and S4RQ (request) in default customizing delivery, which include such an approval workflow. The approval workflow for Change Request Management with transaction type SMCR is also supported. These workflows can be integrated into the Fiori app My Inbox running on a central Fiori Frontend Service (central-hub-deployment).

The configuration of this scenario follows the general procedure of the My Inbox integration for Change Request Management. In addition, configuration specific to Simple IT Request is delivered via piece lists for the Simple IT Request.

For more information, see SAP Note 2590554 - SAP Solution Manager - Change Request Management: My Inbox SAP Fiori App Integration - General Information. Please follow the note's instructions to establish an integration of your gateway/frontend server with SAP Solution Manager.

11.6.10 (Optional) Rich Text for Simple IT Request

The configuration steps below show how to enhance Simple IT Request with the rich text formatting feature.
As a disclaimer, technical restrictions prohibit working with rich texts in combination with guided procedures. In addition, technical restrictions prohibit activating rich texts for Change Request Management transaction types.

Once you've activated rich text formatting for a specific IT service management transaction type (such as incidents or service requests), avoid creating transactions of these types using guided procedures (such as used in business role SOLMANREQU to create incidents or service requests).

11.6.10.1 Prerequisites

First, as a prerequisite for establishing rich text, Focused Build SPS 2 or higher is installed on SAP Solution Manager 7.2 SPS 7 or higher.

Second, the following business functions are activated in transaction SFW5:

- CRM_ITSM_COM - Content and Text Management
- CRM_TM_1 - Text Management Assignment Block
- UI_FRW_RTE - Assignment is defined in business function

⚠️ Caution

Please be aware that business functions CRM_TM_1 and UI_FRW_RTE are not reversible.

Third, the following are implemented and activated:

- ORDER_SAVE
  - AIC_RICH_TEXT_ATTACH - Save images in rich text as attachments.

To check the status of BAdI implementation AIC_RICH_TEXT_ATTACH, follow these steps:

1. Start transaction SE18,
2. Enter ORDER_SAVE as BAdI Name.
3. From the menu bar, choose Enhancement Implementation ➔ Overview.
4. On the following screen, check if the implementation AIC_RICH_TEXT_ATTACH is highlighted with a yellow background color.

If the implementation has a yellow highlight, it is active. If the implementation is not highlighted, it must be activated.

To activate AIC_RICH_TEXT_ATTACH, continue with these steps:

5. On the same screen as described in step 4, select implementation AIC_RICH_TEXT_ATTACH.
6. Enter change mode by selecting F6 or the change icon, as highlighted by the arrow in the screenshot below.

7. Activate the implementation by choosing Implementation † Activate.

11.6.10.2 Configuration Considerations

Rich text formatting can be activated per text type individually. We recommend activating it for every used text type within the specific transaction type.

Please be sure to activate every text type which is defined in Simple IT Request’s customizing (description, reply, proposed solution, and others).

11.6.10.3 Enabling Notes Assignment Block for Rich Texts in CRM WebClient UI

The CRM WebClient UI can only display and edit rich texts in the notes assignment block of each transaction’s work area. Therefore, this block must be enabled in each relevant CRM WebClient UI component.

To enable the notes assignment block, follow these steps:
1. Enter the CRM WebClient UI via the Fiori work center or via transaction SM_CRM.
2. Choose business role /SALM/SM_PRO or your equivalent copied one.
3. Ensure that the configuration mode in personal settings is enabled.
   o From the CRM WebClient UI home screen, choose Personalize.
On the following screen, choose **Personalize Settings**.

![Personalize Settings](image)

In the following dialog box, select the **Enable configuration mode** checkbox and save your changes.

![Enable configuration mode](image)

4. Navigate to a transaction that you want to activate for rich text formatting.
5. Choose the **Configure Page** icon from the navigation bar.

![Configure Page](image)

6. In the following dialog box, copy the chosen configuration key, proceed with the predefined keys, or adapt the keys to your needs.

7. Select **Continue**.

8. Select the configuration for copying into customer namespace.

![Configuration](image)

9. Choose the **Copy** icon.
10. Choose the configuration key and select Continue:

![Configuration Key](image)

11. Change the load option of the assignment block GSTEXT (Title: Notes) from Hidden to your desired option.
   - Choose Direct for displaying the expanded block
   - Choose Lazy for a collapsed display.

![Displayed Assignment Blocks](image)

12. Select GSTEXT and change the load option.
13. Save the changes.
14. Repeat these steps for each transaction type that you want to use with rich text formatting.
15. (Optional) Since the assignment block displays all used text types, change the text assignment block’s load option to Hidden or Lazy via component AIC_LONGTEXT.

### 11.6.10.4 Configuration Options

See the following configuration options for activating rich text formatting in Simple IT Request. The options can be defined and maintained in customizing tables via transaction SM30.

<table>
<thead>
<tr>
<th>Option</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRM Formatted Text</td>
<td>CRMV_TEXT_FORMAT</td>
<td>Add a table entry for each text type you want to use. Choose the following options: Text-Object CRM_ORDERH</td>
</tr>
<tr>
<td>Option</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Select</strong></td>
<td></td>
<td><strong>Formatted</strong>&lt;br&gt;<strong>Select HTML-Text</strong>&lt;br&gt;Enter <strong>CL_CRM_TEXT_FORMAT_CONVERSION</strong> as the converter class</td>
</tr>
<tr>
<td><strong>Assign Business Objects to Switches</strong></td>
<td>CRMV_ITSM_SWITCH</td>
<td>Add a table entry for each business object type you want to use. Choose the following options:&lt;br&gt;Switch: <strong>CRM_ITSM_COM</strong>&lt;br&gt;Trans.Cat.: <strong>BUS2000223</strong> (for service requests and incidents), <strong>BUS20001116</strong> (for service orders) and/or <strong>BUS2000224</strong> (for problems)</td>
</tr>
<tr>
<td><strong>Customizing of General Settings for Simple IT Request</strong></td>
<td>/SALM/ITSM_SSRRST</td>
<td>Add a table entry for each transaction type you want to use. Choose the following options:&lt;br&gt;+: <strong>RT_PROC</strong>&lt;br&gt;Number: 1, 2, …, n&lt;br&gt;Text: <strong>S4RQ, S4AT</strong> and/or any additional ITSM transaction type.</td>
</tr>
<tr>
<td><strong>Service Desk Customizing (Attachment handling)</strong></td>
<td>DNOC_USERCFG</td>
<td>Add a table entry for each text type you want to use. Choose the following options:&lt;br&gt;Field Name: <strong>IM_TEXT_SAVE_ATTACH_{TextType}</strong> (Change {TextType} with text type ID)&lt;br&gt;Sequence Number: 1, 2, …, n&lt;br&gt;Field Value: X&lt;br&gt;Description: (your choice)</td>
</tr>
<tr>
<td><strong>AGS: Work Center Customizing</strong></td>
<td>AGS_WORK_CUSTOM</td>
<td>Optional: Maintain following entries in case Request for Changes are to be used with Simple IT Request:&lt;br&gt;Parameter Key: <strong>UIC_PROC_TYPE_SPECIFIC_{*}, Parameter Value: /SALM/CMCR_H/CMCROverview_S4CT</strong>&lt;br&gt;Parameter Key: <strong>UIC_PROC_TYPE_SPECIFIC_{*}, Parameter Value: /SALM/CMCR_H/CMCRHeaderEF_S4CT</strong>&lt;br&gt;See note 1483276 for additional information on the Parameter.</td>
</tr>
</tbody>
</table>

### 11.6.11 (Optional) Multilingual Services for Simple IT Request

Multilingual services enable service managers to maintain templates in the service catalog in each available language in SAP Solution Manager.
Note

The displayed language in applications My Requests and Catalog is selected based on the logon language in the Fiori launchpad. No additional customizing is necessary to activate this feature.

In CRM Web Client UI, the service manager can maintain the short-text translations in each available language. This is due to a translation area in the Simple IT Request assignment block.

If a translation is missing, a fallback scenario is implemented. The fallback language is selected based on the service’s initial language.

Maintain long-text translations (description, for example) as shown in the screenshots below.

Assignment block Text:

Assignment block Notes:

Any additional information (such as multi-level-categorization) can be maintained using the standard translation feature in CRM WebClient UI.
11.6.12 (Optional) Multi level Categorization layout field

To include Multi Level Categorization fields within your request templates, open the customizing activity Definition of available Layout Fields for UIS Apps and add an entry as follows:

Trans. Type: Transaction Type of your Request Template  
Object Name: CATEGORIZATION  
Field name: Catalog type and the technical ID of your Multi Level Categorization scheme separated by a backslash (e.g. D\SAP_SM_TEMPLATE_V2)  
Field label: Label displayed in the Category App  
Type: Value Help

Note: Both the template transaction type as well as the request transaction type need to be assigned to the same Catalog type of the Multi-Level Categorization scheme (see Application Area in the Categorization Scheme configuration).

The Categorization layout field works out of the box, but if you require to use an Implementation of BAdI /SALM/ITSM_SSR_FLDVALHELP_BADI due to internal requirements, you need to activate Parameter CAT_USE_BADI using Value 'X' in customizing activity General Settings for Simple IT Request. You’ll also have to create a custom Implementation of BAdI /SALM/ITSM_SSR_FLDVALHELP_BADI.

11.7 My Checklist Steps: Configuration

11.7.1 Overview

My Checklist Steps offers a central entry point to manage all not completed checklist steps that are assigned to you.

Features:
- toggle between the checklist steps that are assigned to you and those assigned to your team
- filter the displayed checklist steps
- switch between display and edit mode
- In edit mode, you can change the business partner assigned to a checklist step, the status of a checklist step, and the deadline
- Navigation to parent document
- Navigation to step details
11.7.2 Prerequisites

Checklists are customer specific and have to be setup.
This can be done in the following SAP Solution Manager customizing activity:
SAP Solution Manager Implementation Guide > SAP Solution Manager > Capabilities (Optional) > IT Service Management > Checklists

11.7.3 Configuration of My Checklist Steps: Transaction Types

It has to be configured, to which parent transaction types checklist steps shall be listed in the My Checklist Steps app.

1. Start transaction SM30 to navigate to the customizing table
2. In the Table/View field, enter view /SALM/ITSM_MCS_C
3. Choose Maintain
5. Add the transaction types that you want to use with checklists and to that in the My Checklist Steps app entries shall be listed
6. Save

11.8 dropDoc: Configuration

11.8.1 Overview

To manage numerous file types, consider configuring dropDoc. Here are dropDoc’s highlighted benefits:

- Simplifies the default usability of file management inside solution documentation.
- Allows for detailed configuration for your specific needs.
  - Defines the documentation store type and the expected document types in different surroundings.
  - Can be used in different variants.
- Can be implemented directly as a standalone option in solution documentation.
  - The standalone app MyDocuments displays all documents the user has created in Solution Documentation and that are assigned to the user as owner or responsible.
- Can be integrated as a part of Work Package (WP), Work Item (WI) and Business Requirement (BR) applications.
- Functions as a partial web application.
  - The frontend functionality of dropDoc is based on the browser UI technology SAPUI5.
Recommendation

For best dropDoc functionality, use the latest browser versions for Google Chrome, Firefox, Safari, or Internet Explorer.

With dropDoc you can:
- Insert files using drag and drop.
- Perform mass maintenance of documents and documents type.
- Change the document status.
- Change document owner or responsible party.
- Display and download of items such as process diagrams.
- Delete one or more documents at the same time.
- Optimize for different screen resolutions.

11.8.2 Prerequisites

You have already created a solution and assigned document types.

11.8.3 Overview of dropDoc Variants

- First, the attachments variant is used to upload and manage attachments for a solution. See the Attachments Tab as a part of WP or WI. For this dropDoc variant, the Allowed document types for Attachments table must be customized. (For more information, see chapter Document Types of Attachments.)
Second, the integration variant is the main dropDoc application for Solution Documentation for the managing of documentation. See the documentation tab in WP or WI. In the BR application, this variant is integrated in an attachment panel of a requirement. In addition, it is easily accessible via context menu. For this dropDoc variant, customize the general document types for solution. These are the documents for which the digital signature should be applied and the characteristics of the digital signature in general and the KPI properties must be defined. (For more information, see chapters Current Status Handling - KPI Overview, Overview of Digital Signature, Configuring E-Mail Notifications on Document Status Change)

Third, the standalone variant is displayed in a dialog box window directly in Solution Documentation column browser. For this dropDoc variant, define the document types for solution only.

The MyDocuments app presents documents from Solution Documents according to branches. You can change the status of documents directly from the MyDocuments app and trigger the e-mail notification. (see chapter Configuring E-Mail Notifications on Document Status Change)
11.8.4 Activating oData Services

To activate oData services, follow these steps:

1. Start transaction SICF.
2. Select the execute icon or F8.
3. Follow the path: /default_host/sap/bc/bsp/salm/drop_doc.
4. Activate the service DropDocs ui5 component for WP integration/SMUD.

11.8.5 Activating ICF Services

To activate BSP services, follow these steps:

1. Start transaction SICF.
2. Select the execute icon or F8.
3. Follow one of the following paths:
   - For dropDoc, /sap/opu/odata/salm/drop_doc_srv and activate the service DROP_DOC_SRV.
11.8.6 Document Types for Attachments

The only types of documents that are allowed as attachments for the solution are defined in the table **Allowed document types for Attachments**. If five document types must be defined for the solution, then each document type has to be maintained individually in the table. This table is accessible by running transaction **SM30** and then using transaction **/SALM/ALLWD_DOCT**. The table displays a list of allowed document types of attachments for each solution ID.

The table is divided into three columns:

- The first column, **Trans.Type**, stands for transition type. These values determine the usage of document types. There is the possibility to define different document types for different usage areas, separated for the WP, WI, or BR.
- The second column, Solution ID, displays required identification values for selecting a specific solution.
- The third column, Doc.Type, displays values for the documentation types.

**Recommendation**

To attach or upload documents without any specific document type, use the wildcard (*) for all three parameters in the table.

### 11.8.6.1 Configuring Document Types for Attachments

To configure document types for attachments, follow these steps:

1. Start transaction SM30 to navigate to the customizing table.
2. In the Table/View field, use transaction /SALM/ALLWD_DOCT.
3. Choose Maintain.
4. Here you can select a customized document type from the list. Select the value help icon to the right of the list for a short description of each document type.
5. Choose New Entries. Define one or several of the allowed document types.
6. Define the Solution ID, choose transaction type and document type.

**Note**

Use following transaction types:
- S1IT for WP
- S1CG for WI
- S1BR for BR

7. Save the parameter.
8. Confirm the prompt for workbench request or create a new one with the create request option.

As a result, the defined document types for attachments are available in the selected solution. You see the document types in the dialog box window in the dropdown menu of document type’s field. The dialog box window opens by creation of an attachment.
11.8.7  Current Status Handling - KPI Overview

Logic of dropDoc KPI

The KPI displaying the state of necessary documents of WP and their rating. If the rating of the document KPI is grey, this signifies that KPI for this document type exists but not necessary for WP/WI in its current status. The overall rating applies the worst rating, as shown below:

<table>
<thead>
<tr>
<th>KPI 1</th>
<th>KPI 2</th>
<th>OVERALL RATING</th>
</tr>
</thead>
<tbody>
<tr>
<td>green</td>
<td>green</td>
<td>green</td>
</tr>
<tr>
<td>green</td>
<td>red</td>
<td>red</td>
</tr>
<tr>
<td>red</td>
<td>green</td>
<td>red</td>
</tr>
<tr>
<td>red</td>
<td>grey</td>
<td>red</td>
</tr>
<tr>
<td>green</td>
<td>grey</td>
<td>green</td>
</tr>
</tbody>
</table>

11.8.7.1  Current Status Handling - KPI Customization for Work Package and Work Item

1. To navigate to the customizing table for KPI, run transaction SM34.
2. In the input field for a Table/View, use transaction /SALM/VC_KPI and choose Maintain.
3. Choose New Entries, define your new KPI (description is optional), and save the settings. Select the Relevant option, because only relevant KPIs are considered.
4. Select your newly created KPI and choose Define relevant transaction in the tree structure, on the left side.

Note

Following two transaction options are available:
- S1IT for WP
- S1CG for WI

5. Define Worst- or Best-Case rating of your KPI.
Note

KPI with Best Case:
Green, if the KPI is green rated in one of the WP/WI structures.
Red, if the KPI is for all structures red.

KPI with Worst Case:
Green, if the KPI is green in all WP/WI structures.
Red, if at least one KPI in a structure is not green.

6. Select your KPI, choose Define Classification Mapping, and define the mapping. In first column, select the classification type of WP or WI, then Sub Classification in the third column.
If no sub classification is selected, default settings for empty sub classification take effect. Default settings must be defined beforehand.
In the last column, determine the document types for which the KPI should apply. Save your parameters.

7. Select the mapping and navigate to Define transaction status and document status.

Define the status of WP/WI in first column UsrSt. Then select Solution Manager Document Status, which is the status of your document type that you defined type defined in a previous step. Specify the KPI behavior in relation to document status in the last column KPI. In the last column KPI select the option Green.
Now you can see your created KPI for your document type in the documentation tab in WP/WI application in the Current Status area.

Recommendation

You can see these parameters in WP/WI applications on the first Details tab. Be sure to define the sub-classification of your WP/WI too. To do so, open the WP, navigate to the Details tab, and select Edit.

11.8.8 Overview of Digital Signature

The digital signature dropDoc can be defined for one or more specific document types. The digital signature includes a relationship of several parameters of a document. It controls the status change of a document. One or more users with certain roles must digitally sign a document. It offers two digital signature modes: the single signature and the double signature mode. In a double signature mode, two different user roles must confirm the document status change.

For example, when changing the status of the document type configuration guide from in preview to released, the user with the developer role signs the document and confirms the change.

Double signature settings can specify that the status change must be confirmed by two different roles, and this can include, for example, a single user with both the developer role and manager role. Only when both roles have signed, can the document complete its change to its new status.

The definition of a signature can be divided into three large work blocks:
- Defining a digital signature including authorization groups
- Defining a status schema
- Assigning a status schema to document type

11.8.8.1 Configuring Digital Signature Settings

To configure digital signature settings, follow these steps:

1. Start transaction SOLMAN_SETUP.
2. Navigate to Process Management in the scenarios field on the left side.
4. In the Steps area, choose Define Signatures and Authorization Groups.
5. Define the digital signature.
Define authorization groups:

Enter the authorization groups you want to generate. The groups represent different departments that need to sign a document to release it.

Define individual signatures

The individual signatures represent the roles you define in the authorization groups.

Define signature strategies:
These entries describe how a document is signed. If you set the method to **System signature with Authorization by SAP User ID/Password**, it means that the signature is based on the currently logged-in user, who must enter their password to proceed.

6. Select the newly created signature strategy and choose **Assign individual signatures**.
7. Enter every individual signature that is needed for the scenario.
8. Go back to the strategy overview and select your strategy.
9. Choose **123 Signatures** on the right side of the table.
10. Check the predecessors according to your signing scenario.
11. Save your changes.

**Note**

The signature sequence controls the order in which a document needs to be signed by the different authorization groups.

12. Go back to the strategy overview and select your strategy.
13. Choose **Release** on the right side of the table.
14. Check the release states accordingly to your signing scenario.
15. Save your definitions.

**Note**

In this context, release means that the signing procedure is completed and the document is locked. The right side displays every combination of individual signatures that can be made. This also takes the signature sequence into account.

As a result, you define a signing strategy as abstraction of your business use case.

Continue by assigning this to a status schema, which is used for a certain documentation type.

To assign a signing strategy to a status schema, follow these steps:

1. Start transaction **SOLMAN_SETUP**.
2. Choose **Process Management** from the navigation area on the left.
4. Choose the step **4.4 Define Values for Document** and execute.
5. Choose the second step **Define Document Status Schema**.
6. Enter the value for the signature strategy you want to use and select the Locked checkbox.

7. Enter values for the end status and the cancelation status.

8. Fill in the highest sequences, so that the last status can only be reached from the last but one status.

9. Save the changes.

Finish by creating a new document type for your solution or select one of the existing document types. Assign your status schema to the created/selected document.

To assign your status schema, follow these steps:

1. Run transaction slan.
2. Select the solution and navigate to Document Types.

3. Select the menu icon in the upper right corner.

4. Choose Document Type Administration from the dropdown menu. Here, you can select or create a document type.

5. Select the document type and choose Edit. Navigate to Properties and select your status schema.

6. End the specification by choosing the toggle edit mode icon.

### 11.8.8.2 Assigning Digital Signature to a Status Schema

Assigning a digital signature to a status schema is useful for a certain documentation type.

To assign a status schema, follow these steps:

1. Run the transaction SOLMAN_SETUP.
2. Choose Process Management from the navigation area on the left.

6. Enter the value for the signature strategy you want to use and select the Locked checkbox.

7. Enter values for End Status and Cancel Status.
8. Fill in the highest sequences, so that the last status can only be reached from the last but one status.
   Save the changes.

11.8.8.3 Creating a New Document Type for Your Solution

Create a new document type for your solution, or select one of the existing document types and assign your status schema to this document.
To create a new document type, follow these steps:

1. Start transaction SLAN.
2. Select the solution and navigate to Document Types.
3. Select the menu icon in the upper right corner, as shown in the screenshot below.
4. Choose Document Type Administration from the dropdown menu, as shown in the screenshot below.
   - Select or create a document type.
5. Select the document type and choose the Edit icon, as highlighted in the screenshot below.
6. Navigate to Properties and select your status schema, as highlighted in the screenshot below.
7. End the specification by choosing the Edit icon.
11.9 Multi-Tenancy Enhancement: Configuration

11.9.1 Use Case

The multi-tenancy function allows customers to fully control all data that is used for CHARM and ITSM, to be separated by respective authorization objects.

Some of these authorization objects are already available in SAP standard and only reused in this configuration guide or added at respective spots where data was not correctly handled.

There are two different options available as splitting criteria:
- Configuration item (system-specific)
- Business partner (customer-specific)

The different data available for a normal end-user:
- Transaction Data (Tickets from CHARM and ITSM)
- Business Partner (BP)
- Configuration Items (CI)
- Change Cycles (CHARM Only)
- Process Management Data

All applications within the WebUI for CHARM and ITSM are applicable to splitting criteria. For example, without authorizations, it is not possible to see data objects in their respective search queries.

11.9.2 Roles and Authorizations

To configure the multi-tenancy enhancement via transaction SPRO, the configuration user needs to have SAP_OST_FB_CM_ITSM_CONFIG.

There are several areas within the multi-tenancy enhancement. Each one may require different authorizations. The necessary adaptions are described in the for each area separately:
- Status Check for Transaction Types: Changes to Roles
- Business Partner-Dependent Checks: Necessary Adaption to Roles
- Configuration of Item-Dependent Checks: Adaptions to Roles
- Restriction of Access to Solutions and Documentation: Adaptions to Roles
11.9.3 Status Check for Transaction Types

The status check for transaction types adds an additional authorization check. It provides status-specific control regarding read and write access to a ticket.

The system checks whether a user has the needed authorization when the user performs an action such as:

- Open/display a document
- Change into edit mode
- Set next status

The system checks whether the type of the current document belongs to the configured types. In this case, it checks if the user is authorized display or edit the ticket in the current status.

This chapter describes the necessary configurations you need to use the business partner-dependent check. The configurations can be combined with Business Partner-Dependent Checks and Configuration of Item-Dependent Checks. Be sure to also perform the steps described in chapter Activation of Checks.

11.9.3.1 Activating the Status Check

You can activate the status check for specified transaction types. Each transaction type where the status check should be applied, must be added to a configuration table.

To activate the status check, follow these steps:

1. Start transaction SPRO.
2. Open SAP Reference IMG.
4. Start Define Multi Tenancy Settings.
5. Select node Statuscheck in Transaction Types.
6. Add all transaction types to be checked.

7. Save.
11.9.3.2 Changes to Roles

The authorization object \texttt{/SALM/MTST} must be added to all process roles used to control access to tickets in Web UI. Otherwise, none of tickets of the added transaction types can be accessed. Depending on their tasks in the process, the values for the authorization fields must be set.

The authorization object \texttt{/SALM/MTST} has three fields:

- \texttt{STSMA}: Status profile of the transaction type to be checked
- \texttt{ESTAT}: User status which can be displayed or created
- \texttt{ACTVT}: Permitted activities are to create and to display

The object consists of the fields \texttt{Activity}, \texttt{Status Profile}, and \texttt{User Status}.

- \texttt{Activity}: Use the value options to define which activities are permitted.
  - \texttt{02} = Change
  - \texttt{03} = Display
  - \texttt{*} = All activities
- \texttt{Status Profile}: Define the status profiles of the checked transaction types.
- \texttt{User Status}: Define the user status values where the user gets authorization to display or edit.

\textbf{Caution}

The values for \texttt{User Status} may be not unique for different transaction types and their status profiles. Therefore, it might be necessary to add different entries of this authorization object for each transaction type.

11.9.3.3 Setting Values for Roles

This new object must be added to the authorization roles of each process role, such as requester, developer, and change manager. Depending on their tasks in the process, the values for the authorization fields must be set.

To set values for the authorization fields, follow these steps:

1. Start transaction \texttt{PFCG}.
2. Open your authorization role in edit mode.
3. From the Authorization tab, choose Change Authorization Data.
4. Add new entries for authorization object \texttt{/SALM/MTST}.
   - Alternatively, edit existing entries.
5. Save your changes and generate the profile.
The following screenshot shows authorizations for transaction ZMAD.

The first entry is for granting display access to the specified status of status profile ZMADHEAD. The second one adds edit authorization.

<table>
<thead>
<tr>
<th>Action</th>
<th>Status</th>
<th>Business Partner</th>
<th>Status Profile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>CI</td>
<td>B_BUPA_GRP</td>
<td>ZMADHEAD</td>
</tr>
<tr>
<td>Edit</td>
<td>SI</td>
<td>B_BUPA_GRP</td>
<td>ZMADHEAD</td>
</tr>
</tbody>
</table>

**Caution**

For each status that the user has edit authorization, we recommend you also assign the display authorization. If the user can set the next status of a ticket, we recommend you assign display authorization for the target authorization too.

There is also the delivered role SAP_OST_FB_MULTI_TEN, which contains only this object and can be used as template.

### 11.9.4 Business Partner-Dependent Checks

Business partner-dependent checks help to control access to:
- Business partners in search help
- CRM transactions via assigned sold-to party

The authorization object for the business partner authorization group, B_BUPA_GRP, is used for these checks. The results of the checks display only those business partners within a group to which the user has authorization.

To access a ticket, the user needs to have the authorization for the sold-to party’s authorization group. The user does not need to be assigned to the same organization.

This chapter describes the necessary configurations to use the business partner dependent check. They can be combined with status check for transaction types and configuration item dependent checks.

Be sure to also perform the steps described in chapter 3.8.12, Activation.

### 11.9.4.1 Organizational Structures Overview

To maintain the master data, maintain an organizational model in SAP Solution Manager with one of the two structures.
11.9.4.2 Creating Root Organizations and Their Structures

Create your organizational model first. One root organization is needed for each tenant.

To create root organizations and their structures, follow these steps:

1. Start CRM WebUI.
2. Use a business role with access to Master Data / Organization Model (for example, /SALM/SM_PRO or SOLMANPRO).
3. Choose Create Root Organizational Unit.
   - Alternatively, choose Open your root organization, if it exists already.

4. Create organizational units and positions within your root organization according your needs. You need at least one position to assign all employees.

11.9.4.3 Assigning Employees to a Root Organizational Structure

All employees working for one tenant must be assigned to a root organization responsible for one of their organizational units. This assignment is then used to assign the business partner authorization group automatically by report. As each business partner has only one authorization group assigned to it, the business partner should be assigned to more than one root organization. Otherwise, the report takes only one assignment into consideration and logs an error.

As a prerequisite, users need to have the authorization to access the corresponding business partner groups. This can be added independent from the current organizational assignment.

To assign employees, follow these steps:

1. Start CRM WebUI.
2. Use a business role with access to Master Data / Organization Model (for example, /SALM/SM_PRO or SOLMANPRO).
3. Open your root organization.
4. Navigation to the position where the employee should be assigned.
5. Choose the add Employee icon.

6. Search for the business partner to be assigned.
7. Select the business partner in the search result list.
8. Repeat for all needed assignments.
9. Save.

As an alternative method to assign the business partner, follow these steps:
1. Run the SAP GUI transaction PPOMA_PRM.
2. Navigate to the position, choose the Assign icon and select Owner.
3. Search for the business partner to be assigned.
4. Select the business partner in the search result list.
   - Select more than one business partner, if needed.
5. Save.

### 11.9.4.4 Adding Role Sold-To Party to Business Partner

To control the access to the tickets, each ticket should have the root organization entered as Sold-To Party. This is only possible, if the corresponding business partner has the role Sold-To Party.

To add the role Sold-To Party to a business partner, follow these steps:
1. Start CRM WebUI.
2. Use a business role with access to Master Data / Organization Model (such as /SALM/SM_PRO or SOLMANPRO).
3. Open the business partner your root organization.
4. Go to assignment block Roles, select the edit list and add new entry for Sold-To Party.
5. Save.

As an alternative method to add the role Sold-To Party to a business partner, follow these steps:
1. Start transaction BP in SAP GUI.
2. Open the business partner.
3. Add the BP role.

11.9.4.5 Creating Authorization Groups

You can use authorization groups to stipulate which business partners a user can process.

The system checks this authorization if you made an entry in the authorization group field for the business partner. Otherwise, any user may process the business partner.

To create authorization groups, follow these steps:

1. Start transaction SPRO.
2. Open SAP Reference IMG.
5. Create one authorization group for each tenant.
6. Create the default authorization group: One authorization group that can be used for all unassigned business partners.

11.9.4.6 Assigning the Default Authorization Group

Assign the default authorization group to business partners not already part of a root organization defined in customizing.

Note

This is a precondition to execute the report to assign authorization groups to all business partners automatically.
To assign the default authorization group to business partners, follow these steps:

1. Start transaction SPRO.
2. Open SAP Reference IMG.
3. Navigate to SAP Solution Manager ➤ Focused Build ➤ Change Control Extensions ➤ Multi Tenancy Extensions.
5. Choose General Parameters.
6. Select or create an entry for parameter DEFAULT_BP_AUTHGRP.
   - Only one entry is applicable.
7. Enter your default authorization group as parameter value.
8. Save.

11.9.4.7 Assigning Authorization Groups to Root Organizations

Define your root organization and assign it to an authorization group.

**Note**

This is a precondition to execute the report to assign authorization groups to all business partners automatically.

To assign the authorization group to root organizations, follow these steps:

1. Start transaction SPRO.
2. Open SAP Reference IMG.
3. Navigate to SAP Solution Manager ➤ Focused Build ➤ Change Control Extensions ➤ Multi Tenancy Extensions.
4. Start Define Multi Tenancy Settings.
5. Select Organizations and Authorizations.
6. For each root organization, create a new entry.
7. Select the corresponding business partner.
8. (Optional) Enter a description.
9. Assign the corresponding business partner authorization group.
10. Save.

11.9.4.8 Assigning Authorization Groups to Business Partners

You can assign authorization groups to business partners manually or by report. Business partners without an authorization group can be accessed by all users with display authorization.

**Recommendation**

Consider assigning all business partners in your system to an authorization group according to their root organization (tenancy). This recommendation also applies to unassigned business partners with restricted visibility.
To assign authorization groups to each business partner manually, follow these steps:

1. Run the transaction BP.
2. Select the business partner to be changed.
3. Go to the Control tab.
4. Enter value for field Authorization group.
5. Save.

A maintenance report automatically assigns authorization groups based on a customizing table where each tenancy is assigned to a specific authorization group. The report assigns a default authorization group to every business partner not otherwise assigned to a tenancy. This prevents unwanted visibility of unassigned business partners.

⚠️ Caution

The user who runs this report may require additional authorizations. The Overview of Multi-Tenancy Enhancement Report chapter contains a detailed list.

To assign authorization groups to business partners by report, follow these steps:

1. Start transaction SPRO.
2. Open SAP Reference IMG.
3. Navigate to SAP Solution Manager → Focused Build → Change Control Extensions → Multi Tenancy Extensions.
5. Execute the report with the prefilled values first.
   - Testmode activated. No changes are saved.
   - Assign authorization groups. The system updates the authorization group by analyzing the organizational assignment of existing business partners.
   - Only assigned business partners deactivated. Unassigned business partners get the configured default authorization group.
   - Root organizations taken from customizing. For more information, see chapter Organizational Structures Overview.
   - Business partner prefilled with a wildcard (*) to check all business partners.

6. Check execution log.
   - All needed changes regarding the assigned authorization groups are listed.
7. Repeat execution with deactivated test mode to make permanent changes to business partners.
11.9.4.9 Scheduling Assignment Report as Background Job

Keeping the assigned authorization groups up-to-date is important to control the access to business partners and business partner dependent data. A background job can update the assignments on a regular basis. Scheduling an assignment report as a background job involves creating a variant for report execution and scheduling the background job.

To create a variant for report execution, follow these steps:

   - Alternatively, open the report via transaction SE38 and use report name: /SALM/ITSM_MT_BP_AUTH_GRP.
2. Deactivate Testmode.
3. Save variant.
   - Enter name and description for variant.
   - Within Objects for selection screen table, change the Save field without values field for entry SO_ROOT to ensure that all root organization from customizing are considered.

   ![Variant Attributes](image)

4. Save.

To schedule a background job, follow these steps:

1. Start transaction SM37.
2. Enter job name.
3. Create step.
   - ABAP program name: /SALM/ITSM_MT_BP_AUTH_GRP.
   - Select your variant.
4. Define start condition.
   - Choose Date/Time.
   - Enter start date and time (if possible, outside business hours).
   - Activate Periodic Job.
Choose Period Values and select a period.

5. Save.

6. Save job definition to release the job.

Check the result of the last job run in transaction SM37 by opening the spool list.

11.9.4.10 Configuring Checked Partner Function

Normally the partner function Sold-To Party is used to check the accessibility of a ticket. The checked partner function can be changed. This configuration is valid for all transaction types.

To configure the checked partner function, follow these steps:

1. Start transaction SPRO.

2. Open SAP Reference IMG.

3. Navigate to SAP Solution Manager ➔ Focused Build ➔ Change Control Extensions ➔ Multi Tenancy Extensions.

4. Start Define Multi Tenancy Settings.

5. Select General Parameters.

6. Select or create an entry for parameter SOLD_TO_PARTNER.
   - There must be only one entry.

7. Add the technical key for the used partner function as parameter value.
   - If there is no entry for SOLD_TO_PARTNER, or if the parameter value is empty, use the default value 00000001 (meaning Sold-To Party).

Caution

If the partner function does not exist or has no value for the current ticket, the user can still access the ticket, but it won't be found by any search. Therefore, you need make sure that the business partner of the root organization is added to each transaction.

All used transactions of ITSM, ChaRM, and Requirements Management should have this partner function available within their partner profile and it is defined as mandatory.

11.9.4.11 Configuring Partner Profiles

To configure partner profiles, follow these steps:
1. Start transaction SOLMAN_SETUP: Change Request Management.
2. Go to Step 3.6 Setup Business Partner and select Define Partner Determination Procedure.
   - Alternatively, use the corresponding transaction SPRO activity.

3. Select your transaction type(s).
5. Add the partner function, if necessary.

7. Repeat for all used transaction types.
8. Save your changes.
11.9.4.12 Authorization Object B_BUPA_GRP

With the authorization object B_BUPA_GRP, define which business partners can be edited based on the authorization group.

The object consists of the fields Activity and Authorization group.

- **Activity**: Define which activities are permitted from the following possible values:
  - 01 = Create
  - 02 = Change
  - 03 = Display
  - 06 = Delete
  - * = All activities
- **Authorization group**: Define the groups of business partners for which the above activities are permitted.

11.9.4.13 Adding Object B_BUPA_GRP to Authorization Roles

The object B_BUPA_GRP must be added to your authorization roles. The concrete values for this authorization object are based on the assignment of the business partner of a user to one of the organizations/tenants and not to the business partner’s process role.

**Recommendation**

Consider managing this authorization in separate roles per tenant. If necessary, further tenant-dependent objects can be added to these roles.

Here, only the display permission is taken into consideration since it is assumed that only this is needed within ChaRM and ITSM.

To add the object B_BUPA_GRP to your authorization roles, follow these steps:

1. Start transaction PFCG.
2. Open your authorization role in edit mode.
4. Add new entries for authorization object B_BUPA_GRP (or edit existing ones).
   - **Activity**: 03 (= Display)
   - **Authorization Group** (your created authorization groups)
5. Save your changes and generate the profile.

In general, a user should have the authorization for the authorization group he or she is assigned to. This is the only possibility to access all business partners that are assigned to the same organization.

- In exceptional cases, a user must access the business partners of different organizations. This may apply, for example, for administrators and support staff. In this case, all corresponding (organization) authorization roles should be assigned to the user.
11.9.5 Configuration of Item-Dependent Checks

The authorization object SM_SDK_IBA is used for configuration item-dependent checks, which help to control access to:

- Systems in search help
- CRM transactions via assigned systems

This section describes the necessary configuration to use the configuration item-dependent check. They can be combined with status check for transaction types and business partner-dependent checks. Be sure to also perform the steps described in chapter Activation of Checks.

11.9.5.1 Organizational Structures

For using this function, it is required to have an organizational structure with employees assigned. A structure as described in chapter Organizational Structures Overview can be reused here.

⚠️ Caution

The organizational units are later assigned to the systems. Each unit with assigned employees must also be assigned to the system. Higher-level units are not considered.

This makes it possible to differentiate the accessible systems within one root organization. However, there might be a higher effort because several units must be assigned to the same systems.

11.9.5.2 Assigning Business Partners to LMDB Objects

As soon as the organizational structure has been finished, the organizational units must be assigned to the LMDB objects.

To assign business partners to LMDB objects, follow these steps:

1. Start CRM WebUI.
2. Use a business role with access to Master Data / LMDB Objects (/SALM/SM_PRO or SOLMANPRO).
3. Search for the system the business partner(s) should be assigned to.
4. Open the system.
5. Go to assignment block Parties involved.
6. Choose Edit List if you want to add a business partner.
   a. Choose Insert
   b. Select the business partners of the organizational units and/or root organizations, which will need to access this system.
   c. Set partner function to Service Employees Group for all added entries.
7. Save LMDB object.
11.9.5.3 Adding Object SM_SDK_IBA to Authorization Roles

Authorization object SM_SDK_IBA restricts the IBase components that are being shown to the user. It has the field Restrict visibility for IBase components, with the following possible values:

- **ALL**: All IBase components
- **USERS_ORG**: IBase components that the business partners' organizations are assigned to.
- **USERS_OWN**: IBase components that the business part itself is assigned to.

Changes to Roles

The concrete values for this authorization object are based on the assignment of an organizational unit to a system and not to their process role.

**Recommendation**

Consider managing this authorization in separate roles per tenant. If necessary, further tenant-dependent objects can be added to these roles.

To add object SM_SDK_IBA to authorization roles, follow these steps:

1. Start transaction PFCG.
2. Open your authorization role in edit mode.
3. From the Authorization tab, choose Change Authorization Data.
4. Add new entries for authorization object SM_SDK_IBA (or edit existing ones).
5. Restrict visibility for IBase components: USERS_ORG, USERS_OWN.
6. Save your changes and generate the profile.

In general, a user should have the authorization for the systems their organizational unit is assigned to. In exceptional cases, a user must access systems of different organizations. For example, here are two applicable options available for administrators and support staff:

- Assign authorization object SM_SDK_IBA with full authorization (Restrict visibility for IBase components = ALL or *).
- Assign the organizational units of these employees to each system they should have access.

11.9.5.4 Configuring Referenced Objects Assignment Block as Visible Per Default

The configuration item-dependent check is based on referenced objects. If a document does not have a referenced object, it will be displayed to all users. Referenced objects are added automatically, except for change cycles (phase and release cycles). An assignment is made within the multi-tenancy enhancement by an additional BAdI, but it must first be activated as described in chapter Activate BAdI for Referenced Objects.

To validate this automatic assignment, the referenced objects assignment block should be made visible for change cycles. Since it is already contained in the configuration as Hidden, this can be done by personalization of the responsible users. However, if
the assignment block for all users should be visible per default, please perform the following steps for phase cycles and release cycles.

To configure the assignment block as visible per default, follow these steps:

1. Login into the WebUI and use your current business role.
2. Open a change cycle.
   - Ensure that your current component name is /SALM/CMCD_H.
4. If you have no configuration for your role configuration key, you can copy a configuration to create your customer version.
   - Use the entry with role config key /SALM/SM_P to copy it to your own configuration key.
5. Select your current WebUI configuration (or the copied one) and check, where the assignment block Referred Objects is contained in the lists of displayed assignment blocks:
   - View ID: CUITSMRefObj.BTREFOBJ/OVEWindow
   - Component: BTREFOBJ
6. Check the column Load Option for this entry. If it is set to Hidden, change it to Direct.
7. Save your changes.

11.9.6 Restriction of Access to Solutions and Documentation

It is possible to restrict the access to solutions and their documents. Even the change cycles belonging to a solution/branch can be restricted. For example, a user can be restricted to assign documentations that belong to the user’s organization only.

Access the application security guide for your specific SP level in SAP Solution manager 7.2. The security guides can be found when you expand the Operation column header, chapter Process Management, and Test Suite / Scenario Specific Guide: Process Management. Alternatively, navigate to Main Authorization Objects Solution Documentation SM_DOC.

Also, see SAP note 2440107 - How to determine Authorization objects for Element Types, Group Type and Attribute Type for Solution Documentation.
This document concentrates on the authorization objects needed for ChaRM and ITSM:

- To add documentation to tickets
- To select change cycles in ChaRM transactions

For the above activities, no activation is necessary. Instead, make changes to authorization roles, as described in the following section.

### 11.9.6.1 Maintenance of Authorization Roles

The authorization objects `SM_SDOC` and `SM_CMFUNC` must be added to your authorization roles. The concrete values for these authorization objects are based on your existing solution documentation and their structure.

#### Authorization Object SM_SDOC
This object controls the solution documentation maintenance.

Use `SM_SDOC` to restrict access to solution documentation. You see cycles assigned to branches where you have the authorization to display the documentation (`SM_SDOC`). You also need the display authorization for all higher-level entries.

Defined fields for `SM_SDOC` include:

- **SLAN**: restricts authorization by solution.
- **SBRA**: restricts authorization by branch.
- **SMUDAREA**: restricts authorization by sections of a solution, by specifying authorization areas within a solution and assigning them to structure elements. Authorization areas are maintained with view cluster `SMUD_AUTHG`, in transaction `SM34`. A structure element can be assigned to only one authorization area. Child elements inherit the area of their parent, if they do not have their own authorization area. Elements that have no parent assigned to an authorization area, have the virtual authorization area `DEFAULT`.
- **SMUDAUTHGR**: restricts authorization to groups of specified element types or attribute types. Authorization groups are maintained with view cluster `SMUD_AUTHG`, in transaction `SM34`. The virtual authorization group `DEFAULT` contains all combinations of objects and attributes that are not in a user-defined authorization group.
- **ACTVT**: allows restricting authorizations to certain user activities like create, change, display, delete, activate, release, move, discard, override and copy. Display is only checked for elements, not for attributes. If a user can see an object, all of its attributes are visible to the user. For operations on structure elements some activities are only checked for the top element as the following table shows. There you also can see that some complex operations that a source and target elements trigger multiple elementary authorization that all must be passed successfully to finish the operation.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Authorization Group(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display elements</td>
<td>03 Display All elements</td>
</tr>
<tr>
<td>Create elements</td>
<td>01 Create All elements</td>
</tr>
<tr>
<td>Delete elements</td>
<td>06 Delete Elements and Sub-elements</td>
</tr>
<tr>
<td>Change attributes</td>
<td>02 Change All attributes</td>
</tr>
<tr>
<td>Sort elements</td>
<td>02 Change Parent element</td>
</tr>
<tr>
<td>Release changes</td>
<td>43 Release for current branch 07 Activate, generate for parent branch Selected and dependent elements</td>
</tr>
<tr>
<td>Discard changes</td>
<td>69 Discard Selected and dependent elements</td>
</tr>
<tr>
<td>Mark conflict as resolved</td>
<td>94 Override Selected and dependent elements</td>
</tr>
<tr>
<td>Move elements</td>
<td>50 Move 01 Create Only moved elements and target parent</td>
</tr>
<tr>
<td>Copy elements</td>
<td>D1 Copy 01 Create Only copied elements and target parent</td>
</tr>
<tr>
<td>Merge elements</td>
<td>06 Delete for parent 02 Change for attributes of target element</td>
</tr>
</tbody>
</table>
Forbidden actions are hidden in the context menu. For some actions (such as delete or reference to executable library) the context menu results in a pre-check. A full check would too long or would not be possible. The context menu entry does not fully define the complete action. These actions can be visible. The user can get an error when executing the action.

Authorization Object **SM_CM_FUNC**: Authorization to perform various Quality Gate Management (QGM) and change request management functions. **SM_CM_FUNC** is used for filtering possible change cycles. Enter **CTPR** (Assign to Change Request Management cycle) in field **CM_ACTVT**.

Defined fields for **SM_CM_FUNC** include:

- **SUB_LAND** - Name of the sub-landscape
- **BRANCH_NM** - Name of the branch
- **CYCLE_TYPE** - Type of change cycle
  - R - Major release
  - M - Minor release
  - E - Emergency release
  - O - Maintenance cycle
  - I - Implementation cycle
  - Q - Quality Gate Management
- **CM_ACTVT** - Specific functions to be controlled.
  - CHCH - Modify change in QGM
  - CHCR - Create change in QGM
  - CHDE - Delete change in QGM
  - CHFI - Complete change in QGM
  - CHRA - Reassign change in QGM
  - CHWD - Withdraw change in QGM
  - CTPR - Assign to Change Request Management cycle
  - CYDP - Display QGM cycle
  - CYED - Edit QGM cycle
  - QBAP - Approve quality gate as Quality Advisory Board member in QGM
  - QMAP - Approve quality gate as Quality Manager in QGM
  - SCDP - Display QGM scenario
  - SCED - Edit QGM scenario
  - SSDP - Display CTS status switch
  - SSED - Edit CTS status switch
  - TACR - Create transport task in QGM
  - TLCF - Complete task list
  - TLCR - Create task list
  - TRAP - Approve/withdraw critical object
  - TRAS - Assign transport request in QGM
11.9.7 Activation of Checks

To use the checks listed in the following sub-sections, you must first activate the checks. For this you need to implement two BAdIs and to switch on the checks in customizing.

11.9.7.1 Activating BAdI for Authorization Check: CRM Business Transaction

The business add-in CRM_ORDER_AUTH_CHECK is used to enhance the authorization check in the business transactions. The implementation /SALM/ITSM_MT_AUTHCK provides additional checks on current status values, selected business partners and referenced systems. To use these checks, the implementation needs to be activated first.

To activate the implementation /SALM/ITSM_MT_AUTHCK, follow these steps:

1. Start transaction SPRO.
2. Open SAP Reference IMG.
3. Navigate to SAP Solution Manager ➔ Focused ➔ Change Control Extensions ➔ Multi Tenancy Extensions.

As a result, a list of all existing implementations of business add-in CRM.ORDER.AUTH_CHECK is displayed. Only one of the displayed implementations must be active. The active implementation is highlighted. In general, this is AI_SDK_EXT_AUTH_CHK, Extended Authorization Check, or your own implementation.

5. Select the active implementation.
7. Activate /SALM/ITSM_MT_AUTHCK.
   o Select the row for this implementation.
   o Choose Activate/Deactivate.
If you have your own implementation deactivated by the previous steps, but you still need the contained authorization check, you can integrate your implementation via customizing.

To integrate an implementation, follow these steps:

1. Start transaction SPRO.
2. Open SAP Reference IMG.
3. Navigate to SAP Solution Manager à Focused Build à Change Control Extensions à Multi Tenancy Extensions.
4. Start Define Multi Tenancy Settings.
5. Select General Parameters.
6. Select or create an entry for parameter DEFAULT_AUTH_CHECK_BADI. There must be only one entry.
7. Enter the implementing class of the BAdI as value.
   o For example: To call the implementation of AI_SDK_EXT_AUTH_CHK, you would need to add CL_IM_AI_SDK_EXT_AUTH_CHK.
   o If there is no entry for DEFAULT_AUTH_CHECK_BADI, or if the value is empty, the system calls the implementation class of AI_SDK_EXT_AUTH_CHK.

11.9.7.2 Activating BAdI for Authorization Checks on OneOrder Documents

The enhancement implementation /SALM/ITSM_MT_ORDER_AUTH_CHECK also provides additional checks on the referenced configuration items of business transactions. To use these checks, the implementation needs to be activated first.

To activate the implementation /SALM/ITSM_MT_ORDER_AUTH_CHECK, follow these steps:

1. Start transaction SPRO.
2. Open SAP Reference IMG.
3. Navigate to SAP Solution Manager à Focused Build à Change Control Extensions à Multi Tenancy Extensions.
4. Start Activate BAdI for Authorization checks on OneOrder Documents.
   o If you see a message from a dialog box asking if you want to deactivate the BAdI implementation, it means BAdI is currently active. Choose Cancel to close the dialog box and keep the implementation active.
If you see a message asking if you want to activate the BAdI implementation, as shown in the screenshot below, it means BAdI is currently inactive. Choose Yes to activate.

### 11.9.7.3 Activating BAdI for Referenced Objects

The business add-in `ORDER_SAVE` is used to enhance the process of saving a CRM document, for example to add additional data. The implementation `/SALM/ITSM_MT_SAVE` will be processed for phase and release cycles. As soon as there are assigned production systems, the corresponding IBase components will be added as referenced objects.

To use these checks, the implementation needs to be activated first. There can be multiple active implementations.

To activate the implementation `/SALM/ITSM_MT_SAVE`, follow these steps:

1. Start transaction `SPRO`.
2. Open SAP Reference IMG.
3. Navigate to SAP Solution Manager ➤ Focused Build ➤ Change Control Extensions ➤ Multi Tenancy Extensions.

As a result, a list of all existing implementations of business add-in `ORDER_SAVE` is displayed. There can be more than one active implementation. All active implementations are highlighted.

5. **Activate** `/SALM/ITSM_MT_SAVE`.
   - Select the row for this implementation
   - Choose Activate/Deactivate

11.9.7.4 Multi-Tenancy Enhancements for Activation

Activate the multi-tenancy enhancements (MTEs) in customizing. There are three parameters to switch on the multi-tenancy checks:

- **ACTIVATE_MTE**
  - Activates multi-tenancy in general. None of the functions (such as business partner or configuration item-dependent checks, status check for transaction types) can be used without this activation.
  - Some restrictions are not controlled by this parameter. For example, the authorization to display a business partner of a specific authorization group is independent of this parameter. This works even if MTE is deactivated.

- **ACTIVATE_MTE_BP**
  - Activates the business partner-dependent check: The user’s root organization needs to be entered in a specified partner function of an CRM ticket.
  - Parameter **ACTIVATE_MTE** must also be activated.

- **ACTIVATE_MTE_CI**
  - Activates the checks based on configuration items: The organization of the current user needs to be assigned to the referenced object of a transaction.
  - Parameter **ACTIVATE_MTE** must also be activated.

This table shows which parameters need to be activated for the following executed checks.

<table>
<thead>
<tr>
<th>ACTIVATE_MTE</th>
<th>ACTIVATE_MTE_BP</th>
<th>ACTIVATE_MTE_CI</th>
<th>Executed Checks</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>-</td>
<td>-</td>
<td>Status Check for Transaction Types</td>
</tr>
<tr>
<td>X</td>
<td>X</td>
<td>-</td>
<td>Status Check for Transaction Types</td>
</tr>
<tr>
<td>X</td>
<td>-</td>
<td>X</td>
<td>Status Check for Transaction Types</td>
</tr>
<tr>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Status Check for Transaction Types</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>None</td>
</tr>
<tr>
<td>-</td>
<td>X</td>
<td>-</td>
<td>None</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>X</td>
<td>None</td>
</tr>
<tr>
<td>-</td>
<td>X</td>
<td>X</td>
<td>None</td>
</tr>
</tbody>
</table>
11.9.7.5 Activating Multi-Tenancy Enhancements

To activate the multi-tenancy enhancements, follow these steps:

1. Start transaction SPRO.
2. Open SAP Reference IMG.
3. Navigate to SAP Solution Manager ➤ Focused Build ➤ Change Control Extensions ➤ Multi Tenancy Extensions.
4. Start Define Multi Tenancy Settings.
5. Select General Parameters.
6. Enter value X to activate the following parameters:
   - ACTIVATE_MTE
   - ACTIVATE_MTE_BP
   - ACTIVATE_MTE_CI

Note
Remember to check the parameter descriptions and table above to see which parameters must be activated together.

11.10 Status-Dependent Check Framework: Configuration

11.10.1 Use Cases

Check for Mandatory Inputs
Consistency check for mandatory field is not only not performed when creating new documents, but later in the process. It can be executed on status change: As soon as the user tries to set a new status via action or directly, the system checks whether there are any mandatory fields, business partners, or texts which need to be filled when entering the new status.

Some standard fields can be examined by the standard status-dependent check, but this framework can also be used in user-defined fields:
- Fast entry fields
- Business partners
- Texts

Locked Fields against Subsequent Changes
Input fields might be locked against changes, but without additional development there is no possibility to do so dependent from the current status.
- Fast entry fields
- Business partners
11.10.2 Roles and Authorization

To configure the status-dependent check framework via transaction SPRO, the configuration user needs to have SAP_OST_FB_CM_ITSM_CONFIG.

11.10.3 Consistency Checks for Change Transaction Types

11.10.3.1 Defining Consistency Check

Before the consistency check can be used, it needs to be defined.

To define the consistency check, follow these steps:

1. Start transaction SPRO.
2. Navigate to SAP Solution Manager à Capabilities (Optional) à Change Control Management à Change Request Management Framework à Consistency Checks.
3. Open the activity Define conditions.

4. If there is no entry for /SALM/CONS_CHECK, create a new entry:
   - Status Transition Consistency Check: /SALM/CONS_CHECK
   - Description: Fieldbased consistency check
   - Implemented in the Class: CL_CM1_INSTANCE

5. Save and navigate back one step to the folder Consistency Checks.
6. Open the activity Define Basic Settings.
7. If there is no entry for /SALM/CONS_CHECK, create a new entry:
   - Status Transition Consistency Check: /SALM/CONS_CHECK
- **Message Class:** `/SALM/ITSM_CC`
- **Message Number:** `001`
- **Message Type:** `Error`

8. Save and navigate back one step to the folder **Consistency Checks**.

### 11.10.3.2 Adding Consistency Check to Transaction Type

The consistency check `/SALM/CONS_CHECK` is used for all status-dependent checks and the field locks described in this guide. Be sure that the used change management transaction types have the consistency check `/SALM/CONS_CHECK` configured for the used status values.

To configure check `/SALM/CONS_CHECK`, follow these steps:

1. Start transaction `SPRO`.
2. Call SAP Reference IMG and navigate to **SAP Solution Manager** ➔ **Capabilities (Optional)** ➔ **Change Control Management** ➔ **Change Request Management Framework** ➔ **Make Settings for Change Transaction Types**

3. Select your transaction type and choose **Assign Consistency Checks**.
4. Add the check `/SALM/CONS_CHECK` for each status where it should be performed.
   - This condition might be inserted for each existing status. If there is no further customizing (as described below), nothing happens.
11.10.4 Adding Field Checks

In this customizing activity, you can add fields to be checked when a certain status is reached. You can also disable the field for a status, while it can still be edited in other statuses.

To add fields to be checked, follow these steps:

1. Start transaction SPRO.
2. Call SAP Reference IMG and navigate to SAP Solution Manager ‣ Focused Build ‣ Change Control Management Extensions ‣ Status Dependent Check Framework

3. Choose the activity Additional Field Checks on the next screen.
4. Create an entry for each field and status you like to check.
   - First enter transaction type, status profile, and user status.
   - Select your field by using the columns **Object Name** and **Fieldname - object**.
   - The column **Mandatory** indicates whether the specified field needs a value when the status is reached.
   - The column **Display** indicates whether the specified field is disabled in the given status. If you want to keep the field disabled for all follow-up status, you need to add an entry for each status.

Example
You use the change management transaction **ZMAD** (copy of admin change). You like to check that the **Description** field has a value when the status **In Development** is set.

Add consistency check to **ZMAD** as described in chapter Consistency Checks for Change Transaction Types.
- Select transaction type **ZMAD**.
- Choose **Assign Consistency Checks**.
- Add entry:
  - User Status **E0002** (in development):
  - Sequence: **15** (or any other unused number)
  - Status Transition Consistency Check: **/SALM/CONS_CHECK**
  - Application Area: **/SALM/ITSM_CC**
  - Message Number: **001**
  - Message Type: **A Cancel**
• Add check for input field in activity Additional Field Checks

Trans Type: ZMAD
StatProf: ZMADJHEAD
UsrSt: E0002
Object Name: ORDERADM_H
Field name – object: DESCRIPTION
Mandatory: [Checked]
Display: [Checked]

• To disable field description in status E002, check the column Display too.

11.10.5 Checking Business Partner Function

In this customizing activity, add business partner functions to be checked when a certain status is reached. You can also disable the business partner input field for a status while it can still be edited in other statuses.

To add business partner functions to be checked, follow these steps:

1. Start transaction SPRO.
2. Call SAP Reference IMG and navigate to SAP Solution Manager ‣ Focused Build ‣ Change Control Management Extensions ‣ Status Dependent Check Framework
3. Choose activity **Check of Business Partner Function** on next screen.

4. Create an entry for each business partner function and status you like to check.
   - First enter transaction type, status profile and user status.
   - Select your business partner function by using the column **Function**.
   - The column **Mandatory** indicates whether the specified business partner function must have a value when the status is reached.
   - The column **Display** indicates whether the field for the specified business partner function is disabled in the given status. If you want to keep the field disabled for all follow-up status, you need to add an entry for each status.
Example

Use the change management transaction ZMAD (copy of admin change) and check that the Change Manager is specified when the status To be tested is set.

- Add consistency check to ZMAD as described in chapter Consistency Checks for Change Transaction Types.
  - Select transaction type ZMAD.
  - Choose Assign Consistency Checks.
  - Add Entry:
    - User Status: E0004 (in development)
    - Sequence: 15 (or any other unused number)
    - Status Transition Consistency Check: /SALM/CONS_CHECK
    - Application Area: /SALM/ITSM_CC
    - Message Number: 001
    - Message Type: A Cancel

- Add check for business partner in activity Check of Business Partner Function.

Trans Type: ZMAD
**11.10.6 Checking Text Fields**

In this customizing activity, you can add texts. Mark items for checks when a certain status is reached.

To add the checking of text fields activity, follow these steps:

1. **Start transaction SPRO.**
2. **Call SAP Reference IMG and navigate to SAP Solution Manager → Focused Build → Change Control Management Extensions → Status Dependent Check Framework**

3. **Choose the activity Check of Text Fields on next screen.**
Create an entry for each text and status you like to check.

- First enter transaction type, status profile and user status.
- Select your text type by using the column ID.
- The column Mandatory indicates whether the specified text needs a value when the status is reached.

Example

You use the Change Management Transaction ZMAD (copy of admin change). Check that the Test Instruction is entered when the status To Be Tested is set.

Add consistency check to ZMAD as described in chapter Consistency Checks for Change Transaction Types.

- Select transaction ZMAD
- Choose Assign Consistency Checks
- Add entry
  - User Status: E0004 (in development)
  - Sequence: 15 (or any other unused number)
  - Status Transition Consistency Check: /SALM/CONS_CHECK
11.11 Change Request Management Scorecard: Configuration

11.11.1 Use Case

The scorecard provides an aggregated overview on current process types in the context of change request management with a possible drill down into the respective list view, and into the details of each individual business transaction. For this purpose, the scorecard provides at least one top-level aggregation attribute (usually the process type) and several second-level aggregation attributes (such as priority, status).

The following mock-up demonstrates this:
11.11.2 Roles and Authorization

The scorecard is integrated in the business role /SALM/SM_SM_PRO. To use it, you need to have the following roles assigned:

- SAP_OST_SM_CRM_UIU_SM_PRO
- SAP_OST_FB_CRM_UIU_CM
- SAP_OST_FB_CRM_UIU

To configure the scorecard via transaction SPRO, the configuration user needs to have SAP_OST_FB_CM_ITSM_CONFIG.

11.11.3 Scorecard Customization

Please use the following SPRO entries to activate and customize scorecards in your system.

11.11.3.1 Activation of BAdI to Aggregate Data for Scorecard

Make sure the implementation /SALM/ITSM_SCCD_IDX of definition CRM_ORDER_INDEX_BADI is activated. Activate if necessary.
11.11.3.2 Configuration of Scorecards

The configuration of the scorecard is to be done in a central view cluster accessible via SPRO or SM34: /SALM/ITSMSC_VC

Changes in the customizing cluster must be recorded into a transport request.

See the following details of folders from the Dialog Structure pictured in the screenshot above.

**Define Groups:** Here you define the aggregation attributes that should form a group in the scorecard.

- **SC Group** = Group identifier
- **Title** = Description of the group
- **Component Name** = Field name of the BOL query result.
- **Table Name** = Name of the table or view containing the descriptions of the attribute values
- **Field Name** = Language field name of the text table
- **Field Name** = Description field name of the text table

The system delivers the following entries by default:

<table>
<thead>
<tr>
<th>SC-Group</th>
<th>Title</th>
<th>Component Name</th>
<th>Table Name</th>
<th>Field Name</th>
<th>Field Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRCTP</td>
<td>Process Types</td>
<td>PROCESS_TYPE</td>
<td>CRMC_PROC_TYPE_T</td>
<td>LANGU</td>
<td>P_DESCRIPTION</td>
</tr>
<tr>
<td>PRIOT</td>
<td>Priorities</td>
<td>PRIORITY</td>
<td>SCPRIOT</td>
<td>LANGU</td>
<td>TXT_LONG</td>
</tr>
<tr>
<td>RELSE</td>
<td>Release</td>
<td>/AICRM/PROJECT_ID</td>
<td>/SALM/ITSMSCVRLS</td>
<td>SPRAS</td>
<td>NAME1_TEXT</td>
</tr>
<tr>
<td>RESPO</td>
<td>Responsible Person</td>
<td>/AICRM/BP_NO_</td>
<td>BUT000</td>
<td>SPRAS</td>
<td>TXT30</td>
</tr>
<tr>
<td>STATU</td>
<td>Status</td>
<td>STATUS</td>
<td>/SALM/ITSMSCVSTT</td>
<td>SPRAS</td>
<td>TXT30</td>
</tr>
</tbody>
</table>
Note

Please note that the business partner field /AIC/BP_NO_ used for the responsible person group RESPO is a generic one. Based on further configuration, the field name ends with a 2-digit number varying from 01 to 10. (For example, /AIC/BP_NO_03)

Define Text Access Field Mapping: Here you define how the fields of the scorecard data. The system maps the data to the text table for each group to read the correct description for the field values.
Scorecard Group = Group identifier
Table Name = Name of the table or view containing the descriptions of the attribute values
Field Name = Key field of the text table
Field Name = Field of the scorecard data to be mapped to the key field

The system delivers the following entries by default:

<table>
<thead>
<tr>
<th>SC Group</th>
<th>Table Name</th>
<th>Field Name</th>
<th>Field Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRCTP</td>
<td>CRMC_PROC_TYPE_T</td>
<td>PROCESS_TYPE</td>
<td>PROCESS_TYPE</td>
</tr>
<tr>
<td>PRIOT</td>
<td>SCPRIOT</td>
<td>PRIORITY</td>
<td>PRIORITY</td>
</tr>
<tr>
<td>RELSE</td>
<td>/SALM/ITSMSCVRLS</td>
<td>SMI_PROJECT</td>
<td>/AICRM/PROJECT_ID</td>
</tr>
<tr>
<td>RESPO</td>
<td>BUT000</td>
<td>PARTNER</td>
<td>/AICRM/BP_NO_</td>
</tr>
<tr>
<td>STATU</td>
<td>/SALM/ITSMSCVSTT</td>
<td>ESTAT</td>
<td>STATUS</td>
</tr>
<tr>
<td>STATU</td>
<td>/SALM/ITSMSCVSTT</td>
<td>PROCESS_TYPE</td>
<td>PROCESS_TYPE</td>
</tr>
</tbody>
</table>

Define Usage Types: Here you define the usage types for the scorecard. As the scorecard can be displayed in the context of Change Request Management, Incident Management, and Requirements Management.
SC Usage = Scorecard usage identifier
Belongs To = Responsibility of business transactions presented to the user logged on (not in use anymore)
External Object Name = BOL Query object name used to select the business transactions (not in use anymore)
Bar Color = HTML Color code used for the scorecard bar (must start with #)
Number = max. number of search result hits (not in use anymore)

The system delivers the following entries by default:

<table>
<thead>
<tr>
<th>SC Usage</th>
<th>Belongs To</th>
<th>External Object Name</th>
<th>Bar Color</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHM</td>
<td></td>
<td>BTQAICSearch</td>
<td>#3E79CB</td>
<td>1000</td>
</tr>
</tbody>
</table>

Note

Please note that the scorecard usage identifier cannot be freely defined. It has to be one of the values defined by the class attribute /ALM/CL_SCORECARD_SERVICE=>GC_SC_USAGES. Currently, the allowed values are CHM and ITM.

Assign Transaction Types: Here you assign the transaction types for the scorecard for a dedicated usage.
Scorecard Usage = Scorecard usage identifier
Trans. Type = Business transaction type
Object Type = UI Object type that represents the transaction type
Sort Order = Numeric value to setup the sort order for display
Sequence = Numeric value between 01 and 10 defining the business partner field to be used

The system delivers the following entries by default:

<table>
<thead>
<tr>
<th>SC Usage</th>
<th>Trans. Type</th>
<th>Object Type</th>
<th>Sort Order</th>
<th>Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHM</td>
<td>SMAD</td>
<td>AIC_OB_CMCD</td>
<td>50</td>
<td>03</td>
</tr>
<tr>
<td>CHM</td>
<td>SMCG</td>
<td>AIC_OB_CMCD</td>
<td>40</td>
<td>05</td>
</tr>
<tr>
<td>CHM</td>
<td>SMCR</td>
<td>AIC_OB_CMCR</td>
<td>10</td>
<td>05</td>
</tr>
<tr>
<td>CHM</td>
<td>SMHF</td>
<td>AIC_OB_CMCD</td>
<td>20</td>
<td>05</td>
</tr>
<tr>
<td>CHM</td>
<td>SMMJ</td>
<td>AIC_OB_CMCD</td>
<td>30</td>
<td>05</td>
</tr>
</tbody>
</table>

Define Status to Be Considered: Here you configure which status values of each transaction type are relevant to be considered within the Scorecard.
Scorecard Usage = Scorecard usage identifier
Trans. Type = Business transaction type
UsrSt = User Status
Sort Order = Numeric value to setup the sort order for display

The system delivers the following entries by default:

<table>
<thead>
<tr>
<th>SC Usage</th>
<th>Trans. Type</th>
<th>UsrSt</th>
<th>Sort Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHM</td>
<td>SMAD</td>
<td>E0001</td>
<td>10</td>
</tr>
<tr>
<td>CHM</td>
<td>SMAD</td>
<td>E0002</td>
<td>20</td>
</tr>
<tr>
<td>CHM</td>
<td>SMCG</td>
<td>E0001</td>
<td>10</td>
</tr>
<tr>
<td>CHM</td>
<td>SMCG</td>
<td>E0003</td>
<td>20</td>
</tr>
<tr>
<td>CHM</td>
<td>SMCR</td>
<td>E0001</td>
<td>10</td>
</tr>
<tr>
<td>CHM</td>
<td>SMCR</td>
<td>E0004</td>
<td>40</td>
</tr>
<tr>
<td>CHM</td>
<td>SMCR</td>
<td>E0005</td>
<td>60</td>
</tr>
<tr>
<td>CHM</td>
<td>SMCR</td>
<td>E0011</td>
<td>45</td>
</tr>
<tr>
<td>CHM</td>
<td>SMCR</td>
<td>E0012</td>
<td>30</td>
</tr>
<tr>
<td>CHM</td>
<td>SMCR</td>
<td>E0014</td>
<td>20</td>
</tr>
<tr>
<td>CHM</td>
<td>SMCR</td>
<td>E0015</td>
<td>50</td>
</tr>
<tr>
<td>CHM</td>
<td>SMHF</td>
<td>E0001</td>
<td>10</td>
</tr>
</tbody>
</table>
Define Assign Groupings: Here you define which groups should be displayed at which level for each usage type.

Scorecard Usage = Scorecard usage identifier
Level = Level of the group (currently 1 or 2)
Counter = Number of the group entry
SC Group = Scorecard group identifier
Indicator = Flag to indicate that the group label/title is generic set from the attribute value of this group

The system delivers the following entries by default:

<table>
<thead>
<tr>
<th>SC Usage</th>
<th>Trans. Type</th>
<th>UsrSt</th>
<th>Sort Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHM SMMJ</td>
<td>E0001</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>CHM SMMJ</td>
<td>E0002</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>CHM SMMJ</td>
<td>E0004</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>CHM SMMJ</td>
<td>E0009</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>CHM SMMJ</td>
<td>E0011</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>CHM SMMJ</td>
<td>E0012</td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>CHM SMMJ</td>
<td>E0013</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>CHM SMMJ</td>
<td>E0014</td>
<td>60</td>
<td></td>
</tr>
</tbody>
</table>

Note
On level 1, only one group can be assigned.
11.11.4 Generating Scorecard data

Once the configuration has been completed, or whenever it has been changed, the initial scorecard data must be generated once.

First open the view cluster /SALM/ITSMSC_VC via SPRO or SM34. Within the step Define Usage Types the scorecard buffer should be refreshed:

![Refresh Scorecard Buffer](image)

**Note**

The Refresh ScoreCard Buffer option is only available in change mode.

Once done, the buffered data needs be rebuild using transaction SA38 and executing report CRM_INDEX_REBUILD.

The system automatically fills or updates the scorecard buffer each time a score card relevant business transaction is changed.

11.12 Release Batch Import: Configuration

11.12.1 Required Activities

Implement or verify the correct implementation of the central SAP Solution Manager note depending on the SP level of your SAP Solution Manager system.

11.12.2 Basic Configuration for SAP Solution Manager

Read the implementation guide for important documentation and initial descriptions before you start with the basic configuration of SAP Solution Manager.

- From transaction SPRO, navigate to SAP Solution Manager Implementation Guide ‡  SAP Solution Manager ‡  Basic Configuration ‡  Basic Configuration: Guided Procedure.
Start the initial configuration of the SAP Solution Manager system via transaction SOLMAN_SETUP.

- In the navigation area on the left, you can access the following guided procedures which contain configuration steps relevant for the Change Request Management scenario:
  - **System Preparation**: In this guided procedure, you make preliminary settings for SAP Solution Manager configuration, such as the creation of dialog users with the required authorizations, implementation of the central correction note, and web service configuration.
  - **Infrastructure Preparation**: In this scenario, you configure the infrastructure to run SAP Solution Manager.
  - **Basic Configuration**: This guided procedure leads you through all configuration steps, which you must perform to enable basic scenarios in SAP Solution Manager. As part of the basic configuration, you set up the connection to SAP, schedule relevant background jobs, and activate piece lists that contain important settings, such as standard customizing.
  - **Managed Systems Configuration**: Here, you connect managed systems to SAP Solution Manager via RFC. This is important, since Change Request Management requires a READ, TMW and TRUSTED RFC connection to every managed system/client. To ensure that Change Request Management works perfectly with managed systems, a minimum SP level is required. Please check SAP Note 907768 for further details.

**Caution**

Ensure that you have successfully performed the three configuration steps according to the guided procedure documentation. In addition to basic configuration for SAP Solution Manager, performing basic configuration for Change Request Management is also required.
11.12.3 Piece List Activation

The standard customizing of Change Request Management and all other IT service management-relevant areas is delivered via a customizing piece list. This piece list needs to be activated as part of transaction SOLMAN_SETUP and copies the standard customizing from Client 000 into the working client of SAP Solution Manager.

Activating the piece list overwrites all existing standard customizing with the content of the piece list. Therefore, we recommend copying all transaction types into the customer namespace before starting to use Change Request Management.

Note

The existing BC-sets of Change Request Management are not supposed to be activated within a 7.2 system, since they are replaced by the customizing piece list.

11.12.4 Prerequisites

Before you start to configure Change Request Management, follow implementation instructions according to the latest version of the master note (for your SPS level) for Change Request Management. Configuring Change Request Management is prerequisite for using release batch import.

11.12.5 Implementation of Required SAP Notes

Before configuring release batch import, review the master note’s latest version (considering your SP level) for Change Request Management. Implement the note before moving on with configuration.

Also, implement the following SAP Notes. Allow enough time for the SAP Note implementation since manual activities also need to be performed.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
<th>SAP Solution Manager</th>
<th>Managed System</th>
</tr>
</thead>
<tbody>
<tr>
<td>2788210</td>
<td>Focused Build - Release/Batch Import: Support run selection based on task list</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>SAP Note</td>
<td>Description</td>
<td>SAP Solution Manager</td>
<td>Managed System</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>2774831</td>
<td>Focused Build - Release/Batch Import: cleanup of logs</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2782017</td>
<td>Focused Build - Release/Batch Import: Status of documents not updated, as transport status cannot be retrieved</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2738750</td>
<td>Focused Build - Release/Batch Import: Improvements for the test mode</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2750241</td>
<td>Focused Build - Release/Batch Import: The run has very long duration</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2774513</td>
<td>Focused Build - Release/Batch Import: Test mode not executed if productive system is detected</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2665730</td>
<td>Focused Build - Release/Batch Import: The import into the target system is not triggered</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2598110</td>
<td>Focused Build - Release/Batch Import: Extended checks for documents with transport request which have different target systems</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>1818804</td>
<td>Enable client restriction for import subsets in Change Request Management must be implemented on SAP Solution Manager and on all managed systems</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>1731806</td>
<td>ChaRM: Support multi-client import must be implemented on SAP Solution Manager and all managed systems</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>1741751</td>
<td>ChaRM: New remote infrastructure without domain link is required on managed systems</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>1384598</td>
<td>Harmonizing RFC communication infrastructure in ChaRM/QGM</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

⚠️ Caution

Be sure to review the manual activities carefully and stick to the sequence above.

11.12.6 Configuring Status-Dependent Imports

As a prerequisite for using the release batch import, configure the status-dependent import in Change Request Management.

To configure the status-dependent import, follow these steps:
1. Start transaction SPRO.
2. Select SAP Reference IMG.
3. Navigate to the following IMG path: SAP Solution Manager ‡ Capabilities ‡ Change Control Management ‡ Transport Management System ‡ Specify Transport Request Import Strategy
4. Select your import strategy (status-dependent import) for a combination of Landscape, Branch, Cycle Type, System Name, Client, and System Role.

5. Define the detailed settings for the status-dependent import.

### 11.12.6.1 Transaction Types for Status-Dependent Imports

The following tables show an example for the standard transaction types in terms of valid CRM user statuses for status-dependent import.

**Note**

Additional customer-specific CRM user statuses and transaction types (such as ZMSG) must be mapped accordingly.

<table>
<thead>
<tr>
<th>Test System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction</td>
</tr>
<tr>
<td>ZMTM</td>
</tr>
<tr>
<td>ZMTM</td>
</tr>
<tr>
<td>ZMMJ</td>
</tr>
<tr>
<td>ZMMJ</td>
</tr>
<tr>
<td>ZMMJ</td>
</tr>
<tr>
<td>ZMMJ</td>
</tr>
<tr>
<td>ZMMJ</td>
</tr>
</tbody>
</table>
### Production System

<table>
<thead>
<tr>
<th>Transaction</th>
<th>Type Status</th>
<th>Profile Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZMTM</td>
<td>ZMTMHEAD</td>
<td>E0009</td>
</tr>
<tr>
<td>ZMMJ</td>
<td>ZMMJHEAD</td>
<td>E0006</td>
</tr>
<tr>
<td>ZMMJ</td>
<td>ZMMJHEAD</td>
<td>E0009</td>
</tr>
<tr>
<td>ZMMJ</td>
<td>ZMMJHEAD</td>
<td>E0014</td>
</tr>
<tr>
<td>ZMHF</td>
<td>ZMHFHEAD</td>
<td>E0006</td>
</tr>
<tr>
<td>ZMHF</td>
<td>ZMHFHEAD</td>
<td>E0007</td>
</tr>
<tr>
<td>ZMHF</td>
<td>ZMHFHEAD</td>
<td>E0008</td>
</tr>
<tr>
<td>ZMHF</td>
<td>ZMHFHEAD</td>
<td>E0009</td>
</tr>
</tbody>
</table>

**Note**

For more information, see hints regarding Status Dependent Import Control [SCN blog](http://scn.sap.com/community/it-management/alm/solution-manager/blog/2014/09/08/some-hints-to-status-dependant-import-control)

In the customizing of SAP Solution Manager, choose SAP Solution Manager › Focused Build › Release Batch Import › Configure Release Deployment and Batch Import.

### 11.12.6.2 Creating an Import Variant for QAS

To create an import variant for QAS, follow these steps:

1. Start transaction SPRO.
2. Choose the option SAP Reference IMG.
3. Navigate to the following IMG Path: SAP Solution Manager ‒ Focused Build ‒ Configure Release Deployment and Batch Import.

4. Create new batch import variant `/OST/QAS` for the import to the quality assurance systems.

5. Set your import variant to Active.

6. Activate Weekday Specifications and save your entries.

7. Fill in the validity of the import variant:
   - **Date & Time Validity:**
     - **Weekday Specifications:**
8. Define the import strategy for your newly-created import variant /OST/QAS.
   - Select the import variant.
   - Select the navigation tree’s Import Configuration and choose New Entries, as highlighted in the screenshot below.

9. Fill in the name for your import configuration and save your entries:

10. (Optional) Activate Phase Chk (phase check).
    - Activate check box if you would like to establish a phase check for the import to the QAS system.

11. (Optional) Activate Phase Chk (phase check) or Continue.
    - Activate check box if further transport requests should be imported when the import of certain transports fails due to DGP or technical issues.

12. Define Import Customizing: Status. Define for which transactions types (ZMHF, ZMMJ, ZMTM) in which CRM user status this should be valid:

Example: Please use the CRM user status values of the standard transaction types copied to the customer namespace.
Caution

Best practice is to always also put status values that are higher than the one where you want to perform the import to avoid potential blocking.

If the customer has adapted Change Request Management standard workflow, adapt the CRM user status values accordingly.

   - Create a new entry by selecting New Entries.
     - Select the following checkboxes:
       - Active
       - Ignore Comp. Version
Valid phases for the import of a project to certain system:

14. (Optional) Maintain the import sequence of systems if required (such as ERP and BW transports). This configuration step is optional for the import to the quality assurance system.
   - Enter system and client.
   - Under Imp. Seq. (import sequence), enter 1 or 2. In case of a sequential import, for instance for SAP ERP and SAP BW, you need two entries, one with Sequence 1 for SAP ERP, and one with Sequence 2 for SAP BW.

15. Finally, maintain landscape data relevant for the selected import strategy/import configuration to be executed.
Set the status-dependent import control active for:

- Import Config. = `/OST/IMPORT_QAS`
- Solution ID = Enter your solution ID; you can also use a wildcard
- Cycle Type = Possible Values: Major Release, Minor Release, Emergency Release, Continual Cycle, Phased Cycle, QGM Change Cycle, or All Types of Change Cycles
- System = Enter the relevant system(s)

Maintain the system client settings.

Set the status dependent import control active for:

- Client = Enter the relevant client for import to QAS
- System Role ID = T (for quality assurance system)
- Communication Client = You should enter the relevant client for import to QAS
- RFC Type = Select Trusted RFC as RFC Type,

If you have more than one QAS client, you can enter this information here.

### 11.12.6.3 Best Practice Settings

Maintain LMDB-Only Clients: If you have clients only existing in LMDB and not in the task list, but these clients are to be supplied as well, you can maintain these clients here.
Create Import Variant for Pre-Production System

Start transaction SPRO, then choose SAP Reference IMG and use the following IMG Path: SAP Solution Manager -> Focused Build -> Configure Release Deployment and Batch Import

Create the new batch import variant `/OST/PRE_PROD` for the import to the pre-production system(s):

Set your import variant to Active and activate Weekday Specifications as well. Save your entries.

Fill in the validity of the import variant:

- Date & Time Validity:

- Weekday Specifications:
As a next step, the import strategy for your newly-created import variant /OST/PRE_PROD must be defined. Select the import variant, select the navigation tree’s Import Strategies and press the button New Entries:

Fill in the name for your import configuration and save your entries:

Please decide whether you want to activate the phase check and continue.

- Phase Check = Activate the check box, if you would like to establish a phase check for the import to the QAS system (optional)
- Continue = Activate the check box, if further transport requests should be imported, if the import of certain transports fails due to DGP or technical issues (optional).

Next, define which transactions types in which status this should be valid:

**Import Customizing: Status**

Example: Please use the CRM user status values of the standard transaction types copied to the customer namespace.
Caution

Best practice is to always also put status values that are higher than the one where you want to perform the import to avoid potential blocking.

If the customer has adapted Change Request Management standard workflow, adapt the CRM user status values accordingly.

As a next step, define Import: Parameters. First, create a new entry:

Select Import Config and fill the following checkboxes:

- Active
- Ignore Comp. Version
Valid phases for import:

This configuration step is optional for the import to the pre-production system(s).

Optional: Maintain the import sequence of systems, if required (for example, with ERP and BW transports).

- Import Sequence:
  - Enter system and client
  - In case of a sequential import, for instance for SAP ERP and SAP BW, you need two entries, one with Sequence 1 for SAP ERP, and one with sequence 2 for SAP BW (Screenshot is only an example).

Maintain Landscape Data

Maintain the relevant landscape data for which the selected import strategy/import config. is used.
Set the status dependent import control active for:

- Import Config. = `/OST/IMPORT_PRE_PROD`
- Solution ID = Enter your solution ID; you can also use a wildcard
- Cycle Type = All types of changes (Possible Values: Major Release, Minor Release, Emergency Release, Continual Cycle, Phased Cycle, QGM Change Cycle, All Types of Change Cycles)
- System = Enter the relevant system(s)

Maintain System Clients

Set the status-dependent import control active for:

- Client = Enter the relevant client for import to the pre-production system(s)
- System Role ID = 2 (for pre-production system)
- Communication Client = Enter the relevant client for import to pre-production system(s)
- RFC Type = Select Trusted RFC as RFC type,

Note: The system role can vary, since it can be defined by the customer.

Maintain LMDB-only clients

If you have clients present in LMDB and not in the task list, you can maintain those clients here.
Create Import Variant for PRD

Start transaction `SPRO`, then choose SAP Reference IMG and use the following IMG Path: SAP Solution Manager -> Focused Build -> Configure Release Deployment and Batch Import

Create the new batch import variant `/OST/PROD` for the import to the production system(s):

Set your import variant to `Active` and activate `Weekdays Specifications` as well.
Fill in the validity of the import variant:

- **Date & Time Validity**

![New Entries: Overview of Added Entries](image1)

- **Weekday Specifications**

![New Entries: Overview of Added Entries](image2)

As a next step, the import strategy for your newly-created import variant `/OST/PROD` must be defined. Select the import variant, choose the navigation tree’s **Import Strategies** and choose **New Entries**:
Set the status dependent import control active for:

- Import Config. = `/OST/IMPORT_PRODUCTION`
- Import Strategy = Import via status of certain elements is used.
- Phase Check = Activate the checkbox, if you would like to establish a phase check for import to the Production System (highly recommended)
- Continue = Activate checkbox, if further transport requests should be imported, if the import of certain transports fails due to DGP or technical issues (optional).

Now define for which transactions types and in which status this should be valid:

**Import Customizing: Status**

Example: Please use the CRM user status values of the standard transaction types copied to the customer namespace.

![New Entries: Overview of Added Entries](image)

⚠️ **Caution**

Best practice is to always also put status values that are higher than the one where you want to perform the import to avoid potential blocking.

If the customer has adapted Change Request Management standard workflow for urgent change, adapt the CRM user status values accordingly.

As a next step, define the **Import: Parameters**. First, create a new entry:

![Change View "Import: Parameters": Overview](image)
Fill the following checkboxes:

- Active?
- Ignore Comp. Version

Valid Phases:

For the import to the production system(s) it is highly recommended to establish a phase check. To do so, two-step customizing is required:

- We have already activated the checkbox Phase Chk on the level of the import strategies.
- In the following customizing step, define the details of the phase check to take place. For instance, if you use the Release Management, the phase check will verify whether the release cycle document (SMRE) is in CRM User Status “E0006” (deploy). If this is not the case, the program /SALM/BATCH_IMPORT_TRIGGER will not perform any imports to the production system(s):

  If you use a phase cycle, the following customizing entry is required:
  
  Trans. Type: SMIM StatProf: SMIMHEAD UsrSt: E0006

  Optional: You can maintain the import sequence of systems if required (for example, ERP and BW transports).
• Import sequence:
  o Enter system and client
  o In case of a sequential import, for instance for SAP ERP and SAP BW, you need two entries, one with Sequence 1 for SAP ERP, and one with Sequence 2 for SAP BW (screenshot above is an example).

Maintain Landscape Data

Finally, enter the relevant landscape data for which the selected import strategy is used:

Set the status dependent import control active for:

• Import Config. = /OST/IMPORT_PROD
• Solution ID = Enter your solution ID. You can also use a wildcard
• Cycle Type = All types of changes (Possible Values: Major Release, Minor Release, Emergency Release, Continual Cycle, Phased Cycle, QGM Change Cycle or All Types of Change Cycles)
• System = Enter the relevant System(s)
• Non-ABAP

Caution

Wildcard (*) is valid for Solution ID and Client. The system field must be specified with a value and no wildcard.

Maintain System Clients:
Set the status dependent import control active for:

- **Client** = Enter relevant client for productive import
- **System Role ID** = P (for production system)
- **Communication Client** = Enter relevant client for productive import
- **RFC Type** = Select **Trusted RFC** as RFC type,

⚠️ **Caution**

Wildcard (*) is valid for **Solution ID** and **Client**. The system field must be specified with a value and no wildcard.

Maintain LMDB-only clients:

If you have clients present in LMDB and not in the task list, you can maintain those clients here.

If you would like to use the TMW RFC connection instead of TRUSTED RFC, please check for RFC user.
Additional authorization is required for communication (such as a reading buffer). The User behind the RFC which is used to the managed system (TMW RFC for communication client) needs to have authorization for function group TMW_PROJECT_LOCK on the managed system for authorization object S_RFC. Fallback is Client 000.
First, the TMW RFC user needs to have import authorization. New authorization object SM_CM_TASK must be configured for this user, if imports are triggered from an SAP Solution Manager 7.2 system.

Special Setup for TMW

If you would like to use the TMW RFC connection instead of TRUSTED RFC, check for the following RFC users:

- SAP_SOLMAN_READ
- SAP_SOLMAN_TMW
  (Relevant for systems until SAP_BASIS 7.01, according to SAP Note 2257213)
- SAP_SOLMAN_READ_702
- SAP_SOLMAN_TMW_702
  (Relevant for systems as of SAP_BASIS 7.02, according to SAP Note 2257213)

11.12.7 Starting Import Based on Import Variant

To start an import based on an import variant, follow these steps:

1. Start transaction SE38.
2. Enter program /SALM/BATCH_IMPORT_TRIGGER.
3. Choose import variant: /OST/QAS.
Note

The program `/SALM/BATCH_IMPORT_TRIGGER` is used to trigger imports for all relevant system roles (QAS, pre-production, and production system).

For pre-production and production systems, the import should be controlled by the IT operator, rather than scheduled automatically by the system.

11.12.7.1 Program `/SALM/BATCH_IMPORT_TRIGGER` - General and Import Variant Options

See the following general options for `/SALM/BATCH_IMPORT_TRIGGER`:

- **Release to Import**: Choose the cycle type which should be imported based on the entered import variant.
  - You can also enter multiple releases or use a wildcard (`*`).
  - If you would like to import several releases (or cycles) please refer to chapter Maintaining AGS_WORK_CUSTOM and look for parameter `/SALM/BI_MULTIPLE_RELEASES`.

- **Tasklist for Import**: Possibility to use the task list as selection criteria. This option is meant to be used when using the Release Batch Import as standalone function. When importing for a phased cycle you would need to schedule single jobs each and every time a new cycle is created after deploying to production. With the option “Tasklist for Import” you can avoid this effort and simply schedule one job for the common tasklist all those cycles share.

- **Import into Production Systems**: Here you can decide if the import would be performed into a production system.
The import variants are defined via the customizing for release batch Import. They define which systems should be considered for import. Import variants also provide restrictions which must be fulfilled, (such as system roles or CRM user status of change documents).

See the following import variant options for /SALM/BATCH_IMPORT_TRIGGER:

- **Allows Transports of Task List without Change assigned**: Transports not assigned to a change document are imported.
- **Test Mode (No Import)**: The system performs all checks but does not trigger an import.
- **Process only Test Transports**: Only Transports of Copies (ToC) are imported. During the transport selection all non-ToCs are removed from the selection.

11.12.7.2 Program /SALM/BATCH_IMPORT_TRIGGER - Scheduling Options

The following import scheduling options can be made for /SALM/BATCH_IMPORT_TRIGGER:

- **Enable automatic rescheduling**: After the program is finished, it schedules itself to run again as a job.
- **Minutes until auto restart**: If automatic rescheduling is enabled, this defines the number of minutes until the program runs again.
  - Enabled active automatic rescheduling will be active permanently, so the job must be removed manually to stop the rescheduling.
- **Name of job**: Here you can give the import job a meaningful name so that you can find the right job faster.
  - All jobs start with "BATCHIMP_".
11.12.7.3 Program /SALM/BATCH_IMPORT_TRIGGER - Check Options for Downgrade Protection

See the following check options for downgrade protection for /SALM/BATCH_IMPORT_TRIGGER:

- **Downgrade Protection on**: Performs check on possible downgrades. Found downgrades are logged.

- **Legacy DGP Check**: Use this option if you want to make use of the former DGP calculation from Release Batch Import not triggering the overall Transport Related Check Framework. It’s required to choose this option if you have selected to import more than one release at once or have chosen the wildcard "*" from the “Release to Import” selection.

- **Skip downgrade Transports**: If this option is enabled, transports, which are affected from downgrades, are removed from the selection before the import is triggered.
  - If this option is disabled and if transports from the selection are affected from a downgrade, no import is triggered.

  **Note**

  On productive systems: If a downgrade has been found in the transport selection, skipping is not allowed. No import triggered as a result.

11.12.7.4 Program /SALM/BATCH_IMPORT_TRIGGER - Relational Checks

The check options for relational checks are only valid when a customer has implemented Focused Build Requirements-to Deploy.

- They are not applicable when using the Focused Build standalone enhancement Release Batch Import.
11.12.7.5 Release Batch Import Log

For each run of the program /SALM/BATCH_IMPORT_TRIGGER, an application log is being created.

Access the application log via transaction SLG1:

Object: /SALM/
Sub-Object: /SALM/BATCH_DEPLOY

<table>
<thead>
<tr>
<th>Check</th>
<th>Mandatory or Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buffer Check</td>
<td>Mandatory - no</td>
<td>Checks that a selected transport exists in the import buffer.</td>
</tr>
<tr>
<td></td>
<td>customizing necessary</td>
<td></td>
</tr>
<tr>
<td>System Role Check</td>
<td>Mandatory - customizing</td>
<td>(Variant)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Compares the actual system role with the one defined by the Customizing.</td>
</tr>
</tbody>
</table>

11.12.8 Transport Checks

Every transport request must pass multiple transport checks before it is imported into a managed system. Some checks are mandatory. Others can be enabled optionally.
### Focused Build for SAP Solution Manager 7.2

#### Configuration: Standalone Extensions

<table>
<thead>
<tr>
<th>Check</th>
<th>Mandatory or Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Document Relation</td>
<td>Optional - only with full Focused Build</td>
<td>Imports a transport with a task list relation, but not a change document relation.</td>
</tr>
<tr>
<td>Change Cycle Status</td>
<td>Optional - customizing (Variant: Phase dependency)</td>
<td>Checks whether the status of the change cycle allows an import.</td>
</tr>
<tr>
<td>Change Document Status</td>
<td>Mandatory - customizing (Variant)</td>
<td>Checks whether the status of the related change document allows an import.</td>
</tr>
<tr>
<td>Downgrade Protection</td>
<td>Optional</td>
<td>Checks for existing downgrade conflicts.</td>
</tr>
<tr>
<td>Relational Check - Work Item Relations</td>
<td>Optional - only with full Focused Build</td>
<td>If relations between change documents exist, this check checks that all transports are either already imported or part of the import set.</td>
</tr>
<tr>
<td>Relational Check - Full Work Package import</td>
<td>Optional - only with full Focused Build</td>
<td>Checks whether transports of all work packages and work items are either already imported or part of the import set. This check can be extended by relations between work packages.</td>
</tr>
<tr>
<td>Relational Check - Master Work Package</td>
<td>Optional - only with full Focused Build</td>
<td>Checks whether the related master work package has a certain status.</td>
</tr>
</tbody>
</table>

### 11.12.9 BAdI Implementations

Batch import uses two BAdIs that can extend the functionality of the program:

- `/SALM/BATCH_IMPORT`: BAdI for extending the performed transport checks or import options and adding further transports.
- `/SALM/BATCH_IMPORT_POST_IMP`: BAdI for executing user-defined post-import tasks.

### 11.13 Template Protection: Configuration

#### 11.13.1 Basic Configuration for SAP Solution Manager

Read the implementation guide for important documentation and initial descriptions before you start with the basic configuration of SAP Solution Manager.

- From transaction SPRO, navigate to [SAP Solution Manager Implementation Guide](https://launchpad.sap.com/).
Via the transaction SOLMAN_SETUP, start the initial configuration of the SAP Solution Manager system. In the navigation area on the left, you can access the following guided procedures that contain configuration steps relevant for the Change Request Management scenario:

- **System Preparation**: In this guided procedure, you make preliminary settings for SAP Solution Manager configuration, such as the creation of dialog users with the required authorizations, implementation of the central correction note, and web service configuration.
- **Basic Configuration**: This guided procedure leads you through all configuration steps, which you must perform to enable basic scenarios in SAP Solution Manager. As part of the basic configuration, you set up the connection to SAP, schedule relevant background jobs and activate piece lists which contain important settings, such as standard customizing.
- **Managed System Configuration**: In the managed system configuration, you connect managed systems to SAP Solution Manager via RFC. This is important, since Change Request Management requires a READ, TMW and TRUSTED RFC connection to every managed system/client. To ensure that Change Request Management works perfectly with managed systems, a minimum SP level is required. For further details, check SAP Note 907768.

Confirm that you have successfully performed those three configuration steps according to the guided procedure documentation.

In addition to the basic configuration for SAP Solution Manager, perform the basic configuration for Change Request Management.

### 11.13.2 Prerequisite for Template Protection

Before you start to configure Change Request Management, follow implementation instructions according the latest version of the master note (for your SP level) for Change Request Management. Configuring Change Request Management is prerequisite for using template protection.

⚠️ **Caution**

Please also make sure that the transport related check framework has been activated for the involved development systems. Within transaction CM_ADM_COCKPIT it must be set to on (Legacy CSOL is not supported).
11.13.3 Activating Template Protection Check

To activate the template protection in your system, a BAdI implementation for the transport generic check Framework (/TMWFLOW/TRANS_DEFINED_CHECK) has to be created. Within this implementation, the template protection checks are activated at the different actions of a transport request. You can include your own checks as well.

To create a BAdI implementation in order to activate template protection, follow these steps:

2. Create an implementation via Enhancement Implementation ➔ Create.
3. Define a name and description.
4. (Optional) Assign this implementation to a composite enhancement implementation.
5. Define a BAdI implementation.
6. Define the implementation class.
7. Select the BAdI definition: /TMWFLOW/TRANS_DEFINED_CHECK.
11.13.4   Activating Check at Save of Objects

The following implementation activates the check at the time of saving objects. When you maintain objects and save the changes to the transport request, the template protection checks are executed in parallel to the cross-system object locks checks.

To activate the checks, follow these steps:

1. Create a BAdI implementation and use a double click to implement method: `/TMWFLOW/IP_TRANSCUSTOM_CHK~CHECK_BEFORE_SAVE_TRANS_REQ`

2. Confirm the action in the dialog box.

3. Implement the following code in addition to your own code:

```
METHOD /tmwflow/if_trans_custom_chk~check_before_save_trans_req.

*Template Protection Checks
/salm/cl_tpp_generic_chk=>check_before_save_trans_req( EXPORTING
```
iv_transport_request  = iv_transport_request
iv_src_sys_tms_sid    = iv_src_sys_tms_sid
iv_src_sys_client     = iv_src_sys_client
iv_src_sys_tms_domain = iv_src_sys_tms_domain
it_locks_4_object     = it_locks_4_object
it_locks_4_table_key  = it_locks_4_table_key
IMPORTING
et_check_result       = et_check_result
et_error_message      = et_error_message )
ENDMETHOD.

4. Save and activate the method.

11.13.5 Activating Check at Release of Transport Requests

The following implementation activates the check at the time of releasing transport requests. When a transport request is being released within Change Request Management, Quality Gate Management, or directly via the task list, template protection checks are executed in addition to downgrade protection checks.

To activate the checks, follow these steps:

1. Create a BAdI implementation and use a double click to implement method:
   /TMWFLOW/IF_TRANS_CUSTOM_CHK~CHECK_BEFORE_RELEASE.

2. Confirm the action in the dialog box.

3. Implement the following code in addition to your own code:
   METHOD /tmwflow/if_trans_custom_chk~check_before_release.
   /salm/cl_tpp_generic_chk=>check_before_release(
   EXPORTING
   it_transport_request  = it_transport_request
   iv_tasklist_id        = iv_tasklist_id
   )
   ENDMETHOD.
iv_cycle_guid = iv_cycle_guid
iv_change_guid = iv_change_guid
iv_immediate = iv_immediate
iv_check_4_creating_toc = iv_check_4_creating_toc
IMPORTING
et_check_result = et_check_result
et_error_message = et_error_message).

ENDMETHOD.

4. Save and activate the method.

11.13.6 Configuration Parameters for Template Protection

Parameters in Maintenance View

With transaction SM34, you can open the maintenance view cluster /SALM/TPP_VCUST. This gives you access to central configuration parameters.

Customizing

Within the Customizing view you can maintain the central handling of template protection. The following list shows you all parameters available.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISABLED</td>
<td>Disable the Template Protection Globally</td>
<td>✗ Activated</td>
</tr>
<tr>
<td></td>
<td></td>
<td>✗ Deactivated</td>
</tr>
<tr>
<td>DCNF_INACT</td>
<td>Display of existing conflicts is inactive</td>
<td>✗ Activated</td>
</tr>
<tr>
<td></td>
<td></td>
<td>✗ Deactivated</td>
</tr>
<tr>
<td>LIVE_INACT</td>
<td>Live Locking is inactive</td>
<td>✗ Activated</td>
</tr>
<tr>
<td></td>
<td></td>
<td>✗ Deactivated</td>
</tr>
</tbody>
</table>

Conflict Handling

Within the Conflict Handling you can maintain, how conflicts shall be treated on the level of global systems.

- In the field **Global System**, define the system for which the locks have been maintained. The desired setting is inherited to all assigned local systems. To define a system, you can define the system ID and client separated by a colon (:) You can also use wildcards (*) both for system ID and for client.
• In the field **Event**, define the related template protection check. **ONSAVE** means the time when saving objects to a transport request, whereas **ONRELEASE** means the time when releasing transport requests.

• In the field **Handling**, define whether a warning message (**W**) or an error message (**E**) should be shown. Depending on the type of message, the process may be cancelled, so that the object cannot be saved or the transport request cannot be released.

### 11.13.7 Add Fiori Tiles to Personalization

Template Protection offers various Fiori tiles, which you can add to your launchpad via personalization. As a prerequisite, the authorization role `SAP_OST_FB_TPP` or equivalent must be assigned to your user.

Please use the tiles of the catalog **Focused Build - Template Protection**.

![Focused Build - Template Protection](image)

### 11.14 Cross-landscape Distribution: Configuration

#### 11.14.1 Overview

**Use Cases**

The Cross-landscape distribution is used to distribute transports from one landscape to other landscapes. There can be several use cases where this function might be helpful.

- **Cross-landscape Functional Developments**
  
  You develop a custom development package in one landscape and want to distribute the same functionality to other landscapes: For example, functions for **User Maintenance** or **Basis Reports** that should be available in all landscapes.

- **Global Functional Development**
  
  You have different landscapes that depend on each other, but don't have a direct transport connection due to their fundamental differences. You still want to distribute changes from one global development landscape to other local landscapes.
Process
Depending on the selected execution mode the target will be selected by the user via a guided procedure or calculated automatically in respect to the current customizing.

After the target is specified the following 4 steps are executed automatically for each target system;

1. Create a Transport of Copies (ToC) from each source transport
2. Release the ToC in the source system and add it to the import queue of the target system
3. Import the ToC into the target system
4. Include the object list of the ToC into the target transport of the same type as the source transport

Caution
If these steps could not be performed manually for a source/target combination, the distribution will also fail.

Distribution Modes
The Cross-landscape distribution function can be executed in two different modes:

• Strict Mode
  In strict mode you define a list of workbench objects, development packages and customizing tables, which should be distributed. These object list can be defined as include or exclude list.

  You can also define which source systems deliver to which target systems.

• Non-Strict Mode
  In Non-Strict mode the Cross-Landscape Distributions allows you to distribute any change to any landscape, that is configured on Solution Manager. This mode provides a lot of flexibility to distribute changes across different landscapes.

  This mode also provides a high risk that users distribute changes across landscapes that should not be distributed. It is your responsibility to ensure that only user with the knowledge what should be distributed are allowed to execute the XLD Wizard.

The strict mode is set via parameter in the General Customizing Settings. It is possible to deactivate the strict mode for single source systems in the System Specific Settings of Configure Filter and Distribution Groups.

Caution
The XLD function does not do any checks regarding if the distributed objects are changed in the target system or not. It always imports the version from the source dev system into the target dev system.

It is the user's responsibility to check for conflicts between the two landscapes before allowing distribution. The general rule should be that objects that are changeable in a source system should never be changeable in any of the target systems.

Execution Modes
There are two different execution modes for Cross-Landscape distribution:

• Wizard-Based
  If you call Cross Landscape Distribution in the Transport Management assignment block of your source change document, a guided procedure is displayed which guides you through the steps to select a target for your distributions.
The source and the target change document may have transports for one or more development systems, but this is restricted to the Strict Mode only. When using Non-Strict Mode only one development system is allowed per change document.

The distribution is also possible into an open transport requests directly without change document. It is also possible to pre-select one of these options. By setting the parameter ACTIVITY in General Customizing Settings it is not necessary to select the target type for each distribution. The wizard is shorter and will provide only the selected option, which is either Change Document Management or Transport Management.

Automated Distribution

The Automated Distribution can be called in the Transport Management assignment block. It can also be configured to be executed when a specific status is set for the source change document.

When executed, the Automated Cross Landscape Distribution will be processed all possible distributions for the current change document will be executed at once. There is no interaction with user like selecting the targets. As the customizing is used to calculate the possible targets, the Strict mode is required for this execution mode.

The target could be either same change document or another change document.

- Same Change Document:
  The target transports will be created automatically in the current change document. If there are still open target transports from a previous distribution left, they will be reused.

- Other Change Document
  A new change document of the same transaction type will be created and assigned to the same Request for Change as the source change document. This target change document will be set into an allowed target status and transport requests will be created.

  In case the change document, used in the last distribution, can be re-used (has an allowed target status), the system will not create a new document.

For both options all target systems need to be in the same change cycle as their source systems.
11.14.2 Roles and Authorizations

The Cross-Landscape Distribution uses the RFC infrastructure of SAP Solution Manager. It requires TMW RFCs to each development system that you want to distribute to.

In each of those systems, the TMW RFC user requires these additional authorizations:

<table>
<thead>
<tr>
<th>Authorization Object</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_RFC</td>
<td>ACTVT</td>
<td>16</td>
</tr>
<tr>
<td>RFC_NAME</td>
<td>/SALM/CM_XLD_CHECK_OBJECTS</td>
<td></td>
</tr>
<tr>
<td>RFC_NAME</td>
<td>/SALM/CM_XLD_CHECK_TRANSPORT</td>
<td></td>
</tr>
<tr>
<td>RFC_NAME</td>
<td>/SALM/CM_XLD_GET_LOCK_KEYS</td>
<td></td>
</tr>
<tr>
<td>RFC_NAME</td>
<td>/SALM/CM_XLD_GET_TADIRS</td>
<td></td>
</tr>
<tr>
<td>RFC_NAME</td>
<td>/SALM/CM_XLD_MERGE_REQUESTS</td>
<td></td>
</tr>
<tr>
<td>RFC_NAME</td>
<td>/SALM/CM_XLD_TRANSMIT_QUEUE</td>
<td></td>
</tr>
<tr>
<td>RFC_TYPE</td>
<td>FUNC</td>
<td></td>
</tr>
<tr>
<td>S_CTS_ADMI</td>
<td>CTS_ADMFCT</td>
<td>EPS1</td>
</tr>
</tbody>
</table>

⚠️ Caution

These authorizations are not added via solman_setup or lmdb when you create the RFCs.

In SAP Solution Manager, there is a specific authorization required to execute the Cross-Landscape Distribution. The role SAP_OST_CM_TRANSPORT_M needs to be assigned to each user with permissions to execute the Cross-Landscape Distribution.

11.14.3 Prerequisites

11.14.3.1 Package Distribution for Managed System

To get the Cross-Landscape Distribution working correctly you need to export the development package /SALM/CHARM_XLD_MS to each development system that is involved in the distribution. For this, a manual Cross-Landscape distribution is required.

To perform a manual Cross-Landscape distribution, follow these steps:

1. Export the package /SALM/CHARM_XLD_MS and all its content from SAP Solution Manager into a transport or ToC.
2. Import the transport into all development systems where you want to allow distribution.

11.14.3.2 Prerequisite for TMS RFC Free Setup

To be able to distribute with XLD transports between any two developments systems, as a prerequisite these development systems need to have a by default domain link between each other.

If you don’t want to create domain links between every development system due to a very huge landscape, there is also an option do this without domain links.

As an example, consider if you have two development systems, TDV and TQA, and you want to setup a distribution from TDV to TQA. You need to create on the domain controller for TDV an external system instance with the system ID TQA (Tx: STMS → system overview). On the domain controller for TQA, you need to create an external systems instance with system ID TDV. Both external systems need to share the same transport directory.

11.14.3.3 Prerequisites for Automated Distribution

Automated cross-landscape distribution provides a way to distribute objects and customizing to several systems at the same time. Since all targets are predefined in the customizing, the user does not need to select them.

Using one of the delivered implementations the change cycle to which the change documents (source and target) are assigned, to needs to know all possible target systems. This behavior can be overwritten by creating your own BAdi implementation.
11.14.4 General Customizing Settings

This section describes the customizing, you can set to activate / deactivate features of Cross Landscape Distribution.

To open the general settings, follow these steps:

1. Start transaction SPRO.
2. Under SAP Reference IMG, navigate to SAP Solution Manager -> Focused Build -> Change Control Management Extensions -> Cross Landscape Distribution -> General Settings
11.14.4.1 Basic Settings

Here you can set some basic customizing flags. Create new entries for each parameter, you need for your current scenario. Unless stated otherwise, you set its value to 'X' to activate an option.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STANDARD_XLD</td>
<td>Activates the wizard-based cross-landscape distribution</td>
</tr>
<tr>
<td>AUTO_XLD</td>
<td>Activates the automated cross-landscape distribution</td>
</tr>
<tr>
<td>XLD_STRICT</td>
<td>Activate the strict mode for XLD globally. In strict mode, only objects that are defined in the master data settings can be distributed. It also allows to configure a consistency change that validates of all those objects are correctly distributed.</td>
</tr>
<tr>
<td>ACTIVITY</td>
<td>• This parameter is used for the wizard based Cross Landscape Distribution.</td>
</tr>
<tr>
<td></td>
<td>• Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• TR to have only the option to distribute into transport requests in the wizard</td>
</tr>
<tr>
<td></td>
<td>• CD to have only the option to distribute a change document in the wizard</td>
</tr>
<tr>
<td></td>
<td>All other values or blank for the option to select the target type (change document or transport request) when executing the wizard</td>
</tr>
<tr>
<td>IGNORE_LOCKED_OBJECT</td>
<td>It might be possible, that you distribute workbench objects, which are already locked in another transport in your target system. As locked objects are not copied to the target transport, it will be checked during the distribution. The distribution is only executed in case none of the object is already locked. By activating this parameter, the distribution will be executed in any case, but still the locked objects are not copied. But there will be a warning message containing the object and transport.</td>
</tr>
<tr>
<td>IMP_QUEUE_SYNC</td>
<td>This parameter should be only used in case your development systems are not connected via domain link. It might result in error, when you activate the synchronization of your import queues in other landscape configurations.</td>
</tr>
<tr>
<td>ONLY_OPEN_TR</td>
<td>Only open transports are distributed. Released transport requests are ignored. If this option is deactivated (or not specified) the release status of the transport requests is not considered.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>IGNORE_LOCKED_OBJECT</td>
<td>During distribution, the system checks whether objects to be distributed are already locked in transports other than the target transport. This can lead to incomplete object lists in the target transport. Therefore, the distribution is terminated in this case. If a distribution should be carried out in any case, this can be activated with this parameter. Locked objects are indicated by warnings then.</td>
</tr>
<tr>
<td>EXECUTE_ONLINE</td>
<td>This parameter is used for the automated distribution. As it might be time-consuming to create, export and import transport of copies into several systems, this part is now executed in a batch job per default. With this parameter you can switch the Automated Cross Landscape Distribution to execute all steps synchronously (online).</td>
</tr>
<tr>
<td>BATCH_MAX_JOBS</td>
<td>In case the Automated distribution is executed via batch job, the job will be rescheduled if the source change document is edited by another user This parameter defines the maximum number of attempts. If not specified, the default value '5' is used.</td>
</tr>
<tr>
<td>BATCH_WAIT_S</td>
<td>If a job has to be rescheduled, the system should wait a specified period. Use this parameter to define how long this time span should be in seconds. The default value is 300.</td>
</tr>
<tr>
<td>BATCH_OFFSET_S</td>
<td>The first job for automatic distribution should also not start immediately. This parameter defines the wait time before the first job. If no value is defined, the value set for BATCH_WAIT_S is used.</td>
</tr>
</tbody>
</table>

**Example**

First, you need to activate the version of distribution you want to use: Add the parameter STANDARD_XLD or AUTO_XLD with value 'X'. It is also possible to activate both. With the standard XLD you will get a wizard, which guides you through the process of selecting a target. The Automated XLD is executed immediately after calling it.

The parameters XLD_STRICT, ONLY_OPEN_TR, IMP_QUEUE_SYNC and IGNORE_LOCKED_OBJECT are used for both versions. Please note that XLD_STRICT needs to be activated when using the automated distribution.

The parameter ACTIVITY is used in the standard XLD. Per default the wizard shows 5 steps. The second step is selecting an activity: Distribute into a Change Document or Distribution into target transport request. If the parameter is set accordingly, the wizard is shorter without selecting the target type. You only have the possibility to distribution into a change document (CD) or target transports (TR)

When using Automated Distribution, a batch job is scheduled to execute the distribution. This job is not starting instantly. This initial waiting time can be increased or decreased with parameter BATCH_OFFSET_S. In case someone is editing the source change document at the same time, the change document cannot be locked by the job and the distribution will be cancelled. The job will reschedule itself after some time to take another try. The parameter BATCH_WAIT_S can be used to configure the number of seconds between two jobs. As the job should not run forever, the rescheduling will be stopped after several tries (BATCH_MAX_JOBS).

With EXECUTE_ONLINE = 'X' the automated distribution is executed synchronous. This means no batch job will be scheduled.
11.14.4.2  Target Change Documents

The configuration of Target Change Documents is used by the Wizard-based Distribution and the Automated Distribution.

- When you run the cross-landscape distribution wizard with selection for change documents, you can customize with this table what types of change documents in which status will be available as target.
- When using the Automated Distribution, the target might be created by the system (depending on the activated BAdI). New created target documents will be set the allowed target status. In case there are more than one status allowed for one transaction type, the status that is reached first is used.

Add your transaction types with their status profiles to this table. You need to create a new entry per possible target status.

Note

The configured target status should allow open transport requests.

11.14.5  Configure Filter and Distribution Groups

To define your distribution groups and system specific settings please open transaction SPRO. Under SAP Reference IMG, navigate to SAP Solution Manager -> Focused Build -> Change Control Management Extensions -> Cross Landscape Distribution -> Configure Filter and Distribution Groups.
11.14.5.1 Allowed Target Change Cycle

This customizing will be used within the following scenarios:

- When you run the cross-landscape distribution wizard with selection for change documents, you need to select a change cycle. This customizing folder allows you to filter the displayed change cycles. If this table is empty, all active change cycles are displayed.
  - Add the ID of your target change cycles and set the checkmark in column In Wizard to limit the displayed change cycles.
  - In case the table is empty or none of the entries is marked to be used In Wizard, all cycles would be displayed.
To use the Automated Distribution via status switch, it needs to be activated per cycle.

- Add the ID of your target change cycles and set the checkmark in column `Via Status` to distribute in this cycle via status change. (Do not forget to add the corresponding action to your transaction type as described in chapter Add Automated Distribution to status switch)

It is possible to activate the Automated Distribution via status change for a cycle and to mark it to be available in the wizard. The Automated Distribution could also be started in the Transport Management Assignment Block directly without activating it for a specific cycle.

The check `/SALM/XLD_Check` also does not use this table. This ensures that all distributable objects have also been distributed and that you did not just forget to enter a cycle here.

### 11.14.5.2 Allowed Target Systems

When you run the cross-landscape distribution wizard with selection for transports, you need to select a target system. The displayed systems need to be defined in this table. If this table is empty, no system is available.

### 11.14.5.3 System Specific Settings

This activity allows you to activate or deactivate single options per system by selecting the corresponding check box.
You can change the settings for your source systems.

- **Exclude list:**
  When the column Exclude is activated for a system, you need to define the objects that are not allowed to be distributed. All objects, that are not defined in a distribution list for the current source system, will be distributed. If the flag is not set, the objects list is handled as include list: You need to define all objects that will be distributed.

- **Not Strict:**
  The strict mode can be activated in the Basic Settings of General Customizing Settings. This global setting is valid for all systems.
  By activating the flag Not Strict under System Specific Setting, you can switch off the strict mode for a single system only. Distributions, starting from this specific system, will be non-strict, which means all objects will be distributed without checking them against the distribution groups.

- **Ovrw.Orig.:**
  The import option "Overwrite Originals" will be used when importing the distribution transport of copies into the specified target system. This means, that the transport control program also imports objects if the objects are the originals in the target system. The object directory entry determines the SAP System where the original version of an object is located.

- **Ovrw.Rep.**
  The import option "Overwrite Objects in Unconfirmed Repairs" will be used when importing the distribution transport of copies into the specified target system. The transport control program also imports objects if they were repaired in the target system and the repair is not yet confirmed.

### 11.14.5.4 Define Distribution Groups

When using cross-landscape distribution in strict mode, you need to define which objects should be taken into consideration. For this purpose, create a new group with a **Group ID**, **Group Name** and a **Group Description**. In the subfolders, assign the objects, development and target or source systems and development classes. Each distribution group can be activated or deactivated by setting the flag in the **Active** column.
**Assigned Objects:** In this customizing setting, define objects to be distributed. These objects can be workbench or customizing objects:

- For workbench objects you need to define **PgID, Obj. Type and Object Name**

- A customizing transport object is classified uniquely by its main type and main name. There are four main types, which also contain sub-objects:
  - View cluster Maintenance: main type **CDAT** - can contain multiple views as sub-objects.
  - View Maintenance: main object type **VDAT** - can contain multiple tables as sub-objects.
  - Customizing: Table Contents: main type **TDAT** - can contain multiple tables as sub-objects.
  - Table contents: main type **TABU** - references exactly one table.

Additionally, you can define a table key, which is used to filter the distributed objects.

**Note**

For examples of client-specific transport objects and their sub-objects, see tables E071 and E071K (transaction **SE16**).

**Example: View cluster Maintenance R3TR CDAT:**

This definition of a transport object references the cluster **SCMGV_ATTRPROFA** as a sub-object of the view cluster **SCMGVC_ATTRPROF**. The table **SCMGATTRPROFA** is part of the view **SCMGV_ATTRPROFA**.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PgID</td>
<td>R3TR</td>
</tr>
<tr>
<td>Obj. Type</td>
<td>TABU</td>
</tr>
<tr>
<td>Table Name</td>
<td>SCMGATTRPROFA</td>
</tr>
<tr>
<td>Main Object Name</td>
<td>SCMGVC_ATTRPROF</td>
</tr>
<tr>
<td>Main Object Type</td>
<td>CDAT</td>
</tr>
</tbody>
</table>
Example: View Maintenance R3TR VDAT

This definition of a transport object references the view V_BAOPHASE. This object describes only those entries in table BAOPHASE. The table is part of the view V_BAOPHASE. If you want to include all tables of a view you can also use a wildcard (*) entry as table name.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Name</td>
<td>SCMGV_ATTRPROFA</td>
</tr>
</tbody>
</table>

Example: Table Contents R3TR TDAT:

This definition of a transport object references the TDAT object BDBG. The table is part of the main object BDBG.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PGID</td>
<td>R3TR</td>
</tr>
<tr>
<td>Obj. Type</td>
<td>TABU</td>
</tr>
<tr>
<td>Table Name</td>
<td>BAOPHASE</td>
</tr>
<tr>
<td>Main Object Name</td>
<td>V_BAOPHASE</td>
</tr>
<tr>
<td>Main Object Type</td>
<td>VDAT</td>
</tr>
<tr>
<td>View Name</td>
<td>V_BAOPHASE</td>
</tr>
</tbody>
</table>

Example: Table Contents R3TR TABU:

This definition of a transport object references the TABU object UST04. The table is the entire content of the main object UST04.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PGID</td>
<td>R3TR</td>
</tr>
</tbody>
</table>

Example: View Maintenance R3TR VDAT

This definition of a transport object references the view V_BAOPHASE. This object describes only those entries in table BAOPHASE. The table is part of the view V_BAOPHASE. If you want to include all tables of a view you can also use a wildcard (*) entry as table name.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Name</td>
<td>SCMGV_ATTRPROFA</td>
</tr>
</tbody>
</table>

Example: Table Contents R3TR TDAT:

This definition of a transport object references the TDAT object BDBG. The table is part of the main object BDBG.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PGID</td>
<td>R3TR</td>
</tr>
<tr>
<td>Obj. Type</td>
<td>TABU</td>
</tr>
<tr>
<td>Table Name</td>
<td>BAOPHASE</td>
</tr>
<tr>
<td>Main Object Name</td>
<td>V_BAOPHASE</td>
</tr>
<tr>
<td>Main Object Type</td>
<td>VDAT</td>
</tr>
<tr>
<td>View Name</td>
<td>V_BAOPHASE</td>
</tr>
</tbody>
</table>

Example: Table Contents R3TR TABU:

This definition of a transport object references the TABU object UST04. The table is the entire content of the main object UST04.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PGID</td>
<td>R3TR</td>
</tr>
</tbody>
</table>
• **Assigned Target & Source Systems**: In this customizing setting, assign the target and source system for the selected customizing group. It is possible to add multiple target systems if required.

![Image of Assigned Target & Source Systems](image1)

• **Assigned Development Classes**: Workbench objects can be specified via development package. The setting here is valid for all objects in this package. This setting is valid for all source and target system of the same distribution group.

![Image of Assigned Development Classes](image2)

11.14.5.5 Including Objects from Transport

The list of assigned objects can be entered manually. When dealing with a large number of objects, consider adding objects from a transport request. Choose transport requests from managed systems, which are known by your SAP Solution Manager (such as transport requests created via change documents).

To add objects from a transport request, follow these steps:

1. Select **Define Distribution Groups** on the left side
2. Select one existing distribution group or create a new one.
3. Select **Assigned Objects**

4. Choose **Include Objects from Transport**

![Image of Assigned Objects dialog]

5. On the following screen, enter the number of the transport requests, which objects you want to add to the current group, you may enter the transport number directly or use the F4 search help. The search help displays all possible transport requests. You may filter by transport number or description.

![Image of Add Objects to Cross Landscape Customizing Group dialog]

6. After the transport number is entered, press button Show Objects. The objects, which are contained in the transports, are read via TMW RFC and displayed in the table below.

![Image of Assigned Objects table]

7. Select all entries, you want to add to the distribution group. All displayed entries in this table are selected per default. You can change the selection for single entries or use the buttons Deselect All or Select All.

8. After you finished the selection, press button Save Selected Objects.
This will take over all selected entries into the distribution group. The Object ID will be added automatically. This change will be saved instantly, but you can edit the entries in the distribution group customizing.

11.14.6 Activate Preparation BAdI

This activity can be used to activate an implementation of BAdI /SALM/CM_XLD_PREPARE_DIST.

There are two implementations available:

- /SALM/IM_CM_XLD_PREPAREDIST
- /SALM/IM_CM_XLD_PREP_AUTO2CD
Both implementations can be used to calculate which object needs to be distributed to which target system when using the distribution wizard. The main difference is the distribution target when calling the Automated Distribution.

- `/SALM/IM_CM_XLD_PREPAREDIST` distributes into the same change document. Missing target transports will be created.
- `/SALM/IM_CM_XLD_PREP_AUTO2CD` distributions into another change document. If there wasn't a distribution for the current change document before or the target document used last is not in a valid target status anymore, a new change document is created for the same Request for Change.

⚠️ Caution

There must be one active implementation to use the Cross-Landscape Distribution. Otherwise you will get an error when calling.

This determination can be overridden by creating your own implementation for BAdI `/SALM/CM_XLD_PREPARE_DISTR`. The implementation of the following two methods is necessary.

- `/SALM/IF_CM_XLD_PREPARE_DISTR~PREPARE_DISTRIBUTION`: Prepare cross-landscape distribution
- `/SALM/IF_CM_XLD_PREPARE_DISTR~PROCESS_RULES`: Check object lists against rules

The default implementation is modular. If its implementation class `/SALM/CL_IM_CM_XLD_PREPAREDIST` is used as super class, you need to redefine only the steps that are different in your scenario. This could be done by overriding one of the following methods:

- `CREATE_NEW_TARGET_TRANSPORT`: XLD, create a new target transport for system/client
- `READ_RULES`: Get configured rules from database
- `CHECK_DISTR_GROUPS_FOR_SOURCE`: Check objects in source transports against the distribution rules
- `CHECK_DEV_CLASSES`: Check dev classes (used in `CHECK_DISTR_GROUPS_FOR_SOURCE`)
- `CHECK_OBJECTS`: Check objects (used in `CHECK_DISTR_GROUPS_FOR_SOURCE`)
- `CHECK_KEYS`: Check keys (used in `CHECK_DISTR_GROUPS_FOR_SOURCE`)
- `GET_DISTR_SOURCES`: Get sources for distribution (transports, systems, clients)
- `GET_DISTR_TARGETS`: Get targets for distribution (transports, systems, clients)
- `CHECK_PREREQUISITES`: Additional check before the distribution preparation starts

You could also use `/SALM/CL_IM_CM_XLD_PREPAUTO2CD` as super class for your own implementation. In addition, you may redefine the following methods:
- **GET_TARGET_CDS**: get target change document for distribution
- **GET_TARGET_TRANSPORTS**: get target transports from change document for distribution
- **GET_TARGET_CR**: get preceding change request, to which the new target change should be added
- **GET_CD_DESCRIPTION**: get description text for target change document
- **GET_PROCESSTYPE_FOR_TARGET**: get process type for target change document

After the active BAdI implementation is called, the returned result is verified in the following points before the distribution is executed.

- For all source systems:
  - TMW RFCs must be defined
  - The user used must have authorization for executing the functions **TMW_CREATE_TRANSPORT_OF_COPIES** and **TMW_GET_TRANSPORT_LIST**.
- For all target systems,
  - TMW RFCs must be defined in the Solution Manager,
  - The function **/SALM/CM_XLD_MERGE_REQUESTS** must exist there
  - The user must have authorization for this function.
- Source and target systems must be different
- There must be objects to be distribution for each identified target.
- The determined destination transports must not yet be released.

To use your own implementation, you need to deactivate the delivered version **/SALM/CM_XLD_PREPARE_DISTR** before activating your own one.

**Note**

There can be only one active implementation at the same time.

### 11.14.7 Activate Post-Distribution BAdI

It is also possible to implement and activate your own implementation of BAdI: **/SALM/CM_XLD_AFTER_DISTR**. This BAdI is named after the automated distribution is finished. As long as there isn't any implementation, you create a new implementation when calling this activity.
11.14.8  Activate Target Change Lock BAdI

You can activate this BAdI if you want to protect the objects you distributed via XLD in the target system against changes in the target landscape by other developers. When activating this function, objects that are defined in the distribution groups can only be changes via distribution from the source system and will be locked in the target systems.

The function uses the ChaRM Check Framework. To be able to activate this BAdI you should not have another customer implementation of the BAdI /TMWFLOW/TRANS_DEFINED_CHECK. There can be only one of them active. But you can add the function to your custom implementation by calling the implementing class /SALM/CL_CM_XLD_LOCK_BADI in your custom BAdI implementation.

The BAdI only considers systems for the lock when they are flagged as relevant in the Systems Specific Settings for XLD. Based on this setting, all Distribution Groups that contain this system as a Target System will be used to calculate the locked object list.

To fully match the same objects when distributing via XLD and lock objects via the same list there is one limitation: If you maintain view clusters (CDAT) in your object list, you need to put a * into column View Name to lock all views of the view cluster at the same time. It is not possible to lock a single view in a view cluster.

To make sure the checks and rules always match we have a check in place that validates if the Main Object Type is "CDAT" or "**" that the Main Object Name and the View Name are either identical or the View Name is *.

If this is not the case the BAdI shows an error message, that XLD settings are inconsistent. To fix this issue you need to review all object rules in the Distribution Groups and check that View Name is set to * in case the Main Object Type is CDAT.

11.14.9  Additional configurations for transaction types

There are some configurations needed for your custom transaction types to use the Cross-Landscape Distribution. The activities described in this chapter might not be needed in any case.
11.14.9.1 Activating Consistency Check

The consistency check `/SALM/XLD_Check` can be used for wizard based and automated distribution. It validates whether all distributions were executed before a specific status can be set. This check only works in strict mode, as it requires you to have defined targets. When working in non-strict mode, the check will never fail. To use the consistency check, follow the listed sequence of instructions (details provided below):

- Activate BAdI implements to check.
- Define consistency check.
- Add check to your transaction types.

To ensure activation of BAdI implement `/SALM/XLD_Check` for consistency check, follow these steps:

1. Start transaction SPRO.
2. Navigate to SAP Solution Manager ‣ Capabilities (Optional) ‣ Change Control Management ‣ Change Request Framework ‣ Consistency Check.
3. Open the activity Implement Consistency Checks in Change Request Management.

4. Check whether implementation `/SALM/XLD_Check` is activated, as shown in the screenshot below.
   - If necessary, activate the implementation.
To define the consistency check before it can be used, follow these steps:

1. Start transaction SPRO.
2. Navigate to SAP Solution Manager à Capabilities (Optional) à Change Control Management à Change Request Framework à Consistency Check.
3. Open the activity Define Conditions.

4. If there is no entry for /SALM/XLD_CHECK, please create a new entry:
   - Status Transition Consistency Check: /SALM/XLD_CHECK
   - Description: Check that XLD is done.
   - Implemented in the Class: CL_CHM1_INSTANCE

5. Save and go back one step to the folder Consistency Checks.
6. Open the activity Define Basic Settings.
7. If there is no entry for /SALM/XLD_CHECK, please create a new entry:
   - Status Transition Consistency Check: /SALM/XLD_CHECK
   - Message Class: /SALM/CM_XLD_MSG
   - Message Number: 021
   - Message Type: Error
8. Save and go back one step.

To add the consistency check to your transaction types, follow these steps:

1. Start transaction SPRO.
2. Navigate to SAP Solution Manager ➤ Capabilities (Optional) ➤ Change Control Management ➤ Change Request Framework.
3. Open the activity Make Settings for Change Transaction Types.

4. Go to Select Transaction Type in the left tree.
5. After selecting your transaction type in the displayed table, open Assign Consistency Checks.
6. Create a new entry for the status to which the distribution is to be completed.
   - You may use application area /SALM/CM_XLD_MSG with message number 021, XLD Error: Transports not distributed to all cross-landscape targets.

11.14.9.2 Configuring Status-Dependent UI Element Control

Without further customizing, the option to call the cross-landscape distribution wizard in the WebUI is disabled for all transaction types. To make it available, you need to configure, for which transaction types in which status it needs to be used.

To configure the cross-landscape distribution wizard in the WebUI, follow these steps:
1. Start transaction SPRO.
2. Select the entry Configure status-dependent UI element control, as shown in the screenshot below.

![Screenshot showing the Configure status-dependent UI element control]

3. Select the folder Assignment Blocks.
4. Select the assignment block Transport Management on the right side.
5. With a double-click, select the sub-folder UI Elements.

![Screenshot showing the Assignment Blocks and UI Elements]

6. Create the new entry /SALM/XLD for the assignment block Transport Management.

![Screenshot showing the Change View "UI Elements" Overview]

- The UI Element /SALM/XLD is currently not available via search help. You can enter it directly. If you would like to find it in the search help result list, you should enter the following entry in the table AIC.UI_IDT (transaction SE16).
  - FIELDNAME: /SALM/XLD
  - LANGU: E
  - P_DESCRIPTION: Cross Landscape Distribution
- Create new entries for each used language by choosing another value for LANGU. Add your entries to a transport request by marking them in the first column and selecting Table Entry - Transport Entries from the menu.
7. Select your new entry and go to **Status-Dependent Control of UI Elements**.

8. Here you need to define your customizing for all transaction types.
   - Add an entry for each status value of your transaction types.
   - Select a value for **Editable/Executable** as required.
   - Make sure that you activate all entries in the last column **Active**.

   **Note**

The following screenshot displays an example for `ZMHF` and `ZMMJ`. Please note the other attributes (such as **Visible**) are ignored.

![New Entries: Overview of Added Entries](image)

### 11.14.9.3 Add Automated Distribution to status switch

The Automated Cross Landscape Distribution can be started directly from the Transport Management assignment block, but it is also possible to trigger it during a status change.  

For this option you should activate the BAdI `/SALM/IM_CM_XLD_PREP_AUTO2CD` as it is intended to be used for that. Using `/SALM/IM_CM_XLD_PREPAREDIST` might work too, but it needs to be started for a status, which allows to create new transport requests.

Executing the distribution might take some time. To prevent session time outs during a status switch, the online execution should not be activated the parameter **Execute_online** via general customizing settings.

**Recommendation**

Please activate BAdI `/SALM/IM_CM_XLD_PREP_AUTO2CD` and use the execution via scheduling a batch job.

1. Start transaction **SPRO**.
2. Select the entry **Make Settings for Change Transaction Types**, as shown in the screenshot below.
3. Select your transaction type and go to folder Assign Actions.

4. Create a new entry for the status, the distribution should be executed. Use action S1_XLD.

Example

The following screenshot shows a configuration for an Urgent Change and status Successfully Tested.

5. Also check the Define Execution Time settings for the selected status. Depending on the configured consistency checks, you may schedule the action before or after the check are executed.

Example

You want to distribute in a status with the configured consistency ALL_TASKS_RELEASED. It makes sense to schedule the distribution action S1_XLD after the check execution, to get an instant feedback.

Although it would be checked by the distribution too, the result would come up later, especially for the batch job execution.

6. Save your changes.

11.14.9.4 Personalize WebUI to display SALM Transport Assignment Block

Cross Landscape Distribution could be used with Focused Build work items too. This section describes how you can access the necessary buttons when using another Focused Build business role instead of /SALM/SM_PRO.
Starting from SP07 the necessary assignment block /SALM/CM_TRANS is available in all Focused Build business role, but each user needs to add it to his personal view.

⚠️ Caution

The button Personalize may not be visible to each user. It needs to be activated by each user in the Personalize setting for a user before.

Another reason may be, that the user does not have the authorization to personalize. If this should not be allowed for users, it’s not possible to use this option.

1. Start WebUI with your preferred business role.
2. Open a work item
3. Click on button Personalize.

4. Tile 2 contains the Transport Management assignment block, which needs to be exchanged.

5. Click on button Add to display the available assignment blocks. Select FB Transport Management and click on button Choose.
6. Move the added assignment block up and down to the desired position. (e.g. next to Transport Management)

7. Delete the former Transport Management by click on the dust bin.

8. Saving your changes will bring you back to the WebUI displaying the new assignment block.

11.15 Cutover Checks and Post Cutover Activities: Configuration

11.15.1 Overview

The cutover-related checks and activities are valid within a N+1 system landscape. There is one maintenance landscape that supports the productive systems and one project or development landscape in place. The maintenance landscape should be assigned to the maintenance branch and the project landscape to the development branch of the solution.

The project systems (development, quality assurance, and pre-production systems) deliver to the maintenance system track (development, quality assurance, and pre-production systems).
Please refer to the corresponding content activation guides of SAP Solution Manager 7.2 that are available on the support market place for further reference and best practices for the solution and landscape setup.

Scenario 1
In this scenario, the cutover from the project landscape takes place into the productive system of the maintenance landscape.

Scenario 2
The cutover from the project landscape takes place into the pre-production system of the maintenance landscape.

Scenario 3
The cutover from the project landscape takes place into the development system of the maintenance landscape and repack needs to be done after the cutover.

Scenario 4
The cutover from the project landscape takes place into the development system of the maintenance landscape and the changes are then transported through the maintenance landscape to the production system.
Cutover Checks

Cutover checks must be executed before the cutover takes place. The checks ensure that the risk that may arise during the cutover into the maintenance landscape are known and can be mitigated.

The change cycles that are created within a branch different than the maintenance branch contain a new assignment block in the WebUI. This provides the necessary elements to execute the cutover checks as well as to verify the check results.

Post Cutover Activities

Post cutover activities should be executed after the cutover has been performed and all necessary software has been deployed into the maintenance track. Post cutover activities are executed for each system of the maintenance landscape individually. Which post cutover activities are available for those systems depend on their role in the landscape and whether the actual cutover took place in a system before or after, given the transport track defines the order of the systems.

11.15.2 Roles and Authorizations in SAP Solution Manager

Cutover checks and post-cutover activities are integrated in the business role `/SALM/SM_PRO`. To use it, you need to have the following roles assigned:

- SAP_OST_SM_CRM_UIU_SM_PRO
- SAP_OST_FB_CRM_UIU_CM
- SAP_OST_FB_CRM_UIU

To start a check or activity (such as scheduling background jobs and reading LMDB objects), the user needs additional authorizations. These authorizations are contained on the authorization role SAP_OST_CM_CUTOVER.

To configure this function via transaction SPRO, the configuration user needs the role SAP_OST_FB_CM_ITSM_CONFIG.

11.15.3 Roles and Authorizations in Managed Systems

Remote function calls are necessary to execute some checks and activities. TMW RFC is used.

Make sure the user of TMW RFC has the following authorizations in the managed systems:

S_RFC for function modules
11.15.4 Define Cutover Check Settings

The central entry point to configure the cutover checks is the view cluster /SALM/CHM_COC_VC. This could be maintained using transaction SPRO or SM34. Changes to this customizing cluster must be recorded into a transport request.

<table>
<thead>
<tr>
<th>Display View “Define Check Types”: Overview</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dailog Structure</td>
</tr>
<tr>
<td>Define Check Types</td>
</tr>
<tr>
<td>- Assign Check to process type</td>
</tr>
<tr>
<td>- Select Process Type</td>
</tr>
<tr>
<td>- Assign Cutover Check</td>
</tr>
<tr>
<td>Define Check Types</td>
</tr>
<tr>
<td>Check Type</td>
</tr>
<tr>
<td>010</td>
</tr>
<tr>
<td>0011</td>
</tr>
<tr>
<td>0020</td>
</tr>
</tbody>
</table>
11.15.4.1 Define Check Types

Define the cutover checks that should be available to be executed.

- **Check Type**: Identifier of the check.
- **Description**: Language dependent description of the check. Appears in the UI.
- **Table Name**: Name of a DDIC structure that defines the columns of the check result shown in the UI.

The following entries are delivered by default:

<table>
<thead>
<tr>
<th>Check Type</th>
<th>Description</th>
<th>Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>0010</td>
<td>Retrofit Scope</td>
<td>/SALM/CHARM_CO_CHECK_RES_RETRO</td>
</tr>
<tr>
<td>0011</td>
<td>Retrofit Deployment</td>
<td>/SALM/CHARM_CO_CHECK_RES_RETRO</td>
</tr>
<tr>
<td>0020</td>
<td>Transport Dependencies</td>
<td>/SALM/CHARM_CO_CHECK_RES_TRDEP</td>
</tr>
<tr>
<td>0030</td>
<td>Development Conflicts</td>
<td>/SALM/CHARM_CO_CHECK_RES_CSOL</td>
</tr>
</tbody>
</table>

Retrofit Scope validates, that all retrofits have been executed in the parallel tracks. Changes in the development system of the maintenance track, that have not yet been transferred to the implementation track, are displayed here, because no retrofit has yet been performed. Changes in additional development systems, which have the same production system, will be shown as warning.

Retrofit Deployment checks, that retrofitted changes are "finally" life. This means that the original requests in the maintenance landscape have already been imported into the production system.

When executing Transport Dependencies, the system checks objects that are to be imported into the production system during the next go live. It is not only checked that these objects are syntactically correct. The system also analyzes which objects are used by these objects and whether they exist in the same version in the production system as in the implementation landscape (unless they are also part of the current go live.)

The last check Development Conflicts validates, that objects, changed in the implementation landscape, must not have been changed in maintenance landscape. This check is based on Cross System Object Lock. The objects, which are part of the current cutover, should have no entry for the target landscape.

1 Note

Please note that for each defined check type, a corresponding BAdI implementation with the check type identifier as filter value must be implemented and activated.

11.15.4.2 Assign Check to process type

Assign the different checks that should be available for the certain process types.

- **Check Type**: Identifier of the check.
- **Trans.Type**: Transaction the check should be assigned to.

The following entries are delivered by default:
In general, the maintenance starts with Define Check Types and continues with Assign check to process type. Sometimes it’s hard to see all checks currently assigned to an individual transaction type. To overcome this, there is a second entry point in the view cluster. This entry point, Select Process Type, allows you to select the process type first and then navigate to Assign Cutover Checks. The data is stored into the same database table. The content is presented from a different angle only and can be maintained in both ways.

### 11.15.5 Configuration of Post-Cutover Activities

The central entry point to configure the post-cutover activities is the view cluster /SALM/CHM_PCA_VC. This could be maintained using transaction SPRO or SM34. Changes to this customizing cluster must be recorded into a transport request.

#### 11.15.5.1 Post-Cutover Actions

Here, you define post-cutover actions that should be available to be executed:

- **Action ID**: Identifier of the action.
- **Description**: Language-dependent description of the action. Appears in the UI.
- **Exec. Type**: Defines whether this action can be executed only once per system or several times. Defines whether it is an online or batch execution.
- **Validity**: Defines the systems in the cutover track this action should be available depending on the cutover scenario.
- **Sort Order**: This defines the order the actions appear in the UI.

The following entries are delivered by default:

<table>
<thead>
<tr>
<th>Check Type</th>
<th>Trans.Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>0010</td>
<td>SMIM</td>
</tr>
<tr>
<td>0010</td>
<td>SMRE</td>
</tr>
<tr>
<td>0011</td>
<td>SMIM</td>
</tr>
<tr>
<td>0011</td>
<td>SMRE</td>
</tr>
<tr>
<td>0020</td>
<td>SMIM</td>
</tr>
<tr>
<td>0020</td>
<td>SMRE</td>
</tr>
<tr>
<td>0030</td>
<td>SMIM</td>
</tr>
<tr>
<td>0030</td>
<td>SMRE</td>
</tr>
<tr>
<td>Action ID</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>IMPO</td>
<td>Import Synchronized Deployment</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>LOGN</td>
<td>Logon to System</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>ORGS</td>
<td>Adjust Original System</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>SYNC</td>
<td>Synchronize Deployment (ToC to buffer)</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The configured actions will be available for the systems, which are part of the target maintenance landscape. The activities displayed depend on the system role and the position of the system in relation to the cutover system:

- Logon to System provides the possibility to access the selected system for example to validate any import logs and issues directly in the managed system.
- Activity Synchronize Deployment (ToC to buffer) is called to create Transports of Copies (ToCs) in the cutover system and to add the transport to the transport buffer of the selected system.
- Import Synchronized Deployment executes the import of the create ToCs.
- The optional activity Adjust Original System is used to adopt of the system originality flag.

**Note**

Please note that for each defined action a corresponding BAdI implementation with the action ID as filter value must be implemented.

If SP01 was installed in your system before, it might be possible that there is an additional action definition for Repack in this table.

This entry is not supported anymore. Please delete it from your customizing.

### 11.15.5.2 Post-Cutover System Roles

Here, you define the system roles' post-cutover actions that should be relevant and available for execution:

- **Action ID**: Identifier of the action.
- **Role Type**: System role type in the landscape.
- **SysRole ID**: System role identifier.

The following entries are delivered by default:
11.15.5.3 Post-Cutover Dialog Boxes

Here, you assign WebUI components and their interface window that should be displayed as dialog boxes before the post-cutover action is performed.

- **Action ID**: Identifier of the action.
- **BSP Application**: WebUI Application providing the dialog box window
- **Interface Window**: Name of the interface window of the WebUI component added to the component interface in the runtime repository
- **Dialog window title**: OTR alias providing the language dependent dialog box window title
- **Width**: Width of the dialog box window (default is 500px if not provided)
- **Height**: Height of the dialog box window (default is 500px if not provided)

These could be used to request further data from the user to ensure proper action execution or to completely perform this action in the dialog box.

**Note**

To control whether the action should be executed after the dialog box has been closed the BAdI /SALM/CHARM_PCA_POPUP_CONTROL could be implemented. The implementation is based on the filter for the action ID.

The following entries are delivered by default:

<table>
<thead>
<tr>
<th>Action ID</th>
<th>BSP Application</th>
<th>Interface Window</th>
<th>Dialog window title</th>
<th>Width</th>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOGN</td>
<td>/SALM/CM_CUTOVR</td>
<td>nWindow</td>
<td>AGS_TD/SYSTEMLOGON</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
11.15.5.4 Implementation of Post-Cutover Activities

The default delivered post cutover actions does already have an active implementation. The actions implement the enhancement definition /SALM/CHARM_PCA_ACTIONS. This enhancement contains the BAdI definition /SALM/CHARM_PCA_EXECUTION, which needs to be implemented with a filter value representing the post-cutover action ID assigned. The delivered enhancement implementation containing the implementation of this BAdI is /SALM/IM_CHARM_PCA_EXECUTION.

BAdI /SALM/CHARM_PCA_EXECUTION

The implementation of this BAdI is executed if the corresponding post-cutover action is processed. Based on the execution type, this would be in batch or dialogue mode. The signature of the method EXECUTE_ACTION provides all necessary information to process this action. Each action is executed for a dedicated system of the transport track the cutover takes place into. The execution for each system is triggered by the user within the corresponding assignment block in the WebUI.

- EXECUTE_ACTION: This method is called while executing the corresponding post cutover action. The processing logic need to be implemented here.

11.15.6 Overview of WebUI Configuration

The visualization of the cutover checks and post cutover activities is implemented in the WebUI component /SALM/CM_CUTOVR. The cycle documents are accessed through WebUI component AIC_CMCD_H. If this feature should be available, a corresponding component usage needs to be defined and the context node binding to context node BTAdminH should be setup. This is all done in the delivered WebUI component /SALM/CMCD_H. Once the component usage has been set up, the embedded window should be assigned to the view area of the overview page in the runtime repository. As a result, the UI configuration of the overview page is enhanced to cover this new assignment block.

The assignment block for the cutover feature is dynamically hidden in case the cycle document is assigned to a maintenance branch. This is implemented in the method DETACH_STATIC_OVW_VIEWS of the overview page implementation class.

11.15.7 Activation of Webservice cm_cutovr

The web service cm_cutovr needs to be activated to use the cutover checks in the CRM. It can be activated in transaction SICF and found in the path /default_host/sap/bc/bsp/salm/.
11.15.8 Defining the Consistency Check

Before the consistency check /SALM/COC_SUCCESS can be used, it needs to be defined.

To define the consistency check, follow these steps:

1. Start transaction SPRO.
2. Navigate to SAP Solution Manager ➔ Capabilities (Optional) ➔ Change Control Management ➔ Change Request Management Framework ➔ Consistency Checks.
3. Open the activity Define Conditions.

4. If there is no entry for /SALM/COC_SUCCESS, create a new entry:

Note

If the service is not activated when calling the Cutover Checks and Activities assignment block, it looks like the landscape view keeps loading.
5. Save and go back one step to the Consistency Checks folder.
6. Open the activity Define Basic Settings.
7. If there is no entry for /SALM/COC_SUCCESS, create a new entry:
   - Status Transition Consistency Check: /SALM/COC_SUCCESS
   - Message Class: /SALM/CHARM_COC
   - Message Number: 000
   - Message Type: Error
8. Save and go back.

11.15.9 Adding Consistency Check to Transaction Type

Add the consistency check /SALM/COC_SUCCESS to your transaction types to ensure that all checks are passed before the cutover to the maintenance track, and to ensure that they are performed successfully. It should be added to your change cycle (such as SMRE or SMIM) to be executed when the production status is reached.

To add the check to your transaction types, follow these steps:
1. Start transaction SPRO.
2. Navigate to SAP Solution Manager ➤ Capabilities (Optional) ➤ Change Control Management ➤ Change Request Management Framework.
3. Open the activity Make Settings for Change Transaction Types.
Go to Select Transaction Type in the navigation tree on the left.

Select the transaction type (SMIM or SMRE) in the displayed table.

Open Assign Consistency Checks.

Create a new entry for the condition check /SALM/COC_SUCCESS.
- You may use application area /SALM/CHARM_COC with message number 000. Cutover check not yet executed or raises errors. Please verify.

Save.

11.15.10 Maintenance Tracks to be Ignored

It might be necessary to ignore some maintenance tracks (such as in a simulation landscape). It can be customized per development transport track which maintenance development systems should be ignored. Therefore, you may open table /SALM/CHARMCOQL in transaction SM30. Add a new entry for the transport track of your current implementation cycle and each maintenance development system that should be ignored.

Added systems are not considered for calculating the affected tracks. No checks and no activities could be performed for these systems.
11.16 Electronic Signature for Change Request Management: Configuration

11.16.1 Overview

The purpose of this section is to describe the electronic signature for CHARM functionality and configuration. This functionally might be used especially in controlled systems where a legally-binding electronic signature is required for specific approvals and process steps.


Official applicable paragraphs:
21 CFR §11.10(e) System must assure that record changes (create, modify, delete) do not obscure previously recorded information by implementing secure, computer-generated, time-stamped audit trails. These audit trails must be retained for as long as the subject electronic records and be available for review and copying.
21 CFR §11.100(a) & §11.300(a) System must ensure that each electronic signature be unique to one individual and not reused by, or reassigned to, anyone else.
21 CFR Part §11.200(a, 1) System must assure that any electronic signature not based on biometrics must employ at least two distinct components (such as, ID code and password)
21 CFR §11.200(a, 1, ii) System must enforce workflows such that an individual executing one or more signings, not performed during a single continuous period of controlled system access, executes each signing using all of the electronic signature components.
21 CFR Part §11.300(e) Any devices that bear or generate identification code or password information must be tested to ensure that they function properly and have not been altered in an unauthorized manner.

The electronic signature supports signature scenarios in Change Request Management.

- During an approval step, using the approval procedure.
- During any status switch within a change request or change document executed via actions.
11.16.2 Roles and Authorizations

The electronic signature is integrated in the business role /SALM/SM_SM_PRO. To use it, have the following roles assigned:

- SAP_OST_SM_CRM_UIU_SM_PRO
- SAP_OST_FB_CRM_UIU_CM
- SAP_OST_FB_CRM_UIU

To execute a digital signature, the additional authorization C_SIGN object is required. The authorization object requires the following attributes:

- C_SIGN
  - Activity: 73
  - Application of the Digital Sig: /SALM/CR
  - Digital Signature Object: /SALM/CR

This authorization is contained in the role SAP_OST_FB_CM_ESIGN.

To configure the Electronic Signature via transaction SPRO, the configuration user needs to have the role SAP_OST_FB_CM_ITSM_CONFIG.

11.16.3 Creating and Validating the Signature Object

To create and validate the signature object, follow these steps:

1. Start transaction SM30 and open view SIGNAPPL_V

   ![Register "Application" Grouping Element for Dig. Signature](image)

   Validate that the application object /SALM/CR is available

2. Start transaction ELSIG03N

   ![Digital Signature: Signature Object](image)

   Validate that signature object /SALM/CR is available and is set to system signature with authorization by SAP user ID/password.
Go to SM30 open view SIGNOBJECT_V

Validate that appl. /SALM/CR with object /SALM/CR is available and contains the following entries:

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mata Table</td>
<td>/SALM/DS_CR</td>
</tr>
<tr>
<td>LogStruct.</td>
<td>/SALM/DS_LOG</td>
</tr>
<tr>
<td>Comment</td>
<td>Possible</td>
</tr>
<tr>
<td>Remark</td>
<td>Possible</td>
</tr>
<tr>
<td>Document</td>
<td>Possible</td>
</tr>
<tr>
<td>Description</td>
<td>Signature for Change Management</td>
</tr>
</tbody>
</table>

11.16.4 Activating Electronic Signature for the Approval Assignment Block

To activate the electronic signature for an approval assignment block, follow these steps:
1. Navigate to the highlighted SPRO node shown in the screenshot below and choose Electronic Signature.
2. Add a customizing entry to the table /salm/c_itr.
3. Choose activity Activate Signature for Approval Assignment Block.
You can define up to 10 different transaction types where you want to activate digital signature with attribute names DSIGTYP0 to DSIGTYP9.

- All transaction types for ChaRM are possible.

4. Provide your ChaRM transaction types such as SMCR or ZMCR.

11.16.5 Activating Electronic Signature for an Action from the Action Profile

To assign the electronic signature with this customizing to any action from a change request or change document, follow these steps:

1. Call maintenance view AICV_UI_POPUP via transaction SM34 or SPRO node Electronic Signature.

2. Choose activity Activate Signature for PPF Actions.
3. Add an entry for each action you want to add the electronic signature.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Type</td>
<td>Transaction Type of your transaction you like to add</td>
<td>SMCR</td>
</tr>
<tr>
<td>Action Profile</td>
<td>Action Profile name from your transaction</td>
<td>SMCR_ACTIONS</td>
</tr>
<tr>
<td>Action Definition</td>
<td>This is the actual technical name of the action you like to add the signature to</td>
<td>SMCR_QUALIFY_CHANGE</td>
</tr>
<tr>
<td>Sequence</td>
<td>Sequence of the action in the action profile</td>
<td>10</td>
</tr>
<tr>
<td>BSP UI Component</td>
<td>This is the signature</td>
<td>/SALM/DS_SIGN</td>
</tr>
<tr>
<td>BSP Interface</td>
<td>This is the signature interface</td>
<td>/SALM/DS_SIGN/MainWindow</td>
</tr>
<tr>
<td>BSP UI Usage</td>
<td>This is the usage linked in /SALM/CMCR_H and /SALM/CMCD_H. You need to use these 2 components to use any Change Request Management enhancement</td>
<td>CUSALMDIGITALSIGNATURE</td>
</tr>
<tr>
<td>PPF Container Element</td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>PPF Data Container Class</td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>Dialog Window title (OTR Alias)</td>
<td>OTR Alias for the dialog box title</td>
<td>/SALM/CHARM_DS/POPUP_TITLE</td>
</tr>
<tr>
<td>Before PPF Call</td>
<td>Signature must be executed before the action. If the signature fails, action does not take place</td>
<td>Checked</td>
</tr>
<tr>
<td>After PPF Call</td>
<td>Do not use</td>
<td>Not checked</td>
</tr>
<tr>
<td>Activate</td>
<td>Activate the customizing settings</td>
<td>Checked</td>
</tr>
</tbody>
</table>

11.16.6 Check sign status for documents

It is possible to check change requests and change documents, whether a signature exists for them. The report /SALM/CM_DS_READ_SIGNATURES might be used for this task. It can be called via transaction `SA38`. On its start screen the IDs of all documents, which should be checked, are entered. Wildcards like '*' might be used.
After executing the report, a list is displayed. It contains all information about all documents matching your entered criteria, like transaction type, current status and, in case it has been already signed, the time stamp and the user.

The report does not filter for specific transaction types. Therefore, it can also handle for example incidents. But only signatures, which were created via this Focused Build enhancement will be taken into considerations.

11.17 Test Steps: Configuration

11.17.1 Overview - Test Steps

Test case designers and testers have an alternative to document test cases that are based on Word or Excel documents. Test cases can be designed at the level of steps directly in SAP Solution Manager Fiori Application Test Steps Designer without the need to upload or download documents such as Excel spreadsheets. Testers can execute these test cases via the Fiori Application My Test Execution and document the test results.

Test steps are test case entities and (though not recommended) could be maintained as standalone entities in the test step designer application. Alternatively, test steps could be maintained in solution documentation (transaction SOLDOC) directly.

For a test case, different languages can be maintained, including version handling and reusing test cases via a template library. The navigation is simplified and intuitive.

You can open Test Steps Designer from solution documentation using the right-click Test Steps (Create) option. This allows you to directly add a test steps document to a structure node in solution documentation. If you created a test steps document directly from the designer app, you can still assign it to solution documentation using the Test Steps (Assign) function.
After configuring **Test Step Designer**, **My Test Execution**, and **Test Suite Dashboard**, you can access the three applications by using these tiles:

11.17.2 **Overview - Test Steps Parameters**

Test Steps Parameters adds further functionalities to manual testing with Test Steps test cases. It can only be used with Focused Build Test Steps and thus requires the setup of Test Steps as described above.

With Test Steps Parameters you can define and use parameters within Test Steps test cases which are later substituted by specific values during test execution. For example, you can use the parameter Plant within a test case which will be substituted by the value Walldorf during test execution. The value assignment allows you to distinguish between Test Plans, Test Packages and Testers. This way, there is no need to define separate test cases or use an external test data repository to execute the same test case with different test data.
11.17.3 Prerequisites

In case you have implemented and used Test Steps on this SAP Solution Manager System before already, it is recommended to run report /SALM/TM_TS_REP_EXEC2TPLN_REF via transaction SE38. This report repairs potentially invalid references between Test Steps Execution Objects and Test Plans/Test Packages. You can run the report in Test Mode to get an overview of potentially affected records first. If any records were found, please run the report without "Test Mode".

Mandatory configuration of Test Suite in SAP Solution Manager setup has been performed (transaction SOLMAN_SETUP)

Even if there are some yellow or red traffic lights in SOLMAN_SETUP, these should not be relevant for Test Suite and test steps. Also, the missing customizing in Test Suite configuration is not critical for usage of test steps. Check: OK / not OK.

Yellow light in SOLMAN_SETUP for system preparation:
Check: OK / not OK. An update of an essential SAP Note should be implemented. It is recommended to start with the latest note version on the productive SAP Solution Manager environment.

Yellow light in SOLMAN_SETUP for infrastructure preparation: Not relevant for test steps.
Status Test Suite preparation in SOLMAN_SETUP:
Overall status OK

11.17.4 Implementation of Key SAP Notes

Implement or verify the correct implementation of the following SAP Notes.

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2955721</td>
<td>Focused Build: Central Note for Focused Build 2.0 SP07 for SAP Solution Manager 7.2 SP12</td>
</tr>
<tr>
<td>2910105</td>
<td>Focused Build: Technical collective note for ST-OST 200 SP06</td>
</tr>
</tbody>
</table>

11.17.5 Activating SALM_FB Service

1. Start transaction SOLMAN_SETUP in your working client.
2. Goto Focused Build in SOLMAN_SETUP.
3. Goto step 1.2 Setup Steps
4. Execute Manual Activities FB ICF Services
11.17.6 Defining System Aliases for OData Services

In defining system aliases, you configure OData services for Focus Build’s UI5 applications.

To define system aliases, follow these steps:
1. Start transaction SOLMAN_SETUP in your working client.
2. Go to Focused Build in SOLMAN_SETUP.
3. Execute step 1.4 Enable Gateway Services

11.17.7 Customization Options

Test Steps offers predefined customizing and authorization roles. The predefined configuration allows direct usage of Test Steps without any further adjustments.

However, the predefined customizing for test steps (received from the piece list) can be adapted. Customizing is described in this chapter.

Further details, standard customizing settings and configuration examples can be found in the corresponding documentation and customizing tables in the IMG of the SAP Solution Manager system:

SAP Solution Manager Implementation Guide † SAP Solution Manager † Focused Build † Test Suite Extensions † Test Steps.

11.17.7.1 General Settings for Test Steps Application

In view /SALM/TM_C_GSET, general settings for test steps are defined. The following parameters should be set:
- **SUBSTEN**: Enable design of sub-steps in test steps designer application
- **STEPSEQ**: Define default value for step sequence setting. Strict sequence forces all testers to execute test steps in the defined sequence. Flexible sequence enables all testers to execute test steps in any sequence. Individual setting enables test case designers to define on test case level whether the test steps should be executed in strict or flexible sequence.
- **LANG**: Test steps-based test cases can be translated in different languages. Here you can define the available languages for translation. Use the sequence parameter to define the display sequence. This also influences the sequence in which fallback texts are loaded in case no translated text exists in the selected language. That is, if the user selects English, but no text exists in English, the display shows the text in the language which is available following the sequence defined here.
- **TESTING**: You can define the status during test execution that covers the semantic of currently testing or in progress. This status is used for aggregation purposes during test execution, such as, when a new run is created.
- **STSCHM**: Here you can define the ID of a custom specific document status schema which is used for status selection in test steps designer. The schema itself can be maintained via view cluster maintenance (transaction SM34) with view cluster SMDDOCSTATUS. If not defined, the standard schema 0DEFAULT is considered. You can also use a schema which enables digital signatures during the status workflow in Test Steps Designer. In this case you need to activate the predefined BAdI implementation /SALM/TM_TS_TD_ADHOC_SIG_STRAT (BAdI Definition Name: CL_EX_ADHOC_STRATEGY). The BAdI implementation is delivered inactive by default and requires activation only in case you use digital signatures also for Test Steps Designer via the status schema.
- **INITSTAT**: With that parameter you can define the initial status for new test cases created in test steps designer. This status should refer to the status schema you define with parameter STSCHM (see description above).
- **DEFPRIO**: Here you can maintain the priority ID for test steps test cases which is taken as default when a new test case is created in test steps designer. Priorities can be maintained in maintenance view V_SMDDOCPRIORITY via transaction SM30.
- **DEEPSEARCH**: In solution documentation you can search for test steps documents by name and content. By default, the search only covers the language-dependent texts on header level (description, prerequisites, exit criteria). If you also want to include the language-dependent texts on step level (description, instructions, expected results, customer text field), activate a deep search by setting this parameter to X.

Special parameters for machine translation

The following parameters are required only in case you want to apply the machine translation API. Further details on how to configure the machine translation for test cases can be taken from the respective chapter below.

- **TRANSL**: You can apply the automated translation API which is offered for test steps designer. By setting this parameter to X, users can perform an automated translation of test case contents in Test Steps Designer. The API is implemented in enhancement spot /SALM/TM_TS_TD_TRANSLATE. A sample BAdI implementation is delivered: /SALM/TM_TS_TD_TRANSL_BADI_IMP. This implementation connects to your SAP Business Technology Platform account and uses the respective translation service.

Relevant for SAP Translation Hub:
- **TRANSLHUBC**: Http connection to SAP Translation Hub

Relevant for SAP Leonardo Machine Translation:
- **TRANSLPETC**: Name of the Ext. HTTP connection to the Translation Service Productive Token Endpoint.
- **TRANSLPESU**: URL to the translation service productive endpoint.

Relevant for SAP Translation Hub Sandbox:
- **TRANSLSESU**: URL to the translation service sandbox endpoint.
- **TRANSLSEKY**: API Key for the translation service sandbox endpoint. This is required only in case you want to apply the machine translation API using a sandbox account.

Relevant for SAP Leonardo Machine Translation together with a proxy:
TRANSLPH: Translation service proxy host. This is required only in case a proxy needs to be maintained to connect to external HTTP endpoints.

TRANSLPS: Translation service proxy service. This is required only in case a proxy needs to be maintained to connect to external HTTP endpoints.

11.17.7.2 Definition of Folders for Test Steps Application

In view /SALM/TM_C_FOSET, folders can be defined by the customer which later can be used in the designer application to structure test cases into different groups/folders. These folders enable a better overview and navigation within the designer application and are valid across test steps test cases.

11.17.7.3 Definition of Step Status Settings

In view /SALM/TM_C_SSET, the settings for step status can be defined.

Properties of Step Status Settings:

- **Status**: Unique identifier of a status
- **Label**: Language dependent label of a status
- **Default**: Default status during test execution
- **Evidence**: An evidence documents the results or errors during test execution and can be attached to a step. This setting defines whether an evidence (such as upload of screenshot) is required during test execution if a certain status is set at step level. This option is checked in dependency with the test case design where an evidence can be defined as required at step level.
- **Color**: Color coding of status at step level
- **Finish Step**: Indicates whether a step has reached a completion status which then leads to automatic checks of the entered test results such as evidence, actual result and others.
11.17.7.4 Status Aggregation Settings

In view cluster /SALM/TM_C_SRVC, the settings for status aggregation rules can be defined. These rules aggregate step status to test case status during test execution.

- For example, status error on steps level can be aggregated to status error on test case level automatically.

Properties of Rules:

- **Rule**: Unique identifier of a rule
- **Label**: Description/label of a rule
- **Test Case Status**: Target status of an aggregation at test case level

Properties of Status Aggregation for each rule:

- **Status**: Status on step level
- **Occurrence**: Occurrence of status on step level across the entire test case during execution (None: No occurrence. Single: At least 1 occurrence. All: All steps in the test case execution have this status)
You can also implement the BAdI /SALM/TM_TS_STAGR_BADI in case you want to execute status aggregations that cannot be performed with the given rule framework. The BAdI implementation would be called instead and substitute the customizing option described above.

The BAdI Interface provides the method AGGREGATE_STATUS. The importing parameter IT_STEPS holds all steps of the test case including each step status. Via the exporting parameters EV_AGGREGATED_STATUS and EV_MATCH you can return the aggregated status and whether an aggregation was possible (i.e., a matching rule was found).

11.17.7.5 Customer Fields for Test Steps Result Attributes

In view /SALM/TM_C_CFLD, custom fields can be defined for use in test steps test cases during design and execution time. Test case designers can pick from the set of defined custom fields and use them when designing test steps-based test cases. These custom fields allow testers the documentation of test results (such as Sales Order IDs) during test execution.

Properties of Custom Fields for Test Steps Test Cases:

- **Label**: Language-dependent label of a field.
- **Data Element**: Selectable from the data dictionary. Defines the length and (optional) value range by the assigned domain of the data element.
- **Rendering**: Defines how the field is rendered for testers during execution time.
- **Multiple Use**: Defines whether a field can be used multiple times within the same test case or not.

Here is a sample entry:

- **Customer Field ID**: MATERIAL_DOC
- **Label**: Material Document
- **Data Element**: CHAR10
- **Rendering**: Input Field
- **Multiple Use**: true
11.17.7.6 Steps Table View Settings for Standard Columns

In view /SALM/TM_C_STSET, the settings of the test steps table view are defined. This affects the appearance of steps in design time and execution time. Here you can show/hide columns in the steps table or change the sort order.

1 Note

Please note that not all settings should be changed here. In the list below, these settings can be changed by customers without effecting the application behavior negatively.

Properties of column settings:
- **Column Name**: Unique identifier of a column (must not be changed).
- **App**: Defines in which of both apps this column setting applies (design time, execution time, both) (can be changed).
- **Column Label**: Language dependent label of a column (can be changed).
- **Column Type**: Rendering type of a column (Dropdown, Value Help, Text Line, Text Area, Attachment, Checkbox, Technical Field, Icon) (should be changed only in alignment with SAP).
- **Order**: Defines the order in which columns are displayed in the table view (can be changed).
- **Visible**: Defines whether a column is displayed in the table view (can be changed).
- **Sub Step**: Defines whether a column should be also displayed at sub step level (can be changed).

11.17.7.7 Steps Table View Settings for Custom Columns

In view /SALM/TM_C_STCS, the settings for custom columns of the test steps table view are defined. This affects the appearance of steps in design time and execution time. Here you can show/hide columns in the steps table or change the sort order. By default, all custom columns are hidden.

For custom columns, you can also provide custom value helps. This is possible for the columns Cust_01, Cust_02, Cust_03. The value helps can be implemented via enhancement spot /SALM/TM_TS_CUST_VHLP. There you will also find a sample enhancement implementation which demonstrates how to implement the custom value help: /SALM/TM_TS_CUST_VHLP_SAMPLE.

Properties of column settings:
- **Column Name**: Unique identifier of a column (must not be changed).
- **App**: Defines in which of both apps this column setting applies (design time, execution time, both) (can be changed).
- **Column Label**: Language dependent label of a column (can be changed).
- **Column Type**: Rendering type of a column (Dropdown, Value Help, Text Line, Text Area, Attachment, Checkbox, Technical Field, Icon) (should be changed only in alignment with SAP).
- **Order**: Defines the order in which columns are displayed in the table view (can be changed).
- **Visible**: Defines whether a column is displayed in the table view (can be changed).
- **Sub Step**: Defines whether a column should be also displayed at sub step level (can be changed).
- **Exec. Edit**: Defines whether the column should be editable during Test Execution (in app My Test Executions) (can be changed).
11.17.8 Enabling Machine Translation API

With Focused Build SP03, a machine translation API allows you to translate contents of Test Steps test cases via an external translation service. You can implement the API with a service of your choice. SAP Business Technology Platform also offers a machine translation service and an example implementation is shipped with SP03 that illustrates how an external service can be called to make use of the translation function.

To enable the machine translation API, follow these steps:

1. Export Service Endpoint Certificate of your external translation service on your SAP Solution Manager system.
   - Download certificate via your web browser.
   - Go to the service endpoint via browser and logon to the endpoint if necessary (for token URL, do not add the token suffix at the end, only the URL).
   - Via your browser, review the certificate and download it to your local computer.

2. Add the certificate via transaction STRUST to your SAP Solution Manager as SSL Client (Standard) certificate.
   - Be sure to select Save at the end of this step.


4. Create an RFC connection of type HTTP Connections to External Server to contact the external service.

5. (Optional) To reach the machine translation service offered by SAP Business Technology Platform, maintain the RFC connection as follows:
   - URL = SCP cloud foundry Token URL
   - Port 443
   - Path prefix: /oauth/token
   - Basic Authentication
   - User: [your client id from SCP]
   - Password: [your client secret from SCP]
   - SSL active; default certificate

6. Do a connection test.
   - If it was successful, the HTTP Response is 400.

7. Perform the customizing in general settings table (see chapter above regarding customizing of Test Steps)

8. Implement the API BAdI to call the service from your SAP Solution Manager.
   - You can find an example implementation that would already work when calling the SAP Leonardo Machine Translation service offered via SCP.
   - Enhancement Spot: /SALM/TM_TS_TD_TRANSLATE
   - BAdI Definition: /SALM/TM_TS_TD_TRANSLATE_BADI
   - Example BAdI Implementation (inactive): /SALM/TM_TS_TD_TRANSL_BADI_IMP
11.17.9 Users and Authorization Roles

For demo, evaluation and test purposes of capability test steps, respective users should be created. It must be clarified with the customer who (customer, partner, or you as delivery team) creates the users, as well as creates and configures the respective authorization roles.

Detailed information about the definition of users and authorization roles can be found in the Focused Build for SAP Solution Manager – Security Guide and in Security Guide SAP Solution Manager 7.2 - Application-Specific Guides.

11.17.9.1 Users

Demo users for the Test Suite RDS test steps must be created using SU01.

Consider the following user and role assignments for using the capability test steps.

<table>
<thead>
<tr>
<th>User</th>
<th>Purpose</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>TESTMGR1</td>
<td>Test Manager</td>
<td>SAP_OST_FB_TEST_M_COMP</td>
</tr>
<tr>
<td>TESTER1</td>
<td>Tester</td>
<td>SAP_OST_FB_TESTER_COMP</td>
</tr>
</tbody>
</table>

**Recommendation**

Consider user TESTMGR1 as test manager.
- Purpose: Designs test cases of different types including test steps. Uses these test cases within Solution Documentation and test plans build upon this.

Consider user TESTER1 as tester.
Purpose: Access to Fiori application *My Test Executions* to execute and document tests using test cases of different types, which were assigned via test packages.

### 11.17.9.2 Authorization Roles

For test steps, the following standard composite roles are delivered and can be used as copy master:

- **For the test manager**: `SAP_OST_FB_TEST_M_COMP`
- **For the tester**: `SAP_OST_FB_TESTER_COMP`

**Recommendation**

Consider copying these roles into the customer namespace.
12 Additional Configuration Activities

12.1 Configuration of Email-Notification for Work Packages Work Items and RfC

12.1.1 Getting Started

12.1.2 Configuration HTML Mail Forms

Please refer to SCN WIKI for basic configuration.

12.1.2.1 Focused Build specific Prerequisites

For using E-mail PPF actions with HTML mail forms in certain Focused Build transaction types you need to fulfill the following prerequisites instead of the prerequisites from the SCN WIKI:

1. You have activated the following switches in transaction SFWS:
   - CRM_IC_CEBP: this BF enable the option #Service Request Attribute#, see SAP Note “2658408 - “Service Request Attributes” in Mail Form Attribute Context is missing”
   - CRM_SHSVC

2. In Customizing under Customer Relationship Management -> Marketing -> Marketing Planning and Campaign Management -> Personalized Mail -> Maintain Attribute Contexts for Mail Forms, you have selected the following:

<table>
<thead>
<tr>
<th>Attribute Context</th>
<th>Marketing Attribute</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>/SALM/ATTRIBUTES</td>
<td>Focused Build Attributes</td>
<td></td>
</tr>
</tbody>
</table>

In this activity, you can adjust the HTML mail forms you want to use for e-mail notifications.

For more information on the configuration of mail forms, see SAP Help Portal at http://help.sap.com/crm-> <SAP CRM 7.0 and above> -> Application Help -> Marketing -> Campaign Management -> Personalized Mail.

12.1.2.2 Mail Form Definition

1. Open the CRM WebUI
2. Select business role /SALM/TOLEAD - Tool Lead
3. And choose the Workcenter Service Operations.
4. In the Workcenter area Create select Mail Form to create a new mail form.

<table>
<thead>
<tr>
<th>ID: FL_WP_MB_NOTIFICATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description: Forecast Build Email Notification</td>
</tr>
</tbody>
</table>

5. Enter an ID for your mail form and enter the information required for your e-mail notification.

6. Select the attribute context `/SALM/Attributes`.


8. Select an Action Profile, e.g., `S1IT_ACTIONS`, and click on sub-node `Action Definition`.

9. Switch to Edit mode

10. For e.g., `S1IT_SEND_MAIL_WP_OWNER`, activate it by removing the inactive flag. The respective actions are named according the following pattern: `<Transaction Type>_SEND_MAIL_<Business Partner Function>`

<table>
<thead>
<tr>
<th>Action Profile</th>
<th>S1IT_ACTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Action Profile: Work Package</td>
</tr>
<tr>
<td>Action Definition</td>
<td>&lt;Transaction Type&gt;<em>SEND_MAIL</em>&lt;Business Partner Function&gt;</td>
</tr>
</tbody>
</table>

11. Select Processing Types

12. Select Method Call and choose Change Definition for the processing parameter.

13. Select the standard expression `MAIL_FORM_TEMPLATE`. Under Initial Value, enter the name of your e-mail template for the expression. It must not have leading spaces.

14. Select the standard expression `DEFAULT_SENDER_EMAIL`. Under Initial Value, enter the e-mail address of the sender of your e-mail notifications, for example, the e-mail address of your support team.
12.2 Configuration of Test Classification for Test Suite

To use Test Suite as part of the Requirements-to-Deploy scenario in Focused Build, ensure that the following standard configuration task has been completed successfully.

12.3 Activating BAdI for Related Transaction in Solution Documentation Attributes Panel

To change the visibility of related transactions in the attribute pane of structure elements (such as business process or business process step), follow these steps:

1. Start transaction SM_WORKCENTER.
2. Select Configuration All Scenarios.
5. Select Process Management.
6. Navigate to chapter 6 Configure Solution Documentation Management (ST < SP03) or 5 Configure Solution Documentation Management for systems on > SP03.

As a result, these BAdI implementations for ST-OST (/SALM/) should be active:

- /SALM/SMUDE_LCO_EXT_BR
- /SALM/SMUDE_LCO_EXT_WP
- /SALM/SMUDE_LCO_EXT_WI
12.4 Deletion of Obsolete Projects

After initially creating the project templates, the used projects can be deleted that they don’t appear in the Solution Readiness Dashboard.

A prerequisite for deletion of projects is that the project is still in status **CREATED**.

Just enter the project in **Read only** modus, select the top node of the project tree and press **Delete**.

12.5 Changing Project Reasons

In Project Management, you can select various project reasons displayed in the screenshot below. The selection can be customized.

To change the project reasons, follow these steps:

2. Change the reasons for projects.
12.6 Creating Business Partners

For each party that is involved in the CRM based transactions of the Requirements-to-Deploy process a business partner is needed. For the employees, the business partners can be created to template users (see appendix section Uncritical Focused Build configuration or customizing changes).

Uncritical Focused Build configuration or customizing changes

Focused Build means to use a SAP Solution Manager system with predefined customizing and configuration. To ensure the error-free usage of the highly integrated functionality this standard configuration shall not be changed. But some of the configurations or customizing settings are uncritical and can be changed, e.g. the value help for value and effort points.

Uncritical Customizing Change Options

Authorization Roles and Users in SAP Solution Manager System) using transaction BP_GEN (a variant of transaction BP_USER_GEN).

To create business partners to the already-created template users, follow these steps:

1. Start transaction BP_GEN
2. Choose RFC Destination NONE
3. Using multiple selection, select the template users
4. Choose Execute to create the business partners

5. If the protocol of the test run indicates no errors, go back to the selection screen, remove the check mark to Test Mode, and execute it again
6. Repeat the same for each relevant RFC destination (pointing to the systems involved with the project – see also chapter Uncritical Focused Build configuration or customizing changes
7. Uncritical Focused Build configuration or customizing changes

Focused Build means to use a SAP Solution Manager system with predefined customizing and configuration. To ensure the error-free usage of the highly integrated functionality this standard configuration shall not be changed. But some of the configurations or customizing settings are uncritical and can be changed, e.g. the value help for value and effort points.

Uncritical Customizing Change Options

8. Authorization Roles and Users in SAP Solution Manager System → Template Users) with the same users
The business partners can be checked and manually adapted in transaction BP. For Requirements-to-Deploy, it is important that the business partner exists with the roles Business Partner (Gen.), Contact Person, and Employee.

In the role Business Partner (Gen.) on tab Identification, entries to all systems in which the user should be able to create requirements or test defects are shown. Entries must be maintained according to the following specifications:

- **IDType**: CRM001
- **Identification Number**: <SysID><blank><installation number><blank><client><blank><user>

12.7 Defining Transport Risks

To define transport risks, follow these steps:

1. Start transaction SOLMAN_SETUP.
2. Select and expand scenario Change Control Management.
3. Select Change Request Management.
4. Navigate to configuration step 4.15 Define Transport Risks and execute the activities there.
12.8 Adjusting Category Schema

To adjust category schema, follow these steps:

1. Select Change and Release Management from the launchpad, as highlighted in the screenshot below.

2. Select Service Operations ➤ Categorization Schemas

3. Search for Schema ID: FOCUSED_BUILD.

4. Select the active one and choose Create Version.

5. Select the parent category for which you would like to create a new category.
6. Choose New.
7. Adjust new Category ID according to existing naming conventions
8. Fill in the fields for Category Name and Category Description.

   - Select the root ID of the schema.
   - Enter Valid-From Date and Valid-From Time.
   - Set Status to Released.

As a result, the schema is available for new documents starting from the specified Valid-From Date and Valid-From Time.

12.9 (Optional) Creating an Organizational Model

You can create an organization model in SAP Solution Manager that represents an extract of the customer’s organization, which covers the Requirements-to-Deploy process. As an example you can structure your Development Department into Teams and assign Developers to these teams. Later, in the My Work Item Application, Developers have the chance via the filter-criteria’s to find easily Work Items assigned to their teams:
Same applies to the Test Team in Work Items, but also for the Development Team in Work Packages, Defect Corrections and Change Documents, Support Team in Request for Changes as well as the Requirements Team in the Requirement.

To create a new root unit, follow these steps:

1. Start transaction SPRO.
2. Choose Create a Root Unit for Your Organizational Structure.
1. **Note**

   If you would like to enhance an existing organization model you can directly use transaction PPOMA_CRM to do so.

3. Select the upper organizational unit to create new organizational units and positions, and choose **Create**.
4. Choose either **Organizational Unit** or **Position**:

5. Provide a name for the new unit.
6. Select positions to assign business partners to those positions, and choose **Assign** for the upper organizational unit.
7. Choose **Create** and choose **Business partner**, as highlighted in the screenshot below.

8. Assign the respective business partner.
9. (optional) Create the organizational units listed below and assign the respective positions and users/business partners:
Business Unit A
Financials
Position: Analyst
BP Analyst 1
Position: Key User
BP Tester 1
Logistics
Position: Analyst
BP Analyst 2
Position: Key User
BP Tester 2
IT
Application Management
Position: Tool Lead
Financial
Position: Architect
BP Architect 1
Position: Developer
BP Developer 1
Position: Test Coordinator
BP Test Coordinator 1
Logistics
Position: Architect
BP Architect 2
Position: Developer
BP Developer 2
Position: Test Coordinator
BP Test Coordinator 2
Operations
Support
PMO
Position: Project Manager
BP Project Manager 1
BP Project Manager 2
12.10 Overview of Multi-Tenancy Enhancement Report

This Multi-tenancy enhancement report /SALM/ITSM_MT_BP_AUTH_GRP can be used to automatically assign authorization groups to business partners according to their position in the organizational structure. It is covered in the chapter titled, Assigning Authorization Groups to Business Partners.

Start report

Open report via SPRO (SAP Solution Manager ‡ Focused Build ‡ Change Control Extensions ‡ Multi Tenancy Extensions ‡ Update Business Partner Authorization Groups) or transaction SE38 (Report Name /SALM/ITSM_MT_BP_AUTH_GRP)
Test mode
If test mode is activated (checked) to changes will be written to database tables.
You can use this mode to check, which business partners would be changed. You will also get a list of business partner which are assigned to more than one root organization. Within the same organization a business partner can be assigned several times.

Assign authorization groups
Authorization groups are updated by analyzing the current organizational assignment of existing business partners

Delete authorization group assignments
The value for business partner authorization group is deleted for all business partners which are considered. This means that afterwards they do not have an authorization group.

Business Partner
Only assigned business partners
With this unchecked, only business partners who are assigned to an organization are taken in to account. Unassigned business partners will be ignored.
If you uncheck this option, all unassigned business partners will get the configured default authorization group.

Root organizations
The root organizations will be prefilled with your customized root organizations. In general, there is no need to change it. Added organizations need to be defined as root. Otherwise, they will be ignored.

Business partner
This search option for business partners is prefilled with *, which means that all business partners will be checked. Only business partner who match this criterion, will be taken into consideration. All others are ignored.
If you want to perform the update for one or some specific business partners only, add a list here.

Necessary Authorizations
The user who executes the report will probably need additional authorizations. Therefore, you need to create an authorization role in transaction PFCG.

<table>
<thead>
<tr>
<th>Authorization Object</th>
<th>Authorization Values</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_TCODE</td>
<td>Transaction Code</td>
<td>/SALM/MT_BP_AUTHGRP</td>
</tr>
<tr>
<td>PLOG</td>
<td>Infotype</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td>Planning Status</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td>Object Type</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td>Plan Version</td>
<td>01</td>
</tr>
<tr>
<td></td>
<td>Function Code</td>
<td>DISP</td>
</tr>
<tr>
<td></td>
<td>Subtype</td>
<td>*</td>
</tr>
<tr>
<td>B_BUPA_GRP</td>
<td>Activity</td>
<td>02, 03</td>
</tr>
<tr>
<td></td>
<td>Authorization Group</td>
<td>*</td>
</tr>
<tr>
<td>Authorization Object</td>
<td>Authorization Values</td>
<td>Comment</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------</td>
<td>---------</td>
</tr>
<tr>
<td>B_BUPA_RLT</td>
<td>Activity 02, 03</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BP Role *</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Change authorization group of business partner in database</td>
</tr>
</tbody>
</table>
13 Appendix

13.1 Key SAP Notes

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2955721</td>
<td>Focused Build: Central Note for Focused Build 2.0 SP07 for SAP Solution Manager 7.2 SP12</td>
</tr>
<tr>
<td>2910105</td>
<td>Focused Build: Technical collective note for ST-OST 200 SP06</td>
</tr>
<tr>
<td>2541761</td>
<td>Focused Build: Release Planning</td>
</tr>
</tbody>
</table>

13.2 Other Useful SAP Notes

<table>
<thead>
<tr>
<th>SAP Note No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2451880</td>
<td>Configuration and Administration of ITSM on 7.2</td>
</tr>
<tr>
<td>2447548</td>
<td>Report for Replacing Sbase component in documents</td>
</tr>
<tr>
<td>1019583</td>
<td>DSWP: Customizing für Issues und Top Issues (composes important information regarding priorities of CRM documents)</td>
</tr>
<tr>
<td>1384598</td>
<td>Information about the new remote infrastructure</td>
</tr>
<tr>
<td>1803899</td>
<td>Report /RPM/CUST_TABLES_COPY deletes customizing entries</td>
</tr>
<tr>
<td>907768</td>
<td>Change Request Management: Information about the required support package levels of managed systems</td>
</tr>
<tr>
<td>2257213</td>
<td>Information about authorizations for SAP Solution Manager RFC users</td>
</tr>
<tr>
<td>1483276</td>
<td>Use of Customizing Parameters in DNO_CUST04, AGS_WORK_CUSTOM and ICT_CUSTOM</td>
</tr>
<tr>
<td>1604651</td>
<td>Bad Performance when loading runtime repositories</td>
</tr>
<tr>
<td>1586185</td>
<td>Project selection fails for some transaction types</td>
</tr>
<tr>
<td>2456627</td>
<td>Document Type Administration Dump Object Types with Namespace</td>
</tr>
<tr>
<td>2194123</td>
<td>Setup HTTP connections to import SAP Best Practices Packages into solutions</td>
</tr>
<tr>
<td>1156507</td>
<td>Language supplementation, RSREFILL and client maintenance</td>
</tr>
<tr>
<td>2685831</td>
<td>Cannot activate Upon-Saving checks for managed systems in the Admin Cockpit - Solution Manager</td>
</tr>
<tr>
<td>2395850</td>
<td>CL_AI_CRM_IM_CATE_HELP=&gt;GET_MULT_CATE_LIST_F4 does not return correct category levels</td>
</tr>
<tr>
<td>SAP Note No.</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>1818804</td>
<td>Change Request Management: Enable client restriction for import subsets</td>
</tr>
<tr>
<td>1731806</td>
<td>Change Request Management: Support of multi-client import</td>
</tr>
<tr>
<td>2468171</td>
<td>ChaRM: Dump DBIF_RSQL_TABLE_UNKNOWN for table /SDF/TMWADM on shadow systems</td>
</tr>
<tr>
<td>2335056</td>
<td>ChaRM: runtime error PERFORM_PARAMETER_MISSING during creation of ToCs</td>
</tr>
<tr>
<td>2781528</td>
<td>Focused Build: Change document ID missing in target transport description created via /SALM/RETRO_AUTOMATION program in batch mode</td>
</tr>
<tr>
<td>2728035</td>
<td>Focused Build: Transport Check Improvements in the Retrofit Automation Program</td>
</tr>
<tr>
<td>2744352</td>
<td>Focused Build: Report /SALM/START_RETRO_OVERVIEW does not support multiple Retrofit systems for the same task list</td>
</tr>
<tr>
<td>2727448</td>
<td>Unnecessary CSOL locks for master roles</td>
</tr>
<tr>
<td>2208176</td>
<td>Retrofit: error about nonexistence of function module TRINT_GET_TLOGO</td>
</tr>
<tr>
<td>2223092</td>
<td>Retrofit: Error TK103 during auto-import language objects</td>
</tr>
<tr>
<td>2311560</td>
<td>Function module RSO_GET_RELATED does not work</td>
</tr>
<tr>
<td>2339934</td>
<td>Saving queries takes a very long time in retrofit scenario</td>
</tr>
<tr>
<td>2355901</td>
<td>SP36: Determination of transformations for retrofit</td>
</tr>
<tr>
<td>2395235</td>
<td>SP37: Determination of transformations for retrofit (II)</td>
</tr>
<tr>
<td>2401952</td>
<td>730SP17: Development class of transformation is reset to $TMP during re-import</td>
</tr>
<tr>
<td>2729126</td>
<td>Wrong categorization of Retrofit objects</td>
</tr>
<tr>
<td>2736254</td>
<td>Retrofit: Classification of Object is incorrect</td>
</tr>
<tr>
<td>2712878</td>
<td>Retrofit: Refine Information and enhance LOG and fix of categorization error</td>
</tr>
<tr>
<td>2733681</td>
<td>Retrofit: Performance improvement Retrofit overview</td>
</tr>
<tr>
<td>2735729</td>
<td>Retrofit: Error message improvement</td>
</tr>
<tr>
<td>2741354</td>
<td>Retrofit: Wrong categorization of workbench and customizing objects</td>
</tr>
<tr>
<td>2743604</td>
<td>Retrofit: Refresh of Retrofit overview shows no new entries</td>
</tr>
<tr>
<td>2744352</td>
<td>Focused Build: Report /SALM/START_RETRO_OVERVIEW does not support multiple Retrofit systems for the same task list</td>
</tr>
<tr>
<td>2754926</td>
<td>Retrofit: Small fixes for Retrofit Overview Screen</td>
</tr>
<tr>
<td>2765929</td>
<td>Improvement of report /SALM/CM_SHOW_CSOL_CONFLICT</td>
</tr>
<tr>
<td>2777400</td>
<td>Retrofit: Performance improvement II</td>
</tr>
<tr>
<td>2775346</td>
<td>Wrong result getting transport requests for a change document</td>
</tr>
</tbody>
</table>
### 13.3 Important Links

For additional Focused Build and related information, see the following resources:

  - [Focused Build installation instructions on SAP Support Portal](https://support.sap.com/en/alm/focused-solutions/focused-build.html#section_728203191)

- **SAP Help Portal**: Navigate to the Focused Build landing page, SAP Help Portal [https://help.sap.com/viewer/product/Focused_Build_Focused_Insights](https://help.sap.com/viewer/product/Focused_Build_Focused_Insights) for primarily technical information regarding the installation and operation of Focused Build, including the latest installation guides, SAP Notes, security guides (including info on assigning roles), application help online, and additional related information. There is an overlap of some information, such as installation instructions, on both portals. This helps you to easily find what you’re looking for. Be sure to use the tabs at the top of the landing page to navigate to all available resources.
  - [Application Help for Focused Build](https://help.sap.com/viewer/product/Focused_Build_Focused_Insights)
  - [Change Request Management](https://help.sap.com/viewer/product/Focused_Build_Focused_Insights)
  - [Batch Job Scheduling](https://help.sap.com/viewer/product/Focused_Build_Focused_Insights)
  - [Virus Scan Profiles](https://help.sap.com/viewer/product/Focused_Build_Focused_Insights)
13.4 Uncritical Configuration or Customizing Changes for Focused Build

For detailed information and related information, see the following resources:


13.5 Transaction Types

Focused Build is intended to use solely the following transaction types:

<table>
<thead>
<tr>
<th>Transaction Type</th>
<th>Description</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1BR</td>
<td>Requirement</td>
<td>Business Requirements</td>
</tr>
<tr>
<td>S1MT</td>
<td>Master Work Package</td>
<td></td>
</tr>
<tr>
<td>S1IT</td>
<td>Work Package</td>
<td>Project Management without Portfolio Management</td>
</tr>
<tr>
<td>S2IT</td>
<td>Work Package</td>
<td>Project Management with Portfolio Management (SAP Portfolio and Project Management)</td>
</tr>
<tr>
<td>S3IT</td>
<td>Work Package</td>
<td>Without Project Management</td>
</tr>
<tr>
<td>S1CG</td>
<td>Work Item</td>
<td>Work Item without transport requests</td>
</tr>
<tr>
<td>S1CR</td>
<td>Request for Change</td>
<td>Fix Pace</td>
</tr>
<tr>
<td>S1HF</td>
<td>Urgent Change</td>
<td>Fix Pace</td>
</tr>
<tr>
<td>S1SG</td>
<td>Standard Change</td>
<td>Fix Pace</td>
</tr>
<tr>
<td>S1MJ</td>
<td>Work Item</td>
<td></td>
</tr>
<tr>
<td>S1MR</td>
<td>Release</td>
<td>Release Cycle Document</td>
</tr>
<tr>
<td>S1RK</td>
<td>Risk</td>
<td></td>
</tr>
<tr>
<td>S1TM</td>
<td>Defect Correction IT</td>
<td>Correction of a defect during testing</td>
</tr>
<tr>
<td>S1TR</td>
<td>Test Request</td>
<td></td>
</tr>
<tr>
<td>S1DM</td>
<td>Defect Message</td>
<td></td>
</tr>
<tr>
<td>S3CR</td>
<td>Request for Change</td>
<td></td>
</tr>
<tr>
<td>S4AT</td>
<td>Service Request Approver Template (S1TR)</td>
<td>Simple IT Request</td>
</tr>
<tr>
<td>S4CT</td>
<td>Request for Change Template for Simple Service Request</td>
<td>Simple IT Request</td>
</tr>
<tr>
<td>S4IT</td>
<td>Incident Template for Simple Service Request</td>
<td>Simple IT Request</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>Description</td>
<td>Usage</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>S4PT</td>
<td>Problem Template for Simple Service Request</td>
<td>Simple IT Request</td>
</tr>
<tr>
<td>S4RQ</td>
<td>Service Request with Approval (SITR)</td>
<td>Simple IT Request</td>
</tr>
<tr>
<td>S4ST</td>
<td>Service Request for Simple Service Request</td>
<td>Simple IT Request</td>
</tr>
</tbody>
</table>

### 13.6 System Roles

The initially-delivered Focused Build system roles are based on the following set of system roles:

<table>
<thead>
<tr>
<th>System Role</th>
<th>Source</th>
<th>Type of Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>SAP</td>
<td>D - Source System</td>
<td>Development System</td>
</tr>
<tr>
<td>D</td>
<td>SAP</td>
<td>O - Target System</td>
<td>Demo System</td>
</tr>
<tr>
<td>T</td>
<td>SAP</td>
<td>O - Target System</td>
<td>Quality Assurance System</td>
</tr>
<tr>
<td>E</td>
<td>SAP</td>
<td>O - Target System</td>
<td>Training System</td>
</tr>
<tr>
<td>P</td>
<td>SAP</td>
<td>P - Production System</td>
<td>Production System</td>
</tr>
<tr>
<td>S</td>
<td>SAP</td>
<td>O - Target System</td>
<td>SAP Reference System</td>
</tr>
<tr>
<td>V</td>
<td>SAP</td>
<td>S - Single System</td>
<td>Evaluation System</td>
</tr>
<tr>
<td>0</td>
<td>CUSTOMER</td>
<td>R - Post-Processing System</td>
<td>Retrofit System</td>
</tr>
<tr>
<td>1</td>
<td>CUSTOMER</td>
<td>O - Target System</td>
<td>Pre-Production System</td>
</tr>
<tr>
<td>2</td>
<td>CUSTOMER</td>
<td>O - Target System</td>
<td>Maintenance Development System</td>
</tr>
<tr>
<td>3</td>
<td>CUSTOMER</td>
<td>O - Target System</td>
<td>Test System</td>
</tr>
</tbody>
</table>

Uncritical Focused Build configuration or customizing changes

### 13.7 Uncritical Focused Build configuration or customizing changes

Focused Build means to use a SAP Solution Manager system with predefined customizing and configuration. To ensure the error-free usage of the highly integrated functionality this standard configuration shall not be changed. But some of the configurations or customizing settings are uncritical and can be changed, e.g. the value help for value and effort points.

Uncritical Customizing Change Options
13.8 Authorization Roles and Users in SAP Solution Manager System

Each employee who is involved in the Requirements-to-Deploy process needs an own user in the SAP Solution Manager system to be able to access the system.

It must be clarified with the customer who (customer, partner, or you as delivery team) will create and configure the needed authorization roles and users.

Further information about the definition of users and authorization roles for Focused Build can be found in the Focused Build for SAP Solution Manager Security Guide.

Authorization Roles

With Focused Build the following composite roles get delivered for the Requirements-to-Deploy process:

- SAP_OST_FB_ARCHITECT_COMP
- SAP_OST_FB_ANALYST_COMP
- SAP_OST_FB_DEV_COMP
- SAP_OST_FB_PROJ_M_COMP
- SAP_OST_FB_REL_M_COMP
- SAP_OST_FB_TESTER_COMP
- SAP_OST_FB_TEST_M_COMP
- SAP_OST_FB_TOOLLEAD_COMP

Beside below exceptions all these composite roles, including the single roles have to be copied into the customer (Z*) namespace.

Exceptions: From the included single roles the following ones are ‘only’ used as navigation roles and should not be copied but to be used as they are:

- SAP_BPR_PPM
- SAP_OST_SM_CRM_UIU_ARCHITECT
- SAP_OST_SM_CRM_UIU_DEV
- SAP_OST_SM_CRM_UIU_PROJ_M
- SAP_OST_SM_CRM_UIU_REL_M
- SAP_OST_SM_CRM_UIU_SM_PRO
- SAP_OST_SM_CRM_UIU_TEST_M
- SAP_OST_SM_CRM_UIU_TESTER
- SAP_OST_SM_CRM_UIU_TOOLLEAD

Use transaction PFCG to

- Copy the roles
- Generate the profiles (leave configuration as is).

Template Users

Use transaction SU01 to create the following template users for Focused Build and to assign the needed roles:

<table>
<thead>
<tr>
<th>User</th>
<th>Last name</th>
<th>First Name</th>
<th>Composite Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARCHITECT1</td>
<td>Template User</td>
<td>Solution Architect 1</td>
<td>ZSAP_OST_FB_ARCHITECT_COMP</td>
</tr>
<tr>
<td>User</td>
<td>Last name</td>
<td>First Name</td>
<td>Composite Role</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
<td>------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>ARCHITECT2</td>
<td>Template User</td>
<td>Solution Architect 2</td>
<td>ZSAP_OST_FB_ARCHITECT_COMP</td>
</tr>
<tr>
<td>ANALYST1</td>
<td>Template User</td>
<td>Analyst 1</td>
<td>ZSAP_OST_FB_COMP_ANALYST_COMP</td>
</tr>
<tr>
<td>ANALYST 2</td>
<td>Template User</td>
<td>Analyst 2</td>
<td>ZSAP_OST_FB_COMP_ANALYST_COMP</td>
</tr>
<tr>
<td>DEVELOPER1</td>
<td>Template User</td>
<td>Developer 1</td>
<td>ZSAP_OST_FB_DEV_COMP</td>
</tr>
<tr>
<td>DEVELOPER2</td>
<td>Template User</td>
<td>Developer 2</td>
<td>ZSAP_OST_FB_DEV_COMP</td>
</tr>
<tr>
<td>PROJMAN1</td>
<td>Template User</td>
<td>Project Manager 1</td>
<td>ZSAP_OST_FB_PROJ_MANAGER_COMP</td>
</tr>
<tr>
<td>PROJMAN2</td>
<td>Template User</td>
<td>Project Manager 2</td>
<td>ZSAP_OST_FB_PROJ_MANAGER_COMP</td>
</tr>
<tr>
<td>RELMAN1</td>
<td>Template User</td>
<td>Release Manager 1</td>
<td>ZSAP_OST_FB_REL_MANAGER_COMP</td>
</tr>
<tr>
<td>RELMAN2</td>
<td>Template User</td>
<td>Release Manager 2</td>
<td>ZSAP_OST_FB_REL_MANAGER_COMP</td>
</tr>
<tr>
<td>TESTER1</td>
<td>Template User</td>
<td>Tester 1</td>
<td>ZSAP_OST_FB_TESTER_COMP</td>
</tr>
<tr>
<td>TESTER2</td>
<td>Template User</td>
<td>Tester 2</td>
<td>ZSAP_OST_FB_TESTER_COMP</td>
</tr>
<tr>
<td>TESTCOORD1</td>
<td>Template User</td>
<td>Test Coordinator 1</td>
<td>ZSAP_OST_FB_TEST_COORD_COMP</td>
</tr>
<tr>
<td>TESTCOORD2</td>
<td>Template User</td>
<td>Test Coordinator 2</td>
<td>ZSAP_OST_FB_TEST_COORD_COMP</td>
</tr>
<tr>
<td>TOOLLEAD1</td>
<td>Template User</td>
<td>Tool Lead 1</td>
<td>ZSAP_OST_FB_TOOLLEAD_COMP</td>
</tr>
<tr>
<td>TOOLLEAD2</td>
<td>Template User</td>
<td>Tool Lead 2</td>
<td>ZSAP_OST_FB_TOOLLEAD_COMP</td>
</tr>
</tbody>
</table>

Users

Transaction BP_USER_GEN can be used to create further users if they already exist in another system. Within this transaction, the users created in chapter 0 can be used as template user to create further users.
13.9 Authorization Roles and Users in Systems Belonging to the Project

Depending on their role, each employee who is involved in the Requirements-to-Deploy process might need an own user in the different systems involved in the project. Which authorizations / roles the different users need depends on the project, role and application.

<table>
<thead>
<tr>
<th>User</th>
<th>Dev</th>
<th>Test</th>
<th>Maint</th>
<th>QA</th>
<th>PreProd</th>
<th>Prod</th>
</tr>
</thead>
<tbody>
<tr>
<td>Architect</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Analyst</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Developer</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Project Manager</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Release Manager</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Tester</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Test Coordinator</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Tool Lead</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

Which authorizations the users get in which of the respective systems must be verified with the project team.
13.10 Language Settings

Ensure that the default language for your browser is English:

![Language settings interface]

13.11 Package and Namespace Selection in bc-Set Activation

If you are uploading or activating a bc-set in the scope of Focused Build, select an appropriate package. Mostly you can use /SALM/CORE.

13.12 Troubleshooting

13.12.1 Context Menu for Test Steps Missing in Solution Documentation

After the setup is complete, navigate to solution documentation and try to create or assign a test case of type test steps. If you open the context menu but cannot find the entries Test Steps (Create) or Test Steps (Assign), consider the following:

- Make sure that the piece list was activated properly (see chapter 3)
- Clear SMUD Buffer with report RSMUDA_MODEL_BUFFER_RESET

As a result, the context menu for Test Steps can be found in Solution Documentation, as shown in the screenshot below.
13.12.2 Error Message When Starting My Test Executions

After creating a test case of type Test Steps and assigning it to a Test Plan and Test Package, you try to open the app My Test Executions. In the role of the Focused Build Tester, you navigate to Fiori Launchpad and select My Test Executions. If you receive the error message "No system alias found for service /SALM/TWL_SRV_0001 and user *", consider the following action:

- Make sure that you activated the corresponding gateway service (/SALM/TWL_SRV_0001) and assigned a system alias in transaction /n/IWFND/MAINT_SERVICE.
- Try opening the app My Test Executions again.

If you open the app My Test Executions and get only a white screen, consider the following action:

- Run report /UI2/INVALIDATE_GLOBAL_CACHES
- Run report /UI5/APP_INDEX_CALCULATE and allow some time before opening the app My Test Executions again.
- Delete the cache of the used browser.
- Try to open the link in another browser (such as Google Chrome).
13.12.3  Upload of Attachments to Steps or Test Cases does not work

Usually, this error occurs related to the Gateway Virusscan Settings. There are two options to overcome this issue:

- You do not use a dedicated virus scanner and virus scan profile to scan documents uploaded via SAP NetWeaver Gateway to your SAP Solution Manager. In this case you should deactivate the virus scan via transaction /IWFND/VIRUS_SCAN (put /n in front to access the transaction).

- You plan to use or already use a virus scanner on your SAP Solution Manager. Make sure that all settings are defined properly and follow the instructions in IMG path:
  SAP Customizing Implementation Guide › SAP NetWeaver › Application Server › System Administration › Virus Scan Interface

13.13  Hints and Pitfalls Regarding Virus Scan Profiles

Please refer to
http://help.sap.com/saphelp_smp304svr/helpdata/en/7c/2d509370061014a2aaf8bb629919d56/content.htm?frameset=en/6e/0e4c04ebf445e79fb57230a2fb4fa3/frameset.htm&current_toc=en/7c/1feb92700610148db1c136782f3f1f/plain.htm&node_id=262&show_children=false

- Check if a virus scanner is defined in transaction VSCAN.
- Check virus scan profile in transaction VSCANPROFILE.

13.14  Clickjacking Protection Framework in SAP NetWeaver AS ABAP an AS JAVA

If you experience that nothing can be done in the release planning application anymore when running within CRM_UI, it may be due to clickjacking.
To overcome such a situation please refer to SAP Note 2319727.